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Privilege Management for Windows Introduction

Privilege Management for Windows combines privilege management and application control technology in a single lightweight
agent. This scalable solution allows global organizations to eliminate admin rights across the entire business.

Actionable intelligence is provided by an enterprise class reporting solution with endpoint analysis, dashboards, and trend data for
auditing and compliance.

Define User Roles
Before deploying Privilege Management for Windows, you should prepare suitable Workstyles for your users. Implementing least
privilege may require Workstyles to be tailored to users’ roles.

The table below shows three typical user roles, but we recommend you create roles that are tailored to your environment.

Role Requirement for Admin Rights

Standard Corporate User | Applications that require admin rights to function, and simple admin tasks.
Laptop User Flexibility to perform ad hoc admin tasks and install software when away from the corporate network.
Technical User Complex applications and diagnostic tools, advanced admin tasks, and software installations.

Privilege Management for Windows can cater to all types of users, including the most demanding technical users, such as system
administrators and developers.

You should also educate users on what to expect from a least privilege experience, before transferring them to standard user
accounts. This ensures they will report any problems encountered during the process of moving to least privilege.

Note: Contact your solution provider or BeyondTrust, to gain access to templates to cater to more complex use case
scenarios.

Implement Least Privilege

The first step is to identify the applications that require admin privileges for each of the roles you’ve defined. These can fall into one of
three categories:

1. Known Admin Applications: You already have a definitive list of applications that require admin rights to run.
2. Unknown Admin Applications: You are not sure of the applications that require admin rights to run.
3. Flexible Elevation: The user will require flexibility and can’t be restricted to a list of applications.

Known Applications

For this category, you should add the relevant applications to the Privilege Management for Windows Application Groups for the
users, which will automatically elevate these applications when they are launched. You can then remove admin rights from these
users.

Unknown Applications

For this category, you have two choices to help you discover the applications that require admin rights:

1. Windows specific: Set up Privilege Management for Windows Workstyles to monitor privileged application behavior. The
Privilege Management for Windows audit logs will highlight all of the applications that require admin rights to run.
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L]
1 For more information, please see "Privilege Monitoring" on page 58.

2. Setup Privilege Management for Windows Workstyles to give the user the on-demand elevation facility, and instruct the user
to use this facility for any applications that fail to run after you take the user’s admin rights away. The Privilege Management
for Windows audit logs will highlight all the applications that the user has launched with elevated rights.

L]
1 For more information, please see "On-Demand Application Rules" on page 72 and "Privilege Monitoring" on page 58.

You can use the auditlogs to determine the relevant set of applications you want to give admin rights to for these users.

L]
1 For more information, please see "Application Rules" on page 62.

Flexible Elevation

For this category, you should set up Privilege Management for Windows Workstyles that give the user an on-demand elevation
facility, which allows the user to elevate any applications from a standard user account. All elevated applications can be audited, to
discourage users from making inappropriate use of this facility.

-
1 For more information, please see "On-Demand Application Rules" on page 72.
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Install, Uninstall, and Upgrade Privilege Management for
Windows

Can l install the 32-bit client on a 64-bit endpoint?

No. The 32-bit client can only be installed on 32-bit endpoints.

Can l install the 32-bit Privilege Management Policy Editor on a 64-bit endpoint?

Yes. The 32-bit Privilege Management Policy Editor can be installed on 64-bit endpoints if required.

Do | need to install the Privilege Management for Windows and the Privilege Management Policy Editor together?

For standalone installations, you must install both Privilege Management for Windows and the Privilege Management Policy Editor.
We also recommend that Privilege Management for Windows and the Privilege Management Policy Editor are installed together
during evaluation, to simplify the evaluation process.

For larger deployments, there is no requirement to install the Privilege Management Policy Editor on endpoints.
What distribution mechanisms do you support?

Privilege Management for Windows can be deployed using any third party software which supports the deployment of MSI and/or
Executable files, such as Microsoft Active Directory, Microsoft SMS/SCCM, and McAfee ePolicy Orchestrator (ePO).

For silentinstallations and advanced installations (such as CERT_MODE and EPOMODE), the third party deployment software must
also support the use of command line options.

Install the Privilege Management Policy Editor

Using an administrator account, log into the Windows computer where you want to manage Privilege Management for Windows.

Note: Ensure you have the relevant Group Policy management tools installed on the desktop or server where you will
install Privilege Management Policy Editor.

To install Privilege Management Policy Editor, run the appropriate installation package:

« For 32-bit (x86) systems, run PrivilegeManagementPolicyEditor_x86.exe.

« For 64-bit (x64) systems, run PrivilegeManagementPolicyEditor_x64.exe.
Install Privilege Management Policy Editor:

1. The installation will detect if any prerequisites are needed. Click Install to install any missing prerequisites. This may take a

few minutes.
Once the prerequisites have been installed, the Welcome dialog box appears. Click Next to continue.
After reading the license agreement, select | accept the terms in the license agreement and click Next.
Enter your name and the name of your organization, and click Next .

If you want to change the default installation directory, click Change and select a different installation directory. Click Next.

o gk wDd

If you are only managing Windows machines with Privilege Management for Windows and want to evaluate it for use with
McAfee ePolicy Orchestrator, check the McAfee ePolicy Orchestrator Integration box. Otherwise, leave it unchecked and
click Next.
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7. Click Install to start installing Privilege Management Policy Editor.
8. Once installed, click Finish. Privilege Management Policy Editor has now been successfully installed.

Note: To use the Event Import Wizard, you must install the Microsoft SQL Server 2008 R2 Native Client. For installation
instructions and to download this component, visit hitps://www.microsoft.com/en-gb/download/details.aspx?id=16978.

Install Privilege Management for Windows

f Note: Privilege Management for Windows requires that Windows short file name creation to be enabled.

Client Packages

To install Privilege Management for Windows, run the appropriate installation package:

« For 32-bit (x86) systems, run PrivilegeManagementForWindows_x86.exe.
« For 64-bit (x64) systems, run PrivilegeManagementForWindows_x64.exe.
The installation will prompt you to install missing prerequisites.

Privilege Management for Windows may be installed manually, but for larger installations we recommend you use a suitable third-
party software deployment system.

f Note: There is no license to add during the client installation, as this is deployed with the Privilege Management for
Windows Workstyles, so the client may be installed silently.
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(1) mPoRTANT!

As of version 5.5, all releases of Privilege Management for Windows are signed only with a SHA-256 code signing certificate.
Previous versions were dual signed with SHA-1 and SHA-256 certificates. The decision to drop SHA-1 certificates was made to
avoid weaknesses in the SHA-1 algorithm and to align to industry security standards. For more information, please see 2019
SHA-2 Code Signing Support requirement for Windows and WSUS at https://support.microsoft.com/en-gb/help/4472027/2019-
sha-2-code-signing-support-requirement-for-windows-and-wsus.

If you intend to deploy Privilege Management for Windows 5.5 to Windows 7 or Windows Server 2008 R2 machines, you must
ensure the following KBs are installed prior to installation of this product:

o KB4490628
o KB4474419

We strongly recommend you keep your systems up to date with the latest Windows security updates.

Installing this release on a system which does not support SHA-256 - -
code signing verification will result in “Bad Image” exceptions o Ll g .
referring to PGHook.dlI.

I@ C:\Program Files\Avecto\Privilege Guard Client\PGHook.dll is either

not designed to run on Windows or it contains an error. Try installing
the program again using the original installation media or contact your
system administrator or the software vendor for support.

Unattended Client Deployment

When deploying Privilege Management for Windows with automated deployment technologies, such as System Center Configuration
Manager (SCCM), you can deploy the client silently and postpone the computer from restarting.

To install the client executable silently, without a reboot, use the following command line (the double quotes are required and the
syntax must be copied exactly):

PrivilegeManagementForWindows x86.exe /s /v" /gn /norestart"
To install the client MSI package silently, without a reboot, use the following command line:

Msiexec.exe /i PrivilegeManagementForWindows x86.msi /gn /norestart

Note: Privilege Management for Windows will not be fully operational until a reboot. To perform an unattended
deployment with a reboot, omit the /norestart switch.

Upgrade Privilege Management for Windows

Before upgrading any versions of Privilege Management for Windows software or existing settings, we recommend you test your
deploymentin a pre-production environment. This will help mitigate any unforeseen compatibility issues, and avoid disruption to the
business. In addition, you should export your policies for backup purposes prior to an upgrade.
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All Privilege Management for Windows MSI and EXE installers will automatically remove old versions of BeyondTrust software when
installed. Therefore, it is not necessary to manually remove old versions prior to installation.

If you previously installed Privilege Management for Windows with a switch, you must ensure you upgrade Privilege Management for
Windows with the same switch. If you do not use the same switch, the new installation parameters will apply and any functionality
relating to the previous installation will be lost.

Privilege Management for Windows guarantees backward compatibility with previous versions, but does not guarantee forward
compatibility. Therefore, we recommend all Privilege Management for Windows installations to be upgraded before rolling out new
versions.

Note: When upgrading BeyondTrust software, it may be necessary for a reboot in order to complete the installation. When
installing in silent mode, a reboot will occur automatically. Therefore, we recommend that upgrades be performed out of
core business hours, or during scheduled maintenance windows, to avoid loss of productivity.

Recommended Steps

M
(1) mPORTANT!

As of release 5.5, all releases of this product will be signed with BeyondTrust Corporation, rather than Avecto, as the software
publisher name. If prior to 5.5 you used the QuickStart Policy Template as a starting point, itis likely that your configuration will
include application groups which target our own applications based on a publisher match to Avecto. An upgrade to 5.5 or
beyond requires you to update your configuration so that it continues to match the versions of the applications and tools that you
use. We recommend one of the following two options:

Option 1

Add a copy of any existing application definitions which target Avecto and update those copies to target BeyondTrust
Corporation instead; the presence of both sets of application definitions will ensure they continue to match both new and
existing versions during the implementation of 5.5. This option has an advantage over Option 2, in that it also targets any
application definitions that you may have created yourselfthat target the Avecto publisher.

Option 2
You may copy fragments of the QuickStart policies in version 5.5 to your existing application definitions.
For either option, it is critical that you roll out your configuration changes before you update your Privilege Management for

Windows software to version 5.5 or later.

Step 1: Upgrade the Privilege Management Policy Editor

L]
1 For steps to upgrade the Privilege Management Policy Editor, please see "Install the Privilege Management Policy Editor"
on page 12.

Step 2: Upgrade Application Groups to Match Publisher Name BeyondTrust Corporation (When Upgrading to Version 5.5)
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lal BeyondTrust

Option 1 - Duplicate application definitions matching Avecto publisher and update to target BeyondTrust
Corporation

1. Locate all Avecto matches:

« Select the Application Groups node.
« Type Avecto into the Search applications box to filter.

] Console Root
~ [ Privilege Management Settings
22 Windows
~ [ Workstyles
[& ANlusers
s High Flexibility
& Medium Flexibility
ke Low Flexibility
~ [ Application Groups
3 (Default) Any Application
(Default) Any Trusted & Signed UAC Prompt
5 (Default) Any UAC Prompt
(Default) Child Processes of TraceConfig.exe
5 (Default) Privilege Management Tools
(Default) Signed UAC Prompt
9 (Default) Software Deployment Tool installs
(Default) Trusted Parent Processes
(Recommended) Restricted Functions
(Recemmended) Restricted Functions (On-Demand)
5 Add Admin - All Users (Business Apps)
Add Admin - All Users (Windows Functions)
5 Add Admin - High Flexibility
5 Add Admin - Low Flexibility
T Add Admin - Medium Flexibility
5 Block - Blackisted Apps

B All Application Groups

0
The list below shows all your Application Groups | Summary View

o [[avead x|

Application Group name / Description
(Default) Child Processes of TraceConfig.exe
D BeyondTrust Privilege M ent ETW Trace Formatter

+= publisher exactly matches filename contains “TraceFormat.exe

(Default) Privilege Management Tools (Privilege Management Support Applications)

Privilege Management Config Capture Utility
&

' publisher exactiy matches “BMEGHB", filename contains “PGCaptureConfig.exe”

E Privilege Management TraceConfig
Gs publisher exactly matches "BUBEN". filename contains “TraceConfig.exe"
Block - Blacklisted Apps (Applications blocked for all users)

Any Privilege Management Client Installer Package
G Publisher exactly matches B, product name contains "Privilege Management”

2. Create a copy of all definitions in each application group found that contain a publisher match on Avecto:

« Copy and paste the existing definitions.

[ Console Root
v [ Privilege Management Settings
v 52 Windows
v o Workstyles
[& ANl Users
& High Fleibility
& Medium Flexibility
S Low Flexibility
~ [ Application Groups
7 (Default) Any Application
5 (Default) Any Trusted & Signed UAC Prompt
5 (Default) Any UAC Prompt
T (Default) Child Processes of TraceConfig.exe
T3 (Default) Privilege Management Tools
7 (Default) Signed UAC Prompt
(Default) Software Deployment Tool Installs
T (Default) Trusted Parent Processes
0 (Recommended) Restricted Functions
(Recommended) Restricted Functions (On-Demand)
53 Add Admin - All Users (Business Apps)
T3 Add Admin - All Users (Windows Functions)
3 Add Admin - High Flexibility
T3 Add Admin - Low Flexibility
5 Add Admin - Medium Flexibility
5 Block - Blacklisted Apps
Passive - High Business Apps
5 Passive - Low Business Apps
&5 Pacsive - Medium Ruciness Annc

h All Application Groups

Summary View
The list below shows all your Application Groups Y

vilweto X

Application Group name / Description
(Default) Child Processes of TraceConfig.exe
D BeyondTrust Privilege Management ETW Trace Formatter
5= publisher exactly matches "BeyondTrust Corporation®, filename contains “TraceFormat.exe”
D BeyondTrust Privilege Management ETW Trace Formatter OLD
5= publisher exactly matches “BiBGIB ", filename contains "TraceFormat.exe”
(Default) Privilege Management Tools (Privilege Management Support Applications)

Jji§ Priviege Management Config Capture Utiity
n% pu thy r ecto”, filename contains "PGCaptureConfig.exe”

il Priviege Management TraceConfig

~ o publisher exactly matche ecto”, filename contains “TraceConfig.exe”

Add Group...
Block - Blacklisted Apps (Applications blocked for all users) Insert Application
ﬁ Any Privilege Management Client Installer Package & Cut
®s publisher exactly matches " BYBGS. product name contains "Privilege Management®
Ty Paste
K Delete

Delete entire group ((Default) Privilege Management Tools')

Properties...

Wb

:"' Tip: Rename one of the copies to OLD, so it’s easy to tell which to delete after the new application definitions take effect.

OLD can be deleted once the 5.5 upgrade is complete.

3. Update the new application definitions to match publisher BeyondTrust Corporation.
4. Testthe updated configuration against the new 5.5 applications.
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Option 2 - Insert policy fragments into existing application definitions

1. Ensure that Hidden Groups are visible by right-clicking the Privilege Management Settings node. Enable Show Hidden
Groups.

2. Copy the following text:

<ClipboardText><ClipboardResources><Config/></ClipboardResources><ClipboardItems><Application
ID="95402ccl1-3301-49ec-8108-7ee359c55018" Type="exe" Description="BeyondTrust Privilege
Management ETW Trace Formatter" OpenDlgDropRights="true" CheckFileName="true"
FileName="TraceFormat.exe" FileStringMatchType="Contains" UseSourceFileName="true"
ProductName="BeyondTrust Privilege Management" ProductDesc="BeyondTrust Privilege Management
ETW Trace Formatter" CheckCertificate="true" Certificate="BeyondTrust Corporation"
CertificateStringMatchType="Exact"/><Application ID="d30£3395-2f7f-4a2e-b8e5-6d3073976dcO"
Type="exe" Description="Performance Log Utility" OpenDlgDropRights="true" CheckFileName="true"
FileName="logman.exe" FileStringMatchType="Contains" UseSourceFileName="true"
ProductName="Microsoft® Windows® Operating System" ProductDesc="Performance Log Utility"
CheckCertificate="true" Certificate="Microsoft Windows"
CertificateStringMatchType="Exact"/></ClipboardItems></ClipboardText>

Paste into a text editor and replace new lines with single spaces. Copy the text again.
Create an application group (Default) Child Processes of TraceConfig.exe.
Select the middle pane and paste what you have copied.

o o kv

Right-click the application group, select Properties, and check the st etings
H v 13 Windows = (Default) Child Processes of TraceConfig.exe

Hidden box. oy Define an ot ore applicetions for ths windows spplication group

~ @@ Application Groups.
5 (Default) Any Application
5 (Default) Any Trusted & Signed UAC Prompt
£ (Default) Any UAC Prompt.

| = (Default) Child Processes of TraceConfig.exe BeyondTrust Privilege Management ETW Trace Formatter
TOefauly ool 3 publisher exactly matches "Avecto”, filename contains "TraceForrmat, exe”

5 (Default) Signed UAC Prompt D Performance Log Utiity

5 (Default) Software Deployment Tool Installs = publisher exactly matches *"Microsoft Windows”, flename contains "logman.exe”
sted
ded) Restricted Functions (Defautt) Child Processes of TraceConfig.cxe Properties ? X
G ded) Restricted Functions (On-Demanc)

5 Add Admin - All Users (Business Apps) General
5 Add Adrmin - Al Users (Windows Functions)

5 Add Admin - High Flexibiity

= AddAd Fleibiy e

Hidden

Applcation Type / Appication
Executzble

o | conce || ooy |

7. Copy the following text:

<ClipboardText><ClipboardResources><Config/></ClipboardResources><ClipboardItems><Application
ID="511e21b7-b059-42ca-bcfe-03cadc5ecf58" Type="exe" Description="Privilege Management Config
Capture Utility" ChildrenInheritToken="true" OpenDlgDropRights="true" CheckFileName="true"
FileName="PGCaptureConfig.exe" FileStringMatchType="Contains" UseSourceFileName="true"
ProductName="BeyondTrust Privilege Management" ProductDesc="BeyondTrust Privilege Management
Config Capture Utility" CheckCertificate="true" Certificate="BeyondTrust Corporation"
CertificateStringMatchType="Exact"/><Application ID="7995df95-0031-460f-a5e3-cfd2b12758d8"
Type="exe" Description="Privilege Management TraceConfig" ChildrenInheritToken="true"
OpenDlgDropRights="true" CheckFileName="true" FileName="TraceConfig.exe"
FileStringMatchType="Contains" UseSourceFileName="true" ProductName="BeyondTrust Privilege
Management" ProductDesc="BeyondTrust Privilege Management Config Capture Utility"
CheckCertificate="true" Certificate="BeyondTrust Corporation"
CertificateStringMatchType="Exact" ChildApplicationGroup="ald8abl6-5b3d-42d1-a90d-
e069d741f7b1"/></ClipboardItems></ClipboardText>
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8. Paste into a text editor and replace new lines with single spaces. Copy the text again.
9. Select the application group (Default) Privilege Management Tools.

10. Selectthe middle pane and paste what you have copied.

11. Double-click the Privilege Management TraceConfig application definition..

12. In the Allow child processes to match the application definition T e i
option in the Application dialog, choose (Default) Child
Processes of TraceConfig.exe from the dropdown.

13. Copy the following text:

<ClipboardText><ClipboardResources><Config/></ClipboardResources><ClipboardItems><Application
ID="52alef23-b71b-4c3b-836c-c228a7343e33" Type="msi" Description="Any Privilege Management
Client Installer Package" ChildrenInheritToken="true" OpenDlgDropRights="true" FileName="*"
FilePatternMatching="true" UseSourceFileName="true" CheckProductName="true"
ProductName="Privilege Management" ProductNameStringMatchType="Contains"
CheckCertificate="true" Certificate="BeyondTrust Corporation"
CertificateStringMatchType="Exact"/></ClipboardItems></ClipboardText>

14. Paste into a text editor and replace new lines with single spaces. Copy the text again.
15. Select the application group Block - Blacklisted Apps.
16. Selectthe middle pane and paste what you have copied.

Step 3: Upgrade Privilege Management for Windows Settings

Once the Privilege Management Policy Editor has been upgraded, the final step is to roll out new versions of the Privilege
Management for Windows settings. Although Privilege Management for Windows is fully backwards compatible with older versions of
Privilege Management for Windows settings, this step is required if you want to take advantage of any new features and
enhancements in Privilege Management for Windows.

K Note: Privilege Management for Windows settings are automatically saved in the latest format each time a change is
made. For details on editing Privilege Management for Windows settings, please see "Deploy Privilege Management for
Windows Policy" on page 135.

f Note: Once Privilege Management for Windows settings have been upgraded, they cannot be downgraded. Therefore, we
recommend an upgrade of Privilege Management for Windows settings is performed only after all instances of Privilege
Management for Windows have been upgraded.

Step 4: Upgrade Privilege Management for Windows

To upgrade Privilege Management for Windows manually, double-click the client installation media for your operating system.
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1 For steps to upgrade Privilege Management for Windows using a deployment mechanism, please see "Install Privilege
Management for Windows" on page 13.

K Note: For larger deployments, Privilege Management for Windows supports mixed client environments, as itis fully
backwards compatible with older versions of Privilege Management for Windows settings. This allows for phased roll-outs
of Privilege Management for Windows, if preferred.

Step 5: Delete Old Application Definitions (Upgrade from 5.4)

Once all machines are running version 5.5, it is safe to delete any application definitions still matching the publisher Avecto from your
configuration and to deploy that configuration.

Privilege Management Reporting Console

The Reporting Console is an MMC snap-in and may connect to the local computer or a remote computer. The Reporting Console
enables you to view Privilege Management for Windows events and privilege monitoring logs for the relevant computer.

To run the Privilege Management Reporting Console:

Launch mmc.exe.
Select Add/Remove Snap-in from the File menu.
Select Privilege Management Reporting from the available snap-ins and click Add.

Before the snap-in is added, you will be prompted to select a computer to manage. The local computer will be selected by
default. To connect to a remote computer select the Another computer option button and enter the name of the remote
computer or click the Browse button to browse for a computer. Privilege Management for Windows supports a connection to a
central event collector if you are using event forwarding to centralize events to a server.

You may also select an alternative location for the privilege monitoring logs, if you have a scripted solution in place to
centralize the privilege monitoring logs to a server. Enter the network location or click the Browse button to browse to the
location.

Click Finish.
Click OK.

Note: You can add multiple instances of the Privilege Management Reporting snap-in and connect them to different
computers.

Auditing Report

The Auditing Report lists all the Privilege Management for Windows events logged on that computer.

For each event the following information is available:

« Date

« EventID

« Filename (Codebase for ActiveX controls)
« Command Line
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« Event Description

« Username

« Computer Name

« Policy

« Application Group

« Reason

« Custom Token

« Hash (CLSID for ActiveX controls)
« Certificate

. PID

« ParentPID

o Trusted Application Name

« Trusted Application Version

« Date

« EventID

« Filename (Codebase for ActiveX controls)
« Command Line

« EventDescription

« Username

o Computer Name

« Policy

« Application Group

« Reason

o Custom Token

« Hash (CLSID for ActiveX controls)
o Certificate

« PID

« ParentPID

« Trusted Application Name

o Trusted Application Version

By default, the report will show all Privilege Management for Windows events from the eventlog, but you can filter the report on date,
event number, username, and computer name. Click Update Report to reload the report.

The application definitions contained within each event may be copied and then pasted into application groups in the Privilege
Management Policy Editor. Select one or more events, and then select Copy from the context menu. You can now paste the
applications into an application group.

Privilege Monitoring Report

Application View

The application view shows a list of all applications that have been monitored. Applications are identified by their file hash.
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For each application, the following information is available:

« Filename/Codebase

« Type

« Instances

« Description

« Certificate

« Hash (CLSID for ActiveX controls)
« Version (ActiveX controls only)

The instances column shows the number of times the application has run. To view the individual instances for an application, double-
click the entry in the list or select Show Details from the context menu. The Process View appears.

By default, the report will show all the monitored applications, but you may filter the report on date, username, and computer name.
Click Update Report to reload the report.
Process View
The process view shows a list of the individual processes that have been monitored for an application.
For each process the following information is available:
« Date
. PID

« Command Line

« Filename

To view the activity for a process, double-click the entry in the list or select Show Details from the context menu. The Activity View
appears.
Activity View

The activity view shows a list of all the privileged activity carried out by a process. Privileged activity is any activity that would fail
under a standard user account.

For each activity entry the following information is available:
« Date
« Operation

« Object
« Parameters
To go back to the process view, double-click the back up entry in the list or select Back Up from the context menu. The Process View

appears.

Diagnose Connection Problems

The Privilege Management Reporting Console needs to connect to the registry and administrator file shares when connecting to a
remote computer.

If the Reporting Console fails to connect or fails to retrieve data, the most common causes are:
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1. The Remote Registry service needs to be started on the remote machine. On Windows 7, this service is not set to start
automatically, so you should ensure it has been started.

2. The Windows Firewall may be blocking the incoming requests. Enabling the File and Printer Sharing exception in the
Windows Firewall Settings should resolve this problem.
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Sign Privilege Management for Windows Settings

The Privilege Management for Windows settings may be digitally signed. Privilege Management for Windows can either enforce or
audit the loading of signed settings.

Privilege Management for Windows Installation Mode Parameters

Privilege Management for Windows will verify the certificate on any signed settings that it loads, regardless of where those settings
originate. The verification process includes:

« Checking the contents of the settings have not been altered

« Establishing a chain of trust

« Checking the certificate used to sign the settings contained the Privilege Management for Windows configuration Signing OID
in its Enhanced Key Usage extension

« Checking for revocation where network connectivity allows

Should the signature verification process fail for any reason, the course of action to take depends on the mode of operation. There
are three modes of operation in Privilege Management for Windows. The mode is set via a command line option during installation:
Parameter ‘ Description
CERT_MODE=0 Standard Mode

The loading of unsigned settings will be audited as information events (event 200).
Signed settings will be audited as information events (event 200) if they are correctly
signed and as warning events (event 201) if they are incorrectly signed.

Privilege Managementfor Windows is installed in Standard Mode by default.
CERT_MODE=1 Certificate Warning Mode

The loading of unsigned settings will be audited as warning events (event201).
Signed settings will be audited as information events (event 200) if they are correctly
signed and as warning events (event 201) if they are incorrectly signed.

CERT_MODE=2 Certificate Enforcement Mode

Unsigned or incorrectly signed settings will not be loaded and audited as error
events (event 202). Signed settings will be audited as information events (event
200) if they are correctly signed.

For example, to install the client MSI package silently in Certificate Warning Mode, use the following command line (the syntax must
be copied exactly):

MSIEXEC.exe /i PrivilegeManagementForWindows x64.msi /gn CERT MODE=1
or
MSIEXEC.exe /i PrivilegeManagementForWindows x86.msi /gn CERT MODE=1

To install the client executable silently in Certificate Warning Mode, use the following command line (the syntax must be copied

exactly):
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PrivilegeManagementForWindows x64.exe /s /v“ /qn CERT MODE=1"
or

PrivilegeManagementForWindows x86.exe /s /v“ /gn CERT MODE=1"
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Create a PFX File for use with Privilege Management for Windows

The Privilege Management for Windows settings console requires access to a certificate and private key to digitally sign XML
configuration. They must both be contained in a PFX or PKCS#12 format file, and the certificate must specifically be designated as
suitable for signing Privilege Management for Windows XML configuration. This is done via the Enhanced Key Usage extension
when generating certificates.

This approach provides another means of ensuring configuration cannot be created and signed by rogue users with access to a
digital signature certificate intended for a different purpose.

BeyondTrust has defined the following OID that should be added to the Enhanced Key Usage extension:
1.2.826.0.1.6538381.1.1.1 (Avecto Privilege Guard - Configuration - XML Configuration Signing)

K Note: The Privilege Management for Windows settings console does not check for the existence of this key usage. The
checks are performed when verifying digital signatures in the Privilege Management for Windows service. A configuration
that is signed with a key that does not contain the specified Enhanced Key Usage extension, will always fail signature
verification checks.

The following sections provide details of two methods that can be used to generate a suitable PFX file, but it should be possible to
use any Certification Authority to produce certificates with the appropriate Enhanced Key Usage extension.

Use MakeCert to Generate your Certificate

MakeCert is a certificate generation tool available from Microsoft that can be used to generate certificates for testing purposes.

The following makecert command line can be used to generate a certificate suitable for signing Privilege Management for Windows
configuration:

makecert -r -pe -n "CN=BeyondTrust Signed XML Configuration" -sky signature -eku
1.2.826.0.1.6538381.1.1.1 -ss my

The parameters can be changed as required. The example will generate a self-signed certificate with an exportable private key, and
adds it to the calling user’s local certificate store. The certificate must then be exported to a PFX file along with the private key in the
usual way.

The important parameter in the example is the addition of the Privilege Management for Windows Configuration Signing OID to the
Enhanced Key Usage extension (-eku 1.2.826.0.1.6538381.1.1.1)

If a self-signed certificate is used to sign the Privilege Management for Windows settings, the certificate must be distributed to all
clients for a chain of trust to be established and for signature verification to be successful.
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Use Certificate Template in a Certificate Request

Once the certificate template is issued, the template can be used during advargggmqgmjcategqehg_ggsts via thF ciertsrv web interface.

Microsoft Active Direc

Advanced Certificate Request

Cartificate Template:

[User |
User

Key Options: Basic EFS

Administrator

EFS Rec ot fing key set
csP. T
Web Sener
Kay Usape: | Subardsnate Certification Autharity

Mir: 384 — P
Key Size: [1024 Mas 1n2ge |EmmEn bey sizes: £12 1004 2048 4058 B152 18384

& Automatic key container name " User specified key container name
¥ Mark keys as axportable
I” Enable strong private key protection

Additional Options:

Request Format: & CMC  © PKCS10

Hash Algorithm: |shal -I

Only vsed fo sign request

I” Save request

o F
ittributes: s
Frendly Mama:

[Done

Once the certificate is issued, it must be installed by the user before it can be exported to a PFX file in the usual way.

f Note: The private key must be exported to the PFX file as well.

Microsoft Certificate Services

Microsoft Certificate Services is a useful way for organizations to run their Certification Authority. In its enterprise editions, Certificate
Services integrates with Active Directory to publish certificates and Certificate Revocation Lists to a location that is accessible to all
computers in the Active Directory domain.

Custom certificate templates can only be managed using enterprise CAs, therefore the following procedure is only possible on
Enterprise Editions of Windows 2008 R2.

Create a Privilege Management for Windows Configuration Certificate Template

The easiest way to create a certificate with the BeyondTrust Privilege Management for Windows Configuration Signing Enhanced
Key Usage extension is to create a new certificate template. Certificate templates allow the content and format of certificates to be
defined so users can request a certificate using a simple template rather than having to generate a complex certificate request.

To create a certificate template, an existing template must be duplicated and then modified.

To create a new version 2 or 3 certificate template:
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Open the Certificate Templates snap-in.

2. Inthe details pane, right-click an existing certificate that will serve as the starting point for the new certificate, and select
Duplicate Template.

3. Choose whether to duplicate the template as a Windows Server 2003-based template or a Windows Server 2008 R2—-based
template.

On the General tab, enter the Template display name and the Template name, and click OK.
5. Define any additional attributes for the newly created certificate template.

The template must then be edited to make it suitable for signing Privilege Management for Windows configuration. This is done by
adding the BeyondTrust Privilege Management for Windows Configuration Signing OID as an application policy for the template.

The Configuration Signing OID must first be defined.

To define an object identifier:

Open the Certificate Templates snap-in.

In the details pane, right-click the certificate template you want to modify, and then click Properties.

On the Extensions tab, click Application Policies, and then click Edit.
In the Edit Application Policies Extension dialog box, click Add.

o K~ DN =

In Add Application Policy, ensure the Privilege Management for Windows Configuration Signing policy that you are creating
does not exist, and then click New.

6. Inthe New Application Policy dialog box, provide the name and
OID for the new application policy, and then click OK.

Type a name for the new application policy, and if necessary change the
object identifier.

Name:

|F‘riv1'|ege Management for Windows Corfiguration Signing| |

Object identifier:
|‘I 2 8260.1.6538381.111

Now that the application policy is defined, you can then associate it with the certificate template.

To associate the application policy with the certificate template:

Open the Certificate Templates snap-in.

In the details pane, right-click the certificate template you want to change, and then click Properties.
On the Extensions tab, click Application Policies > Edit.

In Edit Application Policies Extension, click Add.

ok wn -

In Add Application Policy, click the application policy, and then click OK.
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Issue and Distribute the Certificate

Once the certificate template is created in the Certificate Templates snap-in and has replicated to all domain controllers in the forest, it
can now be published for deployment. The final task for publishing the certificate template is to select it for the Certification Authority
(CA) to issue.

Issue the Certificate

To define which certificate templates are issued by a CA:

In Administrative Tools, click Certification Authority.

In the console tree, expand CAName (where CAName is the name of your enterprise CA).
In the console tree, select the Certificate Templates container.

Right-click Certificate Templates, and then click New > Certificate Template to Issue.

In the Enable Certificate Templates dialog box, select the Privilege Management for Windows Configuration certificate
template you want the CA to issue, and then click OK.

o R~ DN =

Distribute Public Keys

For signature verification to be successful at every client that reads signed Privilege Management for Windows settings, a chain of
trust must be established. For this to be done, a suitable trust point must be distributed to each client that will receive the Privilege
Management for Windows settings. This should be done automatically when using a Microsoft enterprise CA.

Alternatively, public keys can be distributed using Group Policy.

[ ]
1 For more information on distributing public keys using Group Policy, please see Distribute Certificates to Client Computers

by Using Group Policy at https://docs.microsoft.com/en-us/windows-server/identity/ad-fs/deployment/distribute-certificates-
to-client-computers-by-using-group-policy.

ﬂ Note: If you rely on third party providers for certificates, for example, not internal PKI, you will succeed by asking for a "key
signing ceremony" that will allow you to specify the certificate parameters such as custom "extended key usage" values as
described in this appendix.
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Create and Edit Signed Settings

To digitally sign Privilege Management for Windows settings, a PFX file containing an appropriate certificate and private key must be
supplied, alongside the corresponding password for the PFX file.

/4‘ Note: For settings to be correctly signed, the certificate must have an OID that is specific to BeyondTrust Privilege
Management for Windows. The chain of trust and revocation status is also checked by Privilege Management for
Windows. If the settings have been tampered with since signing, the settings will also fail the signing check.

L]
1 For more information about creating certificates suitable for use with Privilege Management for Windows, please see

"Create a PFX File for use with Privilege Management for Windows " on page 25.

To digitally sign the Privilege Management for Windows settings:

Select the BeyondTrust Settings node.

Right-click and select Digitally Sign.

The Digitally sign your BeyondTrust Settings wizard appears.

Check Sign the settings with the following private key option.

Click the Select key button and browse for the PFX file that contains your digital certificate.
Enter the password for the PFX file.

Click Finish.

N o s~ e Db =

To remove the digital signature from the Privilege Management for Windows settings:

Select the Privilege Management Settings node.

Right-click and click Digitally Sign.

The Digitally sign your Privilege Management Settings wizard appears.
Select the Do not sign the settings option.

Click Finish.

o kK wnh =

Once the Privilege Management for Windows settings are digitally signed, the Privilege Management Policy Editor will prompt the
administrator for the corresponding PFX password when the settings are opened.
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To modify the signed settings, you must enter a valid password for the Signed Privilege Management Settings L
PFX. Alternatively, you can select to remove the certificate from the Signed Privilege Management Settings
settings, or open the settings in Read Only mode. Canceling this prompt s e e s B T T

automatically opens the settings in Read Only mode.

The Privilege Management Settings have been digitally signed, to edit them you must enter
the PFYX file password, alternatively you can remove the signature or use Read Only mode

(®) Work with signed settings
To continue please enter the password

(C) Remove digital signature from these settings

The settings can be modified by an administrater after deployment

() Work with the settings in Read Only mode
‘ou will be able to view the settings content but not make any changes
(if you press Cancel you will be placed into Read Only mode)

< Back Finsh | | cancel

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 30

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/12019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrust GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Behavior when Policy Certificate Verification Fails

When using signed Privilege Management for Windows settings, timely certificate revocation enforcement may be desired. This
scenario is most common for clients unable to reach the CRL source since they are off the corporate network for extended periods of
time.

By default, Privilege Management for Windows will allow certificates whose revocation may not be confirmed with Microsoft Crypto
APIs from either cached information, or directly from the CRL source.

The following registry configuration may be used to change the default behavior:

HKEY LOCAL MACHINE\SOFTWARE\Avecto\Privilege Guard Client\
DWORD “CRLNetworkErrorFailOpen” = 0

Failure to retrieve CRL is deemed an error and policy will not be loaded.
DWORD “CRLNetworkErrorFailOpen” = 1

Failure to retrieve CRL is deemed a warning and policy will still be loaded. This is the default behavior if this registry setting has not
been configured.

The CRL is cached when downloaded and honored until its Time To Live (TTL) has expired (standard Microsoft CryptoAPI behavior).
The Certificate Authority may be configured according to requirements. Microsoft Group Policy provides centralized configuration in
this area. Security and usability need to be balanced according to your organization's risk tolerance.

Note: Prior settings from the same source type (GPO, HTTP, etc) will be deleted before the newly acquired settings are
verified. This could lead to no policy in effect on the endpoint in the case that invalid settings are delivered, and no valid
settings from other sources are in place.

Manual Deployment of Privilege Management for Windows

Privilege Management for Windows can optionally be deployed manually using any Windows Installer compatible third party
deployment system. The Privilege Management for Windows package is available as both an MSI package and self-installing
executable package, from the BeyondTrust product archive.

Prerequisites

Privilege Management for Windows must be installed in ePO Mode, either by selecting the McAfee ePolicy Orchestrator Integration
option when installing Privilege Management for Windows, or by using a command line option if installing the client using a
deployment system. This will install additional components required to communicate with the McAfee Agent.

To install the client MSI package silently in ePO Mode, use the following command line:
MSIEXEC.exe PrivilegeManagementForWindows x(XX).msi /i /gn EPOMODE=1

To install the client executable silently in ePO Mode, use the following command line (the double quotes are required):
PrivilegeManagementForWindows x (XX).exe /s /v“ /qn EPOMODE=1"

Where (XX) represents 86 or 64 in relation to the 32-bit or 64-bit installation respectively.

The syntax above must be copied exactly for the install to work as designed, including all spacing.
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x Note: If you are deploying Privilege Management for Windows using McAfee ePO, then ePO Mode is automatically
enabled.

Disable ePO Mode

Once installed in ePO Mode, Privilege Management for Windows will send events to the McAfee Agent, as well as raising events to
the Application Log. If you want to disable ePO mode at any time, set the following registry key:

HKEY_LOCAL_MACHINE\Software\Avecto\Privilege Guard Agent\DWORD “EPOMode”’=
To re-enable ePO Mode, set the above DWORD value to 1.
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Launch the Privilege Management Policy Editor

The Privilege Management Policy Editor is accessed as a snap-in to the Microsoft Management Console.

From your administrator account, launch the Microsoft Management Console (MMC.exe). Type MMC into the Search Box from the
Start Menu and press the Enter key.

We will now add Privilege Management for Windows as a snap-in to the console.
Select File from the menu bar and select Add/Remove Snap-in.

Scroll down the list and select the Privilege Management Settings snap-in. Click Add and then click OK.
Optionally, select File > Save as and save a shortcut for the snap-in to the desktop as Privilege Management.

e DN =

Select the Privilege Management Settings node in the left pane and select the operating system node to display the main
screen in the details pane.

Navigate the Policy Editor

The left pane containing the Privilege Management Settings item is
referred to as the Tree pane. The folders beneath Privilege
Management Settings in the tree pane are referred to as Nodes. The
middle pane, which displays content relevant to the selected node, is
referred to as the Details pane.

If you expand the Privilege Management Settings node, you will see three nodes:

1. Windows: Create Privilege Management policy for Windows endpoints.
2. 0OS X: Create Privilege Management policy for macOS endpoints.
3. Licensing: Manage Privilege Management licenses.

When you expand the Windows node, you see five nodes:

Workstyles: Assign privileges to applications.
Application Groups: Define logical groupings of applications.
Content Groups: Define specific file content.

Messages: Define end user messages.

o R~ DN =

Custom Tokens: Define custom access tokens.

Once a Workstyle is created and selected in the tree pane, the Workstyle tabs are displayed in the details pane.

Automatic Save

By default, the Privilege Management Settings editor will automatically save any changes back to the appropriate GPO (or local XML
file if you are using the standalone console).
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Automatic saving can be disabled, by deselecting the Auto Commit Settings menu option on the Privilege Management Settings
node, but we do not recommend it unless you have performance issues. If you deselect the Auto Commit Settings option, then you
must select the Commit Settings menu option to manually save any changes back to the GPO. The Auto Commit Settings option is
persisted to your user profile, so it will be set for all future editing of Privilege Management for Windows settings.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 34

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/12019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrust GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Policies and Templates

A Privilege Management for Windows policy is made up of one or more items from the following groups. Each of these groups can be
a node in Privilege Management Settings:

« Workstyles

o A Workstyle is part of a policy. It's used to assign application rules for users. You can create Workstyles by using the
WorkStyle Wizard or by importing them.

« Application Groups

o Application groups are used by Workstyles to group applications together to apply certain Privilege Management for
Windows behavior.

« Content Groups

o Content groups are used by Workstyles to group content together to apply certain Privilege Management for Windows
behavior.

« Messages

o Messages are used by Workstyles to provide information to the end user when Privilege Management for Windows
has applied certain behavior that you've defined and need to notify the end-user.

o Custom Tokens

o Custom tokens are used by Workstyles to assign custom privileges to content or application groups.

Users

Disconnected users are fully supported by Privilege Management for Windows. When receiving policies from McAfee ePO, Privilege
Management for Windows automatically caches all the information required to work offline, so the settings will still be applied if the
clientis not connected to the corporate network. Any changes made to the policy will not propagate to the disconnected computer
until the McAfee Agent re-establishes a connection to the ePO Server.

Policies

Privilege Management for Windows policies are applied to one or more endpoints. The Policy Summary screen summaries for the
number of Workstyles, Application Groups, target URL groups, target content groups, messages, tokens and licenses in the policy. As
this is a blank policy, all summaries will be zero.

Each item summary includes an Edit <ltem> button, which allows you to jump to that section of the policy.

Privilege Management for Windows incorporates an autosave, autosave recovery, and concurrent edit awareness feature to reduce
the risk or impact of data loss and prevent multiple users from overwriting individual polices.

A Privilege Management for Windows template is a configuration that is merged with your existing policy. A template also consists of
any number of Workstyles, Application Groups, Content Groups, Messages, and Custom Tokens.

Edit Group Policy

To edit policy, we recommend you use the Group Policy Management snap-in. Once you install the Privilege Management Policy
Editor, the Privilege Management for Windows settings are available in the Group Policy Management snap-in. The Group Policy
Management snap-in can be accessed from the Microsoft Management Console or Group Policy Management editor.
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Note: If you want to create local policy to administer your endpoints, you can use the Privilege Management snap-in in the
Microsoft Management Console or the Local Group Policy Editor. This will create a local policy only.
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Privilege Management Settings

You can right-click on the Privilege Management Settings node to access the following commands.

You can click Tools in the right pane to access:

« "Privilege Management for Windows Activity Viewer" on page 40
« "Response Code Generator" on page 41

By default, Auto Commit Settings is selected. This means any changes made here are saved and applied using group policy.
Alternatively, you can clear Auto Commit Settings and select Commit Settings when you specifically want those settings to apply.

The following options are also available:

« "Create" on page 37

o "Delete" on page 37

« "Export" on page 38

o "Import" on page 38

« "lmport Template" on page 38

« "Digitally Sign" on page 38

« "Save Report" on page 38

« "Set Challenge/Response Shared Key" on page 38
o "Show Hidden Groups" on page 38

o "View" on page 39

Create

Creates a new Privilege Management for Windows policy. This will delete any existing policy for all operating systems. If you have an
existing policy, you are prompted to remove all existing settings when you click Create. Click Yes to delete your existing policy and
create a new one or No to keep your existing policy.

Delete

Deletes your existing Privilege Management for Windows policy. You are prompted to remove all existing settings when you click
Delete. Click Yes to delete your existing policy or No to keep your existing policy.

Delete Items and Conflict Resolution

Some items in Privilege Management Settings are referenced in other areas, such as application groups, messages and custom
tokens. These items can be deleted at any time, and if they are not referenced elsewhere, they delete without any further action
required.

When an item is deleted, Privilege Management Policy Editor will check for any conflicts which may need to be resolved. If the item
you attempt to delete is already in use elsewhere in your settings, then a conflict will be reported, and will need to be resolved.

You can review each detected conflict and observe the automatic resolution which will take place if you proceed. If more than one
conflictis reported, use the Next conflict and Previous conflict links to move between conflicts.

If you want to proceed, click Resolve All to remove the item from the areas of your Privilege Management Settings where itis
currently in use.
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Export

Privilege Management for Windows policies can be imported to and exported from Group Policy as XML files, in a format common to
other editions of Privilege Management, such as the Privilege Management ePO Extension. This allows for policies to be migrated
and shared between different deployment mechanisms.

To export a policy, click Export and give the file a name. Click Save.

Import
Privilege Management for Windows policies can be imported to and exported from Group Policy as XML files, in a format common to

other editions of Privilege Management, such as the Privilege Management ePO Extension. This allows for policies to be migrated
and shared between different deployment mechanisms.

To import a policy, click Import, navigate to the policy XML you want to import, and click Open.

Import Template

Allows you to import template policies.

L]
1 For more information, please see "Templates" on page 42.

Digitally Sign

You can digitally sign the Privilege Management for Windows settings. Privilege Management for Windows can either enforce or
audit the loading of signed settings.

L]
1 For more information, please see "Sign Privilege Management for Windows Settings" on page 23.

Save Report

You can obtain a report of your Windows policy which can be saved locally, if required.

Set Challenge/Response Shared Key

This allows you to set the Challenge/Response Shared Key for the policy. This is encrypted once you have setit. This key is then
required by the Challenge/Response generator to generate response codes. The only way to change the Challenge/Response
Shared Key is by setting a new one.

Show Hidden Groups

Some application groups are hidden by default; for example, application groups prefixed by (Default) in the QuickStart Policy. You
can show or hide application groups in Privilege Management for Windows.

To show groups that are hidden by default, right-click on the Privilege Management Settings node and select Show Hidden
Groups. You can hide the groups again by clearing Show Hidden Groups.
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View

This allows you to view the Workstyles Editor, which is the default, or the HTML Report for your Windows policy.

[ ]
1 For more information, please see "HTML Report" on page 39.

License

Privilege Management for Windows requires a valid license code to be entered in the Privilege Management Policy Editor. If multiple
Privilege Management for Windows policies are applied to an endpoint, you need at least one valid license code for one of those
policies.

For example, you could add the Privilege Management for Windows license to a Privilege Management for Windows policy thatis
applied to all managed endpoints, even if it doesn't have any Workstyles. This ensures all endpoints receive a valid Privilege
Management for Windows license if they have Privilege Management for Windows installed. If you are unsure, then we recommend
you add a valid license when you create the Privilege Management for Windows policy.

Insert a License

1. Click No License. Click to enter a license code to enter a license if one doesn't already exist, or Valid License if you want to
enter an additional license code.

2. Paste your Privilege Management for Windows license code and click Add. The license details are shown.

HTML Report

The Privilege Management for Windows settings may be viewed as an HTML report for your Windows policy only. This report follows
the same style as the Group Policy Management Console (GPMC) reports.

To show the HTML view:

1. Select the Privilege Management Settings node.
2. Right-click and select View > HTML Report.

Privilege Management for Windows uses the same style as the GPMC for its HTML reports. You can expand and collapse the various
sections of the HTML report to show or hide more detailed information.

To return to the Workstyle Editor view:

1. Select the Privilege Management Settings node.

2. Right-click and select View > Workstyles Editor.
You may also save the HTML report to a file (the HTML view does not need to be displayed to save the HTML report).
To save a HTML Report:

1. Select the Privilege Management Settings node.

2. Right-click and click Save Report.
3. Enter afilename for the report and click Save.
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f Note: When displaying Resultant Set of Policy (RSoP) results, the Privilege Management Settings Policy Editor will default
to HTML view, but a read-only Workstyles Editor view may also be displayed.

Privilege Management for Windows Activity Viewer

The Privilege Management for Windows Activity Viewer is an advanced diagnostics tool designed to help identify improvements in
Privilege Management for Windows Workstyles. It allows IT administrators to remotely connect to any Privilege Management for
Windows instance on the network and view all recent activity on the desktop.

To access the Privilege Management for Windows Activity Viewer, select Tools from the right-hand pane of the Privilege
Management Settings start page.

The Activity Viewer will collect a complete audit of every application that ran on the desktop, and provide a detailed summary of how
Privilege Management for Windows interacted with those applications, what actions it applied, and the rules that it used to determine
that action.

The activity is displayed in a rich, detailed, yet simple to use interface that provides every snippet of information required to better
understand the Workstyles deployed to endpoints, how they affect the applications being run, and rapidly identify unexpected

outcomes.
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Response Code Generator

The Response Code Generator allows you to generate a response code using the PGChallengeResponseUl utility.

To generate a Response Code from Privilege Management Settings:

1. Click the Tools link from the right pane of Privilege Management © BeyondTrust Privilege Management Response Code Generator w
Settings.
Click Launch Response Code Generator.

3. Enter your shared key and the challenge code. The response d‘ knter shared key

code is shown in the third text field.

B | Enter challenge code

Generate a One Use Only code v

(£ ‘ Response shown here ‘
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Templates

Templates can be imported into your Privilege Management for Windows settings. You can choose to merge them into your existing
policy; otherwise, the template overwrites your existing policy.

The following templates are Windows specific:

o "Windows QuickStart" on page 42

« "Discovery" on page 48

o "Server Roles" on page 49

« "Trusted App Protection (TAP)" on page 49

Windows QuickStart

The QuickStart for Windows policy contains Workstyles, Application Groups, Messages, and Custom Tokens configured with
Privilege Management and Application Control. The QuickStart policy is designed from BeyondTrust’s experiences of implementing
the solution across thousands of customers, and is intended to balance security with user freedom. As every environment is different,
we recommend you thoroughly test this configuration to ensure it complies with the requirements of your organization.

(1) IMPORTANT!

As of release 5.5, all releases of this product will be signed with BeyondTrust Corporation, rather than Avecto, as the software
publisher name. If prior to 5.5 you used the QuickStart Policy Template as a starting point, it is likely that your configuration will
include application groups which target our own applications based on a publisher match to Avecto. An upgrade to 5.5 or
beyond requires you to update your configuration so that it continues to match the versions of the applications and tools that you
use. We recommend one of the following two options:

Option 1

Add a copy of any existing application definitions which target Avecto and update those copies to target BeyondTrust
Corporation instead; the presence of both sets of application definitions will ensure they continue to match both new and
existing versions during the implementation of 5.5. This option has an advantage over Option 2, in that it also targets any
application definitions that you may have created yourselfthat target the Avecto publisher.

Option 2
You may copy fragments of the QuickStart policies in version 5.5 to your existing application definitions.

For either option, it is critical that you roll out your configuration changes before you update your Privilege Management for
Windows software to version 5.5 or later.

L]
1 For information on how to upgrade Avecto signed application definitions, please see "Upgrade Privilege Management for
Windows" on page 14

This template policy contains the following elements:
Workstyles

o All Users
« High Flexibility
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Medium Flexibility
Low Flexibility

Application Groups

Add Admin - All Users (Business Apps)
Add Admin - All Users (Windows Functions)
Add Admin - High Flexibility

Add Admin - Medium Flexibility

Add Admin - Low Flex (added)

Allow - Whitelisted Functions & Apps
Block - Blacklisted Apps

Passive - High Business Apps

Passive - Medium Business Apps
Passive - Low Business Apps
Whitelisted Functions & Apps

Hidden Application Groups

(Default) Any Application

(Default) Any Trusted & Signed UAC Prompt
(Default) Any UAC Prompt

(Default) Privilege Management Tools

(Default) Child Processes of TraceConfig.exe
(Default) Signed UAC Prompt

(Default) Software Deployment Tool Installs
(Recommended) Restricted Functions
(Recommended) Restricted Functions (On-Demand)

(Default) Trusted Parent Processes

Messages

Custo

SALES: www.beyondtrust.com/contact

Allow Message (Authentication & Reason)
Allow Message (Select Reason)

Allow Message (Support Desk)

Allow Message (Yes / No)

Block Message

Block Notification

Notification (Trusted)

m Tokens

BeyondTrust Support Token

PRIVILEGE MANAGEMENT FOR WINDOWS
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Windows QuickStart Policy Summary

By using and building on the QuickStart policy, you can quickly improve your organization's security without having to monitor and
analyze your users' behavior first and then design and create your Privilege Management for Windows configuration.

After the QuickStart policy is deployed to groups within your organization, you can start to gather information on your users' behavior.
This will provide you with a better understanding of the applications used within your organization, and whether they require admin
rights, need to be blocked, or need authorizing for specific users.

This data can then be used to further refine the QuickStart policy to provide a more tailored Privilege Management for Windows
solution for your organization.

Windows Workstyles

The QuickStart policy contains five workstyles that should be used together to manage all users in your organization.
All Users
This Workstyle contains a set of default rules that apply to all standard users regardless of the level of flexibility they need.

The All Users Workstyle contains rules to:

« Block any applications that are in the Block — Blacklisted Apps group
« Allow Privilege Management for Windows Support tools

« Allow standard Windows functions, business applications, and applications installed through trusted deployment tools to run
with admin rights

« Allow approved standard user applications to run passively
High Flexibility
This Workstyle is designed for users that require a lot of flexibility, such as developers.

The High Flexibility Workstyle contains rules to:

« Allow known white-listed business applications and operating system functions to run

« Allow users to run signed applications with admin rights

« Allow users to run unknown applications with admin rights once they confirm that the application should be elevated
« Allow applications that are in the Add Admin — High Flexibility group to run with admin rights

« Allow unknown business application and operating system functions to run on-demand

Medium Flexibility
This Workstyle is designed for users that require some flexibility, such as sales engineers.

The Medium Flexibility Workstyle contains rules to:

« Allow known whitelisted business applications and operating system functions to run

« Allow users to run signed applications with admin rights once they confirm that the application should be elevated
« Promptusers to provide a reason before they can run unknown applications with admin rights

« Allow applications that are in the Add Admin — Medium Flexibility group to run with admin rights

« Allow unknown business application and operating system functions to run on-demand

« Restricted OS functions that require admin rights are prevented and require support interaction
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Low Flexibility

This Workstyle is designed for users that don't require much flexibility, such as helpdesk operators.

The Low Flexibility Workstyle contains rules to:

« Promptusers to contact support if a trusted or untrusted application requests admin rights

« Prompt users to contact supportif an unknown application tries to run

« Allow known approved business applications and operating system functions to run

Windows Workstyle Parameters

The Privilege Management for Windows settings include a number of features allowing customization of text and strings used for end
user messaging and auditing. If you want to include properties relating to the settings applied, the application being used, the user, or
the installation of Privilege Management for Windows, then parameters may be used which are replaced with the value of the

variable at runtime.

Parameters are identified as any string surrounded by square parentheses ([ ]), and if detected, the agent will attempt to expand the
parameter. If successful, the parameter will be replaced with the expanded property. If unsuccessful, the parameter will remain part of
the string. The table below shows a summary of all available parameters and where they are supported.

Parameter Description

[PG_ACTION]
[PG_AGENT _VERSION]
[PG_APP_DEF]
[PG_APP_GROUP]
[PG_AUTH_USER_DOMAIN]
[PG_AUTH_USER_NAME]
[PG_COM_APPID]
[PG_COM_CLSID]
[PG_COM_NAME]
[PG_COMPUTER_DOMAIN]
[PG_COMPUTER_NAME]
[PG_CONTENT_DEF]

[PG_CONTENT_FILE_DRIVE_
TYPE]

[PG_CONTENT_FILE_HASH]
[PG_CONTENT FILE_IE_ZONE]
[PG_CONTENT_FILE_NAME]
[PG_CONTENT_FILE_OWNER]
[PG_CONTENT FILE_PATH]
[PG_CONTENT_GROUP]
[PG_DOWNLOAD_URL]
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The action which the user performed from an end user message

The version of Privilege Management for Windows

The name of the application rule that matched the application

The name of the application group that contained a matching application rule
The domain of the designated user who authorized the application

The account name of the designated user who authorized the application
The APPID of the COM component being run

The CLSID of the COM component being run

The name of the COM component being run

The name of the domain that the host computer is a member of

The NetBIOS name of the host computer

The definition name of the matching content

The drive type of the matching content

The SHA-1 hash of the matching content

The Internet Zone of the matching content

The file name of the matching content

The owner of the matching content

The full path of the matching content

The group name of a matching content definition

The full URL from which an application was downloaded
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Parameter Description

[PG_DOWNLOAD_URL_DOMAIN] | The domain from which an application was downloaded

[PG_EVENT_TIME]
[PG_EXEC_TYPE]
[PG_GPO_DISPLAY_NAME]
[PG_GPO_NAME]
[PG_GPO_VERSION]
[PG_MESSAGE_NAME]
[PG_MSG_CHALLENGE]
[PG_MSG_RESPONSE]
[PG_POLICY_NAME]
[PG_PROG_CLASSID]
[PG_PROG_CMD_LINE]
[PG_PROG_DRIVE_TYPE]
[PG_PROG_FILE_VERSION]
[PG_PROG_HASH]
[PG_PROG_NAME]
[PG_PROG_PARENT NAME]
[PG_PROG_PARENT PID]
[PG_PROG_PATH]
[PG_PROG_PID]
[PG_PROG_PROD_VERSION]
[PG_PROG_PUBLISHER]
[PG_PROG_TYPE]
[PG_PROG_URL]
[PG_SERVICE_ACTION]
[PG_SERVICE_DISPLAY_NAME]
[PG_SERVICE_NAME]
[PG_STORE_PACKAGE_NAME]
[PG_STORE_PUBLISHER]
[PG_STORE_VERSION]
[PG_TOKEN_NAME]
[PG_USER_DISPLAY_ NAME]
[PG_USER_DOMAIN]
[PG_USER_NAME]
[PG_USER_REASON]
[PG_USER_SID]
[PG_WORKSTYLE_NAME]

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company,
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.

SUPPORT: www.beyondtrust.com/support

The date and time that the policy matched

The type of execution method: application rule or shell rule
The display name of the GPO (Group Policy Object)

The name of the GPO that contained the matching policy
The version number of the GPO that contained the matching policy
The name of the custom message that was applied

The 8 digit challenge code presented to the user

The 8 digit response code entered by the user

The name of the policy

The ClassID of the ActiveX control

The command line of the application being run

The type of drive where application is being executed
The file version of the application being run

The SHA-1 hash of the application being run

The program name of the application

The file name of the parent application

The process identifier of the parent of the application
The full path of the application file

The process identifier of the application

The product version of the application being run

The publisher of the application

The type of application being run

The URL of the ActiveX control

The action performed on the matching service

The display name of the Windows service

The name of the Windows service

The package name of the Windows Store App

The package publisher of the Windows Store app

The package version of the Windows Store app

The name of the built-in token or custom token that was applied
The display name of the user

The name of the domain that the user is a member of
The account name of the user

The reason entered by the user

The SID of the user

The name of the workstyle
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Windows Application Groups

The application groups that are prefixed with (Default) or (Recommended) are hidden by default and do not need to be altered.
- Add Admin - General (Business Apps): Contains applications that are approved for elevation for all users, regardless of
their flexibility level.

« Add Admin - General (Windows Functions): Contains operating system functions that are approved for elevation for all
users.

« Add Admin - High Flexibility: Contains the applications that require admin rights that should only be provided to the high
flexibility users.

« Add Admin - Low Flexibility: Contains the applications that require admin rights that should only be provided to the low
flexibility users.

« Add Admin — Medium Flexibility: Contains the applications that require admin rights that should only be provided to the
medium flexibility users.

« Passive - High Business Apps

« Passive - Medium Business Apps

« Passive - Low Business Apps

« Block - Blacklisted Apps: This group contains applications that are blocked for all users.

- Whitelisted Functions & Apps: Contains trusted applications, tasks and scripts that should execute as a standard user.
« (Default) Any Application: Contains all application types and is used as a catch-all for unknown applications.

o (Default) Any Trusted & Signed UAC Prompt: Contains signed (trusted ownership) application types that request admin
rights.

« (Default) Any UAC Prompt: This group contains applications types that request admin rights.

« (Default) Privilege Management Tools: This group is used to provide access to a BeyondTrust executable that collects
Privilege Management for Windows troubleshooting information.

« (Default) Child Processes of TraceConfig.exe
« (Default) Signed UAC Prompt: Contains signed (trusted ownership) application types that request admin rights.

. (Default) Software Deployment Tool Installs: Contains applications that can be installed by deployment tools such as
System Center Configuration Manager (SCCM).

« (Recommended) Restricted Functions: This group contains OS applications and consoles that are used for system
administration and trigger UAC when they are executed.

« (Recommended) Restricted Functions (On Demand): This group contains OS applications and consoles that are used for
system administration.

o (Default) Trusted Parent Processes

Windows Messages

The following messages are created as part of the QuickStart policy and are used by some of the application rules:

« Allow Message (Authentication): Asks the user to provide a reason and enter their password before the application runs with

admin rights.
« Allow Message (Select Reason): Asks the user to select a reason from a drop-down menu before the application runs with
admin rights.
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« Allow Message (Support Desk): Presents the user with a challenge code and asks them to obtain authorization from the
support desk. Support can either provide a response code or a designated, authorized user can enter their login details to
approve the request.

« Allow Message (Yes / No): Asks the user to confirm that they want to proceed to run an application with admin rights.
- Block Message: Warns the user that an application has been blocked.

« Block Notification: Notifies the user that an application has been blocked and submitted for analysis.

« Notification (Trusted): Notifies the user that an application has been trusted.

Windows Custom Token

A custom token is created as part of the QuickStart policy. The custom token is called Privilege Management Support Token and is
only used to ensure an authorized user can gain access to Privilege Management for Windows troubleshooting information.

Note: We do not recommend using the Privilege Management Support Token for any other application rules in your
Workstyles.

Customize the Windows QuickStart Policy

Before deploying the QuickStart policy to your users, you need to make some company-specific customizations to the standard
template.

As a minimum you need to:
« Configure the users or groups that can authorize requests that trigger messages.
« Assign users and groups to the high, medium, and low flexibility Workstyles.

« Populate the Block Blacklist Apps application group with any applications that you want to block for all users.
« Setyour shared key so you can generate a Privilege Management for Windows Response code.

Discovery

The Discovery policy contains Workstyles, Application Groups, and Messages to allow the discovery of applications that need
administrative privileges to execute. This must be applied to administrator users and includes a pre-configured exclusion group (false
positives) maintained by BeyondTrust.

This template policy contains the following configurations:

« Workstyles
o Discovery Workstyle
« Application Groups
o (Default Rule) Any Application
o (Default Rule) Any UAC Prompts

o Approved Standard User Apps
o Whitelisted Functions & Apps

« Messages
« Allow Message (Yes /No)
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Server Roles

The Server Roles policy contains Workstyles, Application Groups, and Content Groups to manage different server roles such as
DHCP, DNS, IIS, and Print Servers.

This template policy contains the following elements:

« Workstyles

o Server Role - Active Directory - Template

o Server Role - DHCP - Template

o Server Role - DNS - Template

o Server Role - File Services - Template

o Server Role - Hyper V - Template

o Server Role - IS - Template

o Server Role - Print Services - Template

o Server Role - Windows General - Template

« Application Groups

o Server Role - Active Directory - Server 2008R2
o Server Role - DHCP - Server 2008R2

o Server Role - DNS - Server 2008R2

o Server Role - File Services - Server 2008R2

o Server Role - General Tasks - Server 2008R2
o Server Role - Hyper V - Server 2008R2

o Server Role - IIS - Server 2008R2

o Server Role - Print Services - Server 2008R2

« Content Groups

o AD Management

o Hosts Management
o |IS Management

o Printer Management
o Public Desktop

Trusted App Protection (TAP)

The Trusted App Protection (TAP) policies contain Workstyles, Application Groups, and Messages to offer an additional layer of
protection against malware for trusted business applications, safeguarding them from exploitation attempts.

The TAP policies apply greater protection to key business applications including Microsoft Office, Adobe Reader, and web browsers,
which are often exploited by malicious content. It works by preventing these applications from launching unknown payloads and
potentially risky applications, such as PowerShell. It also offers protection by preventing untrusted DLLs being loaded by these
applications, another common malware technique.
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In our research, we discovered that malware attack chains commonly seek to drop and launch an executable or abuse a native
Windows application such as PowerShell. Using a TAP policy prevents these attacks and compliments existing anti-malware
technologies by preventing an attack from launching without relying on detection or reputation.

The Trusted Application Protection policy you have chosen is inserted at the top of the Workstyles, so itis, by default, the first
Workstyle to be evaluated. Once a Workstyle action is triggered, subsequent Workstyles aren't evaluated for that process.

Workstyles

« Trusted Application Protection - High Flexibility (depends on the TAP policy you have chosen)
« Trusted Application Protection - High Security (depends on the TAP policy you have chosen)

Application Groups

« Browsers

« Browsers - Trusted Exploitables

« Browsers - Untrusted child processes

« ContentHandlers

« ContentHandlers - Trusted Exploitables

« ContentHandlers - Untrusted child processes

f Note: Content Handlers are used to hold content rather than executables.

Messages

« Block Message

Trusted Application Protection Policies Summary

The TAP policies allow you to control the child processes which TAP applications can run.

There are two policies to choose from:

« High Flexibility
« High Security

You should choose the High Flexibility policy if you have users who need to download and install or update software. You should
choose the High Security policy if your users don't need to download and install or update software.

The High Security policy checks that all child processes have either a trusted publisher, a trusted owner, a source URL, or a
BeyondTrust Zone Identifier tag, whereas the High Flexibility policy only validates the immediate child processes allowing a wider
range installers to run’. If child processes don't have any of these four criteria, they are blocked from execution. Known exploits are
also blocked by both TAP policies.

-
1 For more information, please see "Trusted Application Protection Blacklist" on page 53.

TInstallers that spawn additional child processes are blocked by the TAP (High Security) policy if those child processes are using
applications that are on the TAP blacklist, but would be allowed to run using the TAP (High Flexibility) policy. For more information,
please see "Trusted Application Protection Blacklist" on page 53
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Trusted Publisher

« Atrusted publisher must be signed. In addition, the publisher certificate must be valid, in date, and not revoked.
Trusted Owner

« Atrusted owner is any owner thatis in the default Windows groups Administrators, SystemUser, or Trustedinstaller.
SourceURL

« The source URL must be present. This is specific to browsers.
BeyondTrust Zone Identifier tag

« The BeyondTrust Zone Identifier tag must be present. This is applied when the browser applies an Alternate Data Stream
(ADS) tag. This is specific to browsers.

In addition, all processes on the blacklist are blocked irrespective of their publisher and owner.

L]
1 For a list of blacklisted processes, please see "Trusted Application Protection Blacklist" on page 53.

The TAP policy template affects the following applications:

« Microsoft Word

« Microsoft Excel

« Microsoft PowerPoint

« Microsoft Publisher

« Adobe Reader 11 and lower
« Adobe Reader DC

o Microsoft Outlook

« Google Chrome

« Mozilla Firefox

« Microsoft Internet Explorer
« Microsoft Edge

Note: TAP applications and their child processes must match all the criteria within the definitions provided in the
Application Groups of the policy for the TAP policy to apply.

You can configure TAP process control by importing the TAP template. TAP also has Reporting.

L]
1. Formore information, please see "Trusted Application Protection Reporting" on page 53.

Trusted Application Protection Precedence

The TAP workstyle you choose is placed at the top of your list of Workstyles when you import the policy template. This is because it
runs best as a priority rule. This ensures child processes of TAP applications (policy dependent) that do not have a trusted publisher,
trusted owner, a source URL, or a BeyondTrust Zone Identifier tag are blocked from execution and that known exploits are blocked.
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The Trusted Application Protection Workstyle is the first to be evaluated by default. Once a Workstyle action is triggered, subsequent
Workstyles aren't evaluated for that process.

Modify the Trusted Application Protection Policies

Both the Trusted Application Protection (TAP) policies (High Flexibility and High Security) protect against a broad range of attack
vectors. The approaches listed here can be used in either TAP policy if you need to modify the TAP policy to address a specific use
case thatis being blocked by a TAP policy.

The TAP (High Security) policy is, by design, more secure and less flexible, as it blocks all child processes of a Trusted Application
that do not have a trusted owner, trusted publisher, source URL, or BeyondTrust Zone Identifier. It is for these reasons more likely to
require modification.

The TAP policy that you choose should be based on your business requirements and existing policy. If using a TAP policy causes a
legitimate use case to be blocked, there are some actions you can take to resolve this.
Change the Policy to Passive and Audit

You can change the TAP (High Security) policy Application Rules Action to Allow Execution and change the Access Token to
Passive (No Change). Ensure Raise an Event is set to On and click OK.

Note: Changing the TAP policy to Allow Execution effectively disables it. You will not get any protection from a TAP policy
if you make this change.

If you make this change for the four Application Rules in the TAP (High Security) policy, TAP programs will be able to execute as if the
TAP (High Security) policy wasn't applied, but you can see what events are being triggered by TAP and make policy adjustments
accordingly.

The event details include information on the Application Group and TAP application. This allows you to gather details to understand if
it's a legitimate use case. You can perform some actions to incorporate the legitimate use case into the TAP (High Security) policy.

Use the High Flexibility Policy

Both the TAP policies offer additional protection against a wide range of attack vectors. If you are using the TAP (High Security) policy
you can change to the TAP (High Flexibility) policy. This is useful if you have a use case where additional child processes of
TAP applications are being blocked by the TAP (High Security) policy.

Edit the Matching Criteria

If your legitimate use case is running a specific command thatis detailed in the event, you can add this to the matching criteria of the
application that's being blocked. You can use the standard Privilege Management for Windows matching criteria, such as Exact
Match or Regular Expressions.

Example
Webex uses an extension from Google Chrome. We have catered for this in the policy using matching criteria.
This criteria says:

If the Parent Process matches the (TAP) High Security - Browsers application group for any parentin the tree.
and

The Product Description contains the string Windows Command Processor

and

The Command Line does NOT contain \\.\pipe\chrome.nativeMessaging
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The TAP policy (High Security) will block the process.

Edit the Trusted Exploitable List

If your legitimate use case is using an application that is listed on either the Browsers - Trusted Exploitables or the Content
Handlers - Trusted Exploitables list, you can remove it.

If you remove it from either list, any browsers or content using that trusted exploitable to run malicious content won't be stopped by the
TAP (High Security) policy.

Remove Application from Trusted Application Group

You can remove the application that s listed in the Trusted Browsers or Trusted Content Handlers groups from the list. This will
mean that application no longer benefits from the protection offered by either of the TAP policies.

Create an Allow Rule

You can also add a Privilege Management for Windows Allow rule and place it higher in the precedence order than the TAP (High
Security) policy. This will allow your use case to run but, it also overrides any subsequent rules that apply to that application so it
should be used with caution.

Trusted Application Protection Reporting

Trusted Application Protection (TAP) is reported in Reporting. You can use the top level TAP dashboard to view the TAP incidents
over the time period, split by type of TAP application. In the same dashboard, you can also see the number of incidents, targets,
users, and hosts for each TAP application.

Trusted Application Protection Blacklist

The following list contains all of the applications that are blocked from being launched by trusted applications when Trusted
Application Protection (TAP) is enabled:

o Bash

- BGInfo

« Boot Configuration Data Editor

« CDB&NTSD

o CMD - Windows Command Processor

« Command Line Interface for Microsoft® Volume Shadow Copy Service
« CScript - Microsoft ® Console Based Script Host
« FSI

« FSIAny CPU

. |IEExec

o KD & NTKD

« MSBuild

o mshta

« PSExec
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« Registry Console Tool

« Regsvr

. WinDBG

« Windows PowerShell

« Windows PowerShell ISE

o WScript - Microsoft ® Windows Based Script
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Privilege Management for Windows Policies for Windows

A Privilege Management for Windows policy for Windows is built with the following optional components:

« Workstyles: A Workstyle is part of a policy. It's used to assign application rules for users. You can create Workstyles using the
WorkStyle Wizard or import them.

[ ]
1 For more information, please see "Workstyles" on page 57.

« Application Groups: Application groups are used by Workstyles to group applications together to apply certain Privilege
Management for Windows behavior.

1 For more information, please see "Application Groups" on page 85.

« Content Groups: Content groups are used by Workstyles to group content together to apply certain Privilege Management for
Windows behavior.

1 For more information, please see "Content Groups" on page 116.

- Messages: Messages are used by Workstyles to provide information to the end user when Privilege Management for
Windows has applied certain behavior that you've defined and need to notify the end-user.

1 Formore information, please see "Messages" on page 119.

« Custom Tokens: Custom tokens are used by Workstyles to assign custom privileges to content or application groups.

L]
1 For more information, please see "Custom Tokens" on page 132.

We have produced a pre-built QuickStart policy that is configured with Privilege Management for Windows and Application Control.

-
1 For more information on the BeyondTrust QuickStart policy, please see "Windows QuickStart Policy Summary" on page

44,

Policy Administration

You can import pre-built Privilege Management for Windows policies.

L]
1 For more information on template policies, please see "Import Template" on page 38.
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Advanced Agent Settings

The Advanced Agent Settings section allows you to configure and deploy additional registry based settings to Privilege
Management for Windows.

Right-click the top level Privilege Management Settings node and click Advanced Agent Settings.

2. Selecteither 32-bit Agent Values if you want to configure a 32-bit Advanced Agent Setings.. x
registry setting, or 64-bit Agent Values for a 64-bit registry Registry values deployed by the agent
setting. addvabe eced

Value Name Type Walue Data

Click Add Value. A new line is added to the advanced agent settings list.
Double-click the Value Name for the new setting, and enter the value name.
Choose the correct Type, either DWORD, String, or Multi-String.

Double-click the Value Data for the new setting, and enter the value data. For DWORD values, you can toggle the display type
between Hexadecimal and Decimal.

R

7. Click OK to save your changes.

x Note: Each advanced agent setting adheres to Group Policy precedence rules. If advanced agent settings are configured
in multiple Group Policies, then the Group Policy with the highest precedence will be applied (except for multi-string
settings, which will be merged and consolidated by Privilege Management for Windows).

x Note: Advanced Agent Settings should only be used when instructed to do so by BeyondTrust Technical Support.

Windows Policy Configuration Precedence

Privilege Management for Windows supports a variety of deployment methods, and accepts multiple simultaneous configurations
from any combination of the following:

- McAfee ePO Policy: A configuration that is stored in McAfee ePO, configured using the Privilege Management ePO
Extension in the ePO Policy Catalog.

« Webservice Policy: A configuration that is served from an PMC webservice using HTTPS.
« Webserver Policy: A configuration located on a web server, accessible using HTTP, HTTPS, or FTP.

« Group Policy: Configurations that are stored in Group Policy Objects, configured using Active Directory Group Policy (GPMC)
and GPEdit (Local Group Policy). Group Policy based configurations are evaluated according to GPO precedence rules.

« Local Policy: A standalone configuration, which is stored locally and is configured using the Privilege Management Policy
Editor snap-in for the Microsoft Management Console.
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- Beyondinsight: A web-based console where you configure and launch vulnerability assessment scans. As a scan completes,
a report is automatically generated. Results can be navigated interactively in the console.

Privilege Management for Windows uses the following default precedence to evaluate each configuration for matching rules:
ePO > Webservice > Beyondinsight > Webserver > GPO > Local

Configuration precedence settings can be configured either as part of the client installation, or using the Windows Registry once the
clientis installed.

To modify the configuration precedence at clientinstallation, use one of the following command lines to install Privilege Management
for Windows with a specific configuration precedence:

msiexec /i PrivilegeManagementForWindows xx (XX) .msi
POLICYPRECEDENCE="EPO, WEBSERVICE, WEBSERVER, GPO, LOCAL"

PrivilegeManagementForWindows x (XX) .exe /s /v"
POLICYPRECEDENCE=\"EPO, WEBSERVICE, WEBSERVER, GPO, LOCAL\""

Note: In the command line argument above, (XX) represents 86 or 64 in relation to the 32-bit or 64-bit installation
respectively.

To modify your configuration precedence using the Windows Registry, run regedit.exe with elevated privileges and an anti-tamper
token disabled. Navigate to the following key and edit the string as required:

HKEY_LOCAL_MACHINE\Software\Avecto\Privilege Guard Client
REG_SZ PolicyPrecedence = "EPO,WEBSERVICE,WEBSERVER,GPO,LOCAL"
Only deployment methods listed in the Privilege Management for Windows engineering key PolicyEnabled are applied, irrespective

of the order listed in the PolicyPrecedence key. Both keys are located in the same place in the Windows registry.

Workstyles

Privilege Management for Windows Workstyles are used to assign Application Groups for a specific user, or group of users. The
Workstyle wizard can generate Application Rules depending on the type of Workstyle you choose.

L ]
1 For more information, please also see:

« "Application Groups" on page 85
« "Create Workstyles" on page 59

Workstyle Properties

To edit the advanced properties for a Workstyle:

1. Expand the Workstyles node and select the relevant Workstyle.
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2. Right-click and select Edit Workstyle Options. Workstyle Options - New Controling Workstyle x
Configure Waorkstyle Options

Events

[]i0g Monitoring Event to Application Event Log:

[[JLog cancel Events {when user cancels message)

Note : Enabling this wil also allow audit scripts to run
Privilege Monitoring Log Files
=
|L E Log Application Activity to Log Files
Application Summary

M- Application Summary and Activity

Application Summary and Detailed Activity

—-‘ Maximum Activity Records per Process
L
Keep Application Activity Logs for days

Privilege Monitoring

Privilege Management for Windows can monitor the behavior of specific privileged applications and processes in Windows, a feature
called privilege monitoring. Privilege monitoring is enabled as an auditing option in the properties of an application rule or an on-
demand application rule. When enabled, Privilege Management for Windows records all privileged operations performed by the
application or process that would fail under a standard user account. These include file operations, registry operations, and any
interactions with other components such as Windows services.

The application must be running under a privileged account, such as an administrator or power user. Alternatively, an application
could be running with elevated privileges because you added it to the Application Rules or On-Demand Application Rules section
of the Workstyle and assigned it to run with admin rights.

Privilege monitoring logs are recorded on each endpoint, and the logs can be accessed using the Privilege Management Reporting
MMC snap-in. The configuration of privilege monitoring logs is applied to each Workstyle.

L]
1 For more information about privilege monitoring contact your BeyondTrust consultant.

Privilege Monitoring Events

« Log Monitoring Event to Application Event Log: This option will log an event to the application event log the first time an
application performs a privileged operation.

« Log Cancel Events (when user cancels message): This option will raise an event when a user cancels an End User
Message, either by clicking the Cancel button, Email button, or clicking a Hyperlink. The action performed by the user is
available as a Policy Parameter [PG_ACTION], which can be used by the script to perform different audit actions based on
the user interaction.

Privilege Monitoring Log Files

The following Privilege Monitoring options are available:
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« Log Application Activity to Log Files: This option will enable logging of privileged activity to log files. The activity level can be
set with the activity slider.

« Application Summary and Activity: This option logs information about the application and unique privileged activity (Default
option).

« Application Summary and Detailed Activity: This options logs information about the application and all privileged activity.

« Maximum Activity Records Per Process: This option determines the maximum number of records that will be recorded per
process (Default 100).

« Keep Application Activity Logs for: This option determines how long activity logs are kept before they will be purged
(Default 14 days).

Create Workstyles

Navigate to the Windows > Workstyles node.
Right-click the Workstyles node, and then click Create Workstyle on the top-right. The Workstyle Wizard is displayed.
You can optionally enter a license code at this stage or you can enter it later once the Workstyle has been created.

e nh =

You can choose from Controlling or Blank for your Workstyle. A controlling Workstyle allows you to apply rules for access to
privileges and applications. A blank Workstyle allows you to create an empty Workstyle without any predefined elements. If
you selected a blank Workstyle, the next screen is Finish, as there is nothing to configure.

5. Filtering (Controlling Workstyle only). This determines who will receive this Workstyle. You can choose from Standard users
only or everyone. If you apply it to everyone it will apply to Administrators. You can modify the filters and apply more detailed
filtering once the Workstyle is created.

6. Capabilities (Controlling Workstyle only). Allows you to choose Privilege Management and/or Application Control. If you
don't select either capabilities, the next screen is Finish. This Workstyle would only contain filtering information.

7. Privilege Management (Controlling Workstyle with the Privilege Management capability). Allows you to choose:
« Ifyou wantto display a notification to the user when applications are elevated by Privilege Management for Windows
« How you want to manage Windows User Account Control (UAC) prompts

« Ifyou wantto allow the on-demand elevation of applications

Note: If you select Present users with a challenge code from the drop-down, you are prompted to configure the
Challenge and Response functionality at the end of creating your Workstyle, if your policy doesn't already have
one.

8. Application Control (Controlling Workstyle with the Application Control capability). Allows you to choose:
- How you want to apply application control. You can choose a whitelist or blacklist approach. We recommend you use
a whitelist approach
« As a whitelist: How you want to handle non-whitelisted applications
« As a blacklist: How you want to handle blacklisted applications

9. Finish. Allows you to enter a Name and Description for your new policy. If the Workstyle has been configured to use a
Challenge/Response message and the policy doesn't have an existing key, you will be asked to set a key. You can select the
check box on this screen to activate this Workstyle immediately or you can leave the box unchecked to continue to configure
the Workstyle before you apply it to your endpoints.

L]
1 For more information, please see "Challenge/Response Authorization" on page 126.
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Depending on the type of Workstyle you created and any capabilities that are included, Privilege Management for Windows will auto-
generate certain Application Groups (containing rules), Content Groups, Messages, and Custom Tokens. Filters are applied and
subsequently configured as part of the Workstyle.

L ]
1 For more information, please see the following:

« "Application Groups" on page 85
« "Content Groups" on page 116

« "Messages" on page 119

« "Custom Tokens" on page 132

Disable/Enable Workstyles

You can enable or disable Workstyles to stop them being processed by Privilege Management for Windows.

1. Navigate to the policy and select the Workstyles node. You can see which policies are disabled and enabled in the list.

2. Right-click on the Workstyle and click Disable Workstyle to Workstyle
disable it or Enable Workstyle to enable it. General Rules (Default set of rules that apply to all users)

6 application rules, na content rules and no on demand application rules

D Will be applied where the user is not a member of BUILTIN\Administratars,

High Flexihility (Workstyle that applies to users who have a lot of flexihility)
This wiorkstyle is disabled

x'n_ 5 application rules, na content rules and no on demand application rules

In the above example, the General Rules Workstyle is enabled and the High Flexibility Workstyle is disabled.

Workstyle Precedence

If you have multiple Workstyles, they are evaluated in the order in which they are listed. Workstyles that are higher in the list have a
higher precedence. Once an application matches a Workstyle, no further Workstyles are processed for that application, so itis
important that you order your Workstyles correctly, because it is possible for an application to match multiple Workstyles.

To change the precedence of a Workstyle:

1. Select Windows > Workstyles from the left pane.
2. Right-click and choose from the options Move Top, Move Up, Move Down, and Move Bottom as required.

Changes are automatically saved.

Workstyle Summary

The Workstyle Summary shows you your Workstyle settings at a glance, and allows you to configure the following elements of a
Workstyle.

The tabs are displayed across the topic. Some of these tabs may not be displayed if they've not been configured in your policy.

o "Overview" on page 61
« "Application Rules" on page 62
o "On-Demand Application Rules" on page 72
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« "Content Rules" on page 75
« "General Rules" on page 78

» "Filters" on page 81

Overview

The Overview tab allows you to quickly access the following features of your policy:

« General

o Allows you to edit the description of your Workstyle and enable or disable it.
» Totals

o Allows you to configure the following types of rule:

= Application Rules
m  On-Demand Application Rules
= ContentRules

L]
1 For more information, please see the following:

« "Application Rules" on page 62
o "On-Demand Application Rules" on page 72
« "Content Rules" on page 75

« Trusted Application Protection
o Allows you to configure the following type of rule:

m Trusted Application DLL Protection

-
l For more information, please see "Trusted Application DLL Protection" on page 77.

« General Rules
o Allows you to configure the following General Rules:
= Collect User Information
= Collect Host Information
= Prohibit Privileged Account Management
= Enable Windows Remote Management Connections

L]
1 For more information, please see "General Rules" on page 78.
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« Filters
o Allows you to configure the following Filters:

= Account Filters

m Computer Filters

= Time Range Filters

= Expiry Filter

= WMI (Windows Management information) Filters

L]
1 For more information, please see the following:

« "Account Filters" on page 81

« "Computer Filters" on page 82

« "Time Range Filters" on page 83
o "Expiry Filter" on page 83

« "WMI (Windows Management information) Filters" on page 83

Application Rules

Application rules are applied to Application groups. Application rules can be used to enforce whitelisting, monitoring, and assigning
privileges to groups of applications. They are a set of rules that apply to the applications listed in the Application group.

L]
1 For more information, please see "Application Groups" on page 85.

You need an Application group before you can create an Application rule.

L]
1 For more information, please see "Create Application Groups" at "Application Groups" on page 85.

Application rules are color coded in the interface:

Application Rule
« Blue: A Power Rule is assigned to the Application rule. This Service Now
could be an Allow or Block action. ® Fun 'Log-ServiceMowlncident’ rile script
® Allow weith "&dd Admin Rights' as default option
L] . . B B Any Signed Application
7 For more information, please see "Power Rules" on page 64. o Bpply 'Bdd Admin Rights' token
® Mo end user message shown
« Green: The default action is Allow. Any UAC Prompt
L # Block Execution
« Orange: The default action is Block. o Showe 'Block Message' message
Insert an Application Rule
Click Application Rules to view, create, or modify the following for each application rule:
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Option Description

Target Application Group Select from the Application Groups list.

[ ]
L Formore information, please see "Application Groups" on

page 85.

Run a Rule Script This option allows you to assign a Rule Script that is run before the
Application Rule triggers.

You need to use Manage Scripts from the drop-down to import your Rule
Script before you can select it.

Select the Rule Script you want to use from the drop-down list.

L]
1 For more information, please see "Manage Scripts" on page

68.

Action Select from Allow Execution or Block Execution. This is what will
happen if the application in the targeted application group is launched by
the end user.

End User Message Select if a message will be displayed to the user when they launch the
application. We recommend using Messages if you're blocking the
execution of the application so the end user has some feedback on why
the application doesn't launch.

Access Token Select the type of token to pass to the target application group. You can
select from:

. Passive (no change): Doesn't make any change to the user's
token. This is essentially an audit feature.

« Enforce User's default rights: Removes all rights and uses the
user's default token. Windows UAC always tries to add
administration rights to the token being used so if the user clicked
on an application that triggers UAC, the user would cannot
progress pastthe UAC prompt.

o Drop Admin Rights: Removes administration rights from the
user's token.

« Add Admin Rights: Adds administration rights to the user's token.

L ]
1 For more information on access tokens, please see

hitps://docs.microsoft.com/en-
us/windows/desktop/SecAuthZ/access-tokens.

Auditing
Raise an Event Whether or not you want an eventto be raised if this application rule is
triggered. This will forward to the local eventlog file.
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Option Description

Run an Audit Script This option allows you to select an Audit Script to run after the Application
Rule.

You need to use Manage Scripts from the drop-down to import your
Audit Script before you can select it.

Select the Audit Script you want to use from the drop-down list.

L]
1 For more information, please see "Manage Scripts" on page

68

Privilege Monitoring Raises a privileged monitoring event.

McAfee ePO Reporting Options

Note: This option is only available if you checked the McAfee integration box when you installed the Privilege
Management Policy Editor.

ePO Queries and Reports Select this option to raise an ePO Threat event. These are separate from
Privilege Management Reporting events.

BeyondTrust Reporting (in ePO) Select this option to raise a Privilege Management Reporting event.
These are available in BeyondTrust Reporting.

Application Rule Precedence

If you add more than one application rule to a Workstyle, entries that are higher in the list will have a higher precedence. Once an
application matches an application rule, no further rules or Workstyles will be processed. If an application could match more than one
Workstyle or rule, then itis important that you order both your Workstyles and rules correctly. You can move application rules up and
down to change the precedence.

Power Rules

A Power Rule is a PowerShell based framework that lets you change the outcome of an Application Rule, based on the outcome of a
PowerShell script.

L ]
1 For information on creating your own Power Rule, please see the Core Scripting Guide, at

www.beyondtrust.com/docs/privilege-management/windows.htm.

-
1 For information on using the BeyondTrust-supported integration with ServiceNow, please see the ServiceNow Scripting
Guide, at www.beyondtrust.com/docs/privilege-management/windows.htm.

Instead of a fixed Default Rule that can either be set to Allow, Elevate, Audit, or Block for the applications in the targeted Application
Group, a Power Rule lets you determine your own outcome based on any scenario you can build into a PowerShell script.

Any existing Default Rule within a Workstyle can be updated to a Power Rule by setting the action to a Power Rule script, and
importing the PowerShell script you want to use. Privilege Management for Windows provides a PowerShell module with an interface
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to collect information about the user, application, and policy. The module can then send a resulting action back to Privilege
Management for Windows to apply.

The Power Rules module also provides a variety of message options that allow you to collect additional information to support your
PowerShell script logic and provide updates to the user as to the status, progress, or outcome of your rule. The messages that are
supported include:

« Authentication message

« Business Justification message

« Information message

« Pass code message

« Vaulted credential message

« Asynchronous progress dialog for long running tasks

Power Rules is a highly flexible feature with unlimited potential. If you can do itin PowerShell, you can do itin a Power Rule. Here
are some example use cases for Power Rules:

« Environmental Factors: Collecting additional information about the application, user, computer, or network status to influence
whether an application should be allowed to run, or run with elevated privileges.

« Service Management: Automatically submitting tickets to IT Service Management solutions, and determining the outcome of a
service ticket.

« File Reputation: Performing additional checks on an application by looking up the file hash in an application store, reputation
service, or a vulnerability database.

« Privileged Access Management: Checking out credentials from a password safe or vault, and passing them back to Privilege
Management for Windows to run the application in that context.

f Note: Power Rules are best used for exception handling and in conjunction with static policy.

L]
1 For more information on Power Rules, please see "Power Rules Additional Guidance" on page 65.

Power Rules Additional Guidance

You can use the PowerShell get-help command to get help on any cmdletin PowerShell. You can also use the following arguments
to get additional guidance on the cmdlet: -examples, -detailed, -full, -online.

Compatibility
Power Rules requires PowerShell 3.0 or later. Run the following command to check the version of PowerShell you are running:

SPSVersionTable.PSVersion

If you attempt to edit an Application Rule containing a Power Rule in a Privilege Management Policy Editor older than 5.3.x, the
PowerRuleScript attribute (thatis linked to the Power Rule) is removed from the application rule.

L]
1 For more information about compatibility with other Privilege Management for Windows versions, please see the Release

Notes for each version, at www.beyondtrust.com/support/changelog.
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Third Party Integration Security

When you are integrating with a third party, you should ensure you use the most secure mechanism possible. For example, ifa
vendor offers both HTTP and HTTPS, you should use HTTPS.

Supported Application Types

All Application Types are supported with the exception of:

« Remote PowerShell Script
« Remote PowerShell Command
o Windows Service

« Windows Store Application

If you try and use these Application Types with a Power Rule, the Rule Script will not be executed and the event will state:

Script execution skipped: Application Type not supported.

Validation

Some restrictions are enforced by the Privilege Management Policy Editor but cannot be enforced in a scripting environment. The
following is guidance for creating your Power Rule. If Privilege Management for Windows cannot determine the correct course of
action, the Default Rule is applied.

All Messages and Tokens must exist in your policy configuration prior to referencing them in a Power Rule script.

« The Action must match the Message. For example, if the Action is Allow, the message must be of type Allow.

« Ifyou setthe Action to be Allow, we assume a passive Token but you can add a different token such a Custom Token that you
have created.

« Tokens cannot be used when the Action is Block.
« If you specify an account to run as, your Action must be Allow.

If the script fails, a local audit event 801 will be triggered.

L]
1 For more information, please see "Script Audit Failure Event" on page 67.

If you use Set-PRRunAsProperty, you need to use Set-PRRuleProperty and set the -Action argument to Allow. You can optionally
set the -Token argument. If you don't define a Token, then a Passive Token is applied.

The values for the -Action and -Token are case sensitive.

Script Restrictions

There are some restrictions that you need to be aware of when you are creating your own integrations.
Block Comments

Single line comments are supported but block comments are not. Block comments take the form:
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<# block comment #>
PowerShell single line comments are supported.

# comment

#Requires

The #Requires notation is not supported.

Script Audit Failure Event

If a Rule Script fails, then a local Windows eventis created, and the Privilege Management for Windows event number is 801. This
eventis always created even when auditing is turned off. The following fields are shown in the event:

Variable Name Description

RuleScriptFileName Name attribute of the scriptin the config

RuleScriptName Set by script properties

RuleScriptVersion Set by script properties

RuleScriptPublisher The publisher of the script

RuleScriptRuleAffected Whether a rule script changed a Privilege Management for Windows rule
RuleScriptStatus Timeout, Exception

RuleScriptResult Script timeout exceeded: X seconds, Set Rule Properties failed validation
ExceptionType Any valid .net exception type

ExceptionMessage The short exception message

Processld PID of the process matching the rule

ParentProcessld PID of the parent process matching the rule

ProcessStartTime Time the process started

Event Time Time the script started

UniqueProcessld GUID of process to link this data to associated audit process event

PowerShell Scripts Execution Policy

We recommend using one PowerShell script for each integration you create. If you create a Power Rule script thatin turn calls an
additional PowerShell script, you need to distribute that PowerShell scriptindependently and may need to change your PowerShell
execution policy to ensure it can run.

Encodings

If you want to maintain signed scripts, you must ensure they are encoded in UTF-16 LE prior to importing them into Privilege
Management for Windows. Rule Script files exported from the Privilege Management Policy Editor are always encoded in UTF-16 LE.

Settings files are encrypted at the endpoint. Settings files must be encoded in UTF-8.
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Supported Application Types

All Application Types are supported with the exception of:

« Remote PowerShell Script

« Remote PowerShell Command
« Windows Service

« Windows Store Application

Manage Scripts
The Manage Scripts option is available from the Run a Rule Script drop-down or Run an Audit Script drop-down on the Edit
Application Rule dialog box.

There are two types of scripts that you can use:

« Rule Scripts: PowerShell scripts and optional associated settings files allow you to modify the outcome of a Privilege
Management for Windows rule, once a script has been run. These scripts can only be run in the User context.

[ ]
1 For more information, please see "Rule Scripts" on page 68.

« Audit Scripts: VB, Javascript, or PowerShell scripts run after the Privilege Management for Windows rule. These are for
auditing purposes. These scripts can be run in the User or System context.

L]
1 For more information, please see "Audit Scripts" on page 70.

Both rules can be imported into Privilege Management for Windows using this dialog box.

Rule Scripts

Rule Scripts are PowerShell scripts that can dynamically change the Privilege Management for Windows Default Rule.

[ ]
1 For more information, please see "Power Rules" on page 64.

You can perform the following functions on Rule Scripts:

« Manage Rule Scripts

« Importa Rule Script

« Add a Settings File

« Exporting a Rule Script
« Delete a Rule Script
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L ]
1 For more information, please see the following:

» "Manage Rule Scripts" on page 69
« "Importa Rule Script" on page 69
» "Add a Settings File" on page 70

« "Exporta Rule Script" on page 70
» "Delete a Rule Script" on page 70

Manage Rule Scripts

The Rule Script node contains all the rule scripts in your policy. If a rule script is assigned to the application rule you are currently
editing, the icon will have a green check mark on it.

f Note: You cannot delete a Rule Script ifitis assigned to an Application Group or an On-Demand Application Group.

If you previously imported Rule Scripts, they are listed on the Rule Script node on the left side of the Script Manager.

Rule Scripts must be created outside the Privilege Management Policy Editor and imported. You cannot create a new Rule Script
using the Script Manager. Click Import Script at the bottom of the Script Manager to import a new Rule Script.

Import a Rule Script

There are two components to Rule Scripts:

« Rule Script
« (Optional) Settings file

BeyondTrust-supported integrations are available from BeyondTrust.

Note: You should not edit BeyondTrust-supported integrations as this may affect the level of support we are able to
provide.

While you can edit a Rule Scriptin the Script Manager, we recommend you import the completed script into the Script Manager.
To import a Rule Script:

1. Copy the PowerShell Rule Script (*.ps1) and associated settings (*.json) file somewhere locally so you locate them from the
policy editor.
Click the Run a Rule Script drop-down and select Manage Scripts.
Select the Rule Scripts node and click Import Script at the bottom of the dialog box.
Navigate to your PowerShell (*.ps1) file and click Open.

S

The scriptis loaded into the Script Manager and displayed.

You can edit the Rule Script here if required. When you click Close, your changes are automatically saved.

Each Rule Script can have an optional associated Settings file which must be in a valid *.json format. Settings files are encrypted at
the endpoint. They are useful for managing credentials required for integrations and other sensitive information.
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After you import a Rule Script, you can change the Timeout settings. This is the time that Privilege Management for Windows will wait
from the start of script execution for the script to complete before running the default rule.

Add a Settings File

After you add a Rule Script (*.ps1), you can optionally add an associated Settings file (*.json) if one is required for the integration.
The Settings file contains any information that is specific to your integration environment, such as URLs, usernames, and passwords.
The Settings file is encrypted on the endpoint using SHA1.

Click Settings > Import Settings.

Navigate to and select your Settings file.

Click Open. The Settings file is displayed. Before you proceed, we recommend you review and make any necessary edits to
the Settings file in this window. Click Save to associate this Settings file with your Rule Script.

4. The name of the Settings file that is associated with your Rule Scriptis shown next to the Settings button. Click Settings to
view the contents of your settings file at any time.

You can click Delete Settings at any time if you want to clear the Settings window. Importing a new script will overwrite the existing
one.

After you associate a settings (*.json) file with a Rule Script (*.ps1), itis always associated with that Rule Script wherever you use it.
For example, if you associate a settings file with a Rule Script for an Application Rule and select the same Rule Scriptin an On-
Demand Application Rule, the same settings file will be used. Changes to the settings or Rule Script file in either location are applied
wherever it's used.

Export a Rule Script
If you need to share the Rule Script you can exportit. You cannot export the settings file because itis linked to the Rule Script.
To export an existing Rule Script:

1. From the Script Manager, click Export Script.
2. Navigate to where you want to save the script to and click Save. The Rule Script is now exported.

Delete a Rule Script

You can delete an existing Rule Script, provided that it is not assigned to an Application Rule or On-Demand Application Rule.

To delete a Rule Script:

1. From the Script Manager, select the Rule Script you want to delete and click Delete Script.
2. Provided that the scriptis notin use by an Application Rule or an On-Demand Application Rule, you are prompted to confirm
the deletion. The scriptis deleted.

If the Rule Scriptis assigned to an Application Rule or On-Demand Application Rule, you will receive a message stating that it cannot
be deleted.

A Rule Scriptis only assigned to an Application Group after you click Close on the Script Manager dialog box and clicked OK on the
Edit Application Rule dialog box. Clicking Close on only the Script Manager does not associate a Rule Script with that Application
Group.

Audit Scripts

Audit Scripts allow you so audit behavior you may want to capture.
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L]
1 For more information, please see "Audit and Reports" on page 144.

You can perform the following functions on Audit Scripts:

- Manage Audit Scripts

« Create an Audit Script
« Import an Audit Script
« Export an Audit Script
« Delete an Audit Script

. Formore information, please see the following:
« "Manage Audit Scripts" on page 71
« "Create an Audit Script" on page 71
« "Importan Audit Script" on page 72
« "Exportan Audit Script" on page 72
« "Delete an Audit Script" on page 72

Manage Audit Scripts

The Audit Script node contains all the audit scripts in your policy. If an audit script is assigned to the Application Rule you are
currently editing, the icon will have a green tick on it.

f Note: You cannot delete a Rule Script ifitis assigned to an Application Group or an On-Demand Application Group.

If you previously imported Rule Scripts, they are listed on the Rule Script node on the left side of the Script Manager.

Click Import Script at the bottom of the Script Manager to import a new Rule Script. Alternatively, you can create a new Audit scriptin
the Privilege Management Policy Editor.

L]
. Formore information, please see "Create an Audit Script" on page 71.

Create an Audit Script
You can create audit scripts using the Privilege Management Policy Editor.

To create an Audit Script:

1. Click New in the Audit Scripts node in the Script manager to create a new Audit Script. You can now choose the following
options and enter your script directly into the policy editor.

« Script Language: Choose from VB Script, Javascript, or PowerShell Script. Switching between languages will clear all
code in the script editor window.
« Script Context: An audit script can run in the User or System context.

« Timeout: The time that Privilege Management for Windows will wait from the start of script execution for the script to
complete before activating the default rule options.
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You can edit the Audit Script here. Your changes are automatically saved when you click Close.

Import an Audit Script

Audit scripts can be imported in the policy editor.

To import an Audit Script:

Copy the Audit Script (*.vbs, *js, or *.ps1) file somewhere locally so you can locate it from the policy editor.
Click either the Run a Rule Script or Run an Audit Script drop-down and click Manage Scripts.

Select the Audit Scripts node and click Import Script at the bottom of the dialog box.

Navigate to your Audit Script file and click Open.

o kK~ wn -

The scriptis loaded into the Script Manager and displayed.

You can edit the Audit Script here if required. Your changes are automatically saved when you click Close.

Export an Audit Script
You can export an existing Audit Script if you need to share it.
To export an existing Audit Script:

1. From the Script Manager, click Export Script.
2. Navigate to where you want to save the script to and click Save. The Audit Script has now been exported.

Delete an Audit Script
You can delete an existing Audit Script, even ifitis assigned to an existing Application Rule.

To delete an Audit Script:

1. From the Script Manager, select the Audit Script you want to delete and click Delete Script.

2. Provided the scriptis notin use by an Application Rule or an On-Demand Application Rule, you are prompted to confirm the
deletion. The scriptis now deleted.

On-Demand Application Rules

The On-Demand Application Rules tab of the Workstyle allows you create rules to launch applications with specific privileges
(usually admin rights), on-demand from a right-click Windows context menu.

Enable and Configure On-Demand Integration

To enable on-demand application rules, select the On-Demand oo
Application Rules Workstyle tab. The first check box applies to all p——
versions of Windows that have the Run as administrator option. The
second two check boxes apply to the Classic Windows Shell only. They
do not apply to the Windows Modern Ul that is available in Windows 8

and Windows 10.
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Windows Modern Ul

If an On-Demand application rule is triggered, Privilege Management for Windows references the check box labeled Apply the on-
demand application rules to the “Run as administrator”. If the box is checked, Privilege Management for Windows intercepts the
Run as administrator option in the right-click context menu and overrides it. The labeling of the option doesn’t change in this
instance. If the box is unchecked, Privilege Management for Windows does not intercept the option to Run as Administrator.

Privilege Management for Windows also references the check box labeled Hide “Run as” and “Run as administrator” commands
in the Classic Shell context menu. If it is checked, these options, where present, are hidden from the right-click context menu.
Privilege Management for Windows does not continue process additional application rules.

Windows Classic Shell

If an On-Demand application rule is triggered, Privilege Management for Windows references the check box in the Classic Shell
Context Menu Options section labeled Apply custom on-demand option to the Classic Shell context menu (this won’t affect the
“Run as administrator” option). If the box is checked, Privilege Management for Windows adds a new option to the right-click
context menu that you configured in the Classic Shell Context Menu Option section, for example, Run with Privilege Management.

Privilege Management for Windows also references the check box labeled Hide “Run as” and “Run as administrator” commands
in the Classic Shell context menu. If it is selected, these options, where present, are hidden from the right-click context menu.
Privilege Management for Windows does not continue to process additional application rules.

Note: Unlike Application rules, the On-Demand rules list will only receive the assigned privileges ifthe user launches a
relevant application using the context menu.

Application Groups for On Demand Application Rules are added and managed in the same way as Application Groups for
Application Rules. Right-click anywhere on the lower section of the page and select Insert Application Rule.

L]
1 For more information, please see "Application Rules" on page 62.

Manage Languages

The menu option that is displayed can be configured for multiple languages. Privilege Management for Windows will detect the
regional language of the end user, and if a message in thatlanguage is configured, the correct translation will be displayed.

To add a new menu option translation:
In the On-Demand Application rules, click the Add Language button.

The Add Language dialog box appears. Select the correct language, and then click OK.
A new text box for the selected language appears.

e DN =

Enter your own translation for the selected language and click Save in the left pane.

K Note: If a language cannot be matched for the region of the end user, then the default language is displayed. To change
the default language, select the language and click Set As Default.

Create an On-Demand Rule

On-Demand rules are not checked by Privilege Management for Windows unless you enabled them in the top section.
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L]
1 For more information, please see "Enable and Configure On-Demand Integration" on page 72.

1. Right-click and select Insert Application Rule to view, create, or modify the following for each on-demand application rule:
Option ‘ Description
Target Application Group Select from the Application Groups list.

L]
1 For more information, please see "Application Groups" on

page 85.

Run a Rule Script This option allows you to assign a Rule Script thatis run before the
Application Rule triggers.

You need to use Manage Scripts from the drop-down to import your Rule
Script before you can select it.

Select the Rule Script you want to use from the drop-down list.

L]
1 For more information, please see "Manage Scripts" on page

68.

Action Select from Allow Execution or Block Execution. This is what will
happen if the application in the targeted application group is launched by
the end user.

End User Message Select if a message will be displayed to the user when they launch the
application. We recommend using Messages if you're blocking the
execution of the application, so the end user has some feedback on why
the application doesn't launch.

Access Token Select the type of token to be passed to be used for the target application
group. You can select from:

« Passive (no change): Doesn't make any change to the user's
token. This is essentially an audit feature.

. Enforce User's default rights: Removes all rights and uses the
user's default token. Windows UAC always tries to add
administration rights to the token being used so if the user clicked
on a application that triggers UAC, the user cannot progress past
the UAC prompt.

« Drop Admin Rights: Removes administration rights from the
user's token.

« Add Admin Rights: Adds administration rights to the user's token.

L ]
1 For more information on access tokens, please see

https://msdn.microsoft.com/en-
gb/library/windows/desktop/aa374909(v=vs.85).aspx .
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Option Description

Auditing
Raise an Event Whether or not you want an event to be raised if this application rule is
triggered. This will forward to the local eventlog file.
Run an Audit Script This option allows you to select an Audit Script to run after the Application
Rule.
You need to use Manage Scripts from the drop-down to import your
Audit Script before you can select it.
Select the Audit Script you want to use from the drop-down list.
-
1 For more information, please see "Manage Scripts" on page
68.
Privilege Monitoring Raises a privileged monitoring event.

McAfee ePO Reporting Options

x Note: This option is only available if you selected the McAfee integration check box when you installed the Privilege
Management Policy Editor.

ePO Queries and Reports Select this option to raise an ePO Threat event. These are separate from
Privilege Management Reporting events.

BeyondTrust Reporting (in ePO) Select this option to raise a Privilege Management Reporting event.
These are available in BeyondTrust Reporting.

Content Rules

Content rules define the actions Privilege Management for Windows takes when content, such as a file, is launched by the user.

You need a Content Group before you can create a Content Rule.

-
1 For more information, please see "Content Groups" on page 116.

Insert a Content Rule
Click Content Rules to view, create, or modify the following for each application rule:

Option ‘ Description

Target Content Group Select from the Content Groups list.

L]
L Formore information, please see "Content Groups" on page

116.

Action Select from Allow Modification or Block Access. This is what will
happen if the user tries to access the content.
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Option Description

End User Message

Access Token

Auditing

Raise an Event

Run an Audit Script
McAfee ePO Reporting Options

Select if a message is displayed to the user when they try to access the
content. We recommend using Messages if you're blocking content from
being accessed, so the end user has some feedback.

Select the type of token to pass to the target application group. You can
select from:

« Passive (no change): Doesn't make any change to the user's
token. This is essentially an audit feature.

« Enforce User's default rights: Removes all rights and uses the
user's default token. Windows UAC always tries to add
administration rights to the token being used so if the user clicked
on an application that triggers UAC, the user cannot progress
past the UAC prompt.

« Drop Admin Rights: Removes administration rights from the
user's token.

o Add Admin Right: Adds administration rights to the user's token.

L]
1 For more information on access tokens, please see

https://docs.microsoft.com/en-

us/windows/desktop/SecAuthZ/access-tokens.

Whether or not you want an event to be raised if this content rule is
triggered. This will forward to the local event log file.

You can choose to run an Audit Script if required.

Management Policy Editor.

Note: This option is only available if you selected the McAfee integration check box when you installed the Privilege

ePO Queries and Reports

BeyondTrust Privilege Management Reporting (in ePO)

Built-in Groups

Select this option to raise an ePO Threat event. These are separate from
Privilege Management Reporting events.

Select this option to raise a Privilege Management Reporting event.
These are available in BeyondTrust Privilege Management Reporting.

Privilege Management for Windows includes a number of built-in groups that may be used in any application rule or content rule.
They provide a simple and convenient way for the application of broad rules to applications and content, in particular when defining
catch-all rules. Built-in groups also help to simplify your configurations by reducing the amount of groups.
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Group Criteria Valid Types

Any Application Matches any application that executed. Will also . Executables

match any child applications. . Control Panel Applets

« Installer Packages
« Privilege Management Policy Editors
« Windows Scripts
« PowerShell Scripts
« Batch Scripts
« Registry Scripts
Any Signed Application Matches any application that executed which has . Executables

been signed by a publisher. Will also match any child

applications of signed applications. o Gzl el A

« Installer Packages
« Privilege Management Policy Editors
« Windows Scripts
« PowerShell Scripts
Any Signed UAC Prompt Matches any application that triggers a Windows UAC . Executables

Prompt, which has been signed by a publisher. Will

also match any child applications. + Installer Packages

« COM Classes

Any UAC Prompt Matches any application that triggers a Windows UAC . Executables

prompt. Will also match any child applications. .| Installer Packages

« COM Classes

Trusted Application DLL Protection

Privilege Management for Windows can dynamically evaluate DLLs for trusted applications for each Workstyle. The first Workstyle to
have DLL Control Enabled or Disabled causes any configuration of DLL Control in subsequent Workstyles to be ignored.

Unless a DLL has a trusted publisher and a trusted owner, itis not allowed to run within the Trusted Application Protection
(TAP) application.

« Trusted Publisher: A trusted publisher must be signed. In addition, the publisher certificate must be valid, in date, and not
revoked.

« Trusted Owner: A trusted owner is any owner that is in the default Windows groups Administrators, SystemUser or
Trustedinstaller.

TAP DLL control affects the following applications:

« Microsoft Word, Microsoft Excel, Microsoft PowerPoint, Microsoft Publisher, Adobe Reader 11 and lower, Adobe Reader DC,
Microsoft Outlook, Google Chrome, Mozilla Firefox, Microsoft Internet Explorer, Microsoft Edge

You can turn on the monitoring of DLLs for TAP applications in any Workstyle. However, the first Workstyle to have DLL Control
Enabled or Disabled causes any configuration of DLL Control in subsequent Workstyles to be ignored.
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Configure Trusted Application DLL Protection

Click Trusted Application DLL Protection enabled, click to Configure to administer how DLLs are handled for TAP applications.

Option Description

Trusted Application Protection (DLL) Select Enabled, Disabled, or Not Configured from the drop-down list.
The first Workstyle to be evaluated that has DLL Control Enabled or
Disabled is matched by Privilege Management for Windows, meaning
subsequent Workstyles are not evaluated by Privilege Management for
Windows.

Action Select from Passive (No Change) or Block Execution. This is what will
happen if the DLL in the TAP application tries to run.

End User Message Select if a message will be displayed to the user when the DLL tries to
run (regardless of it's allowed to run). We recommend using Messages if
you're blocking a DLL from running, so the end user has some feedback.

Auditing

Raise an Event Whether or not you want an event to be raised if the TAP application tries
to run a DLL. This will forward to the local eventlog file.

McAfee ePO Reporting Options

ePO Threat Events Select this option to raise an ePO Threat event. These are separate from
Privilege Management Reporting events.

Privilege Management Reporting Events Select this option to raise a Privilege Management Reporting event.
These are available in BeyondTrust Privilege Management Reporting.

Exclusions

Exclude DLLs from Rule Enter DLLs here that you want to exclude from DLL Control for TAP

Applications. These are DLLs that have either an untrusted owner or an
untrusted publisher, but you still want to be allowed to run with DLL
Control for TAP enabled in the Workstyle. This list of DLLs is not
validated. If the DLL name listed isn't matched by the client, then nothing
will be excluded.

Note: Third party applications may give error messages that aren'timmediately clear to the end user when a DLL is
blocked from running in a TAP application by Privilege Management for Windows.

General Rules

To view or edit the General Rules of a Workstyle, select Windows > Workstyles > 'Workstyle Name' > General Rules from the policy
tree.

Collect User Information

This rule, when enabled, will raise an audit event each time a user logs on to the client machine. The audit event will collect the
following information which is reported through the Reporting pack:
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« Logon Time: The date and time the user logged on.

« Is Administrator: The client will check whether the user account has been granted local administrator rights either directly or
through group membership.

« Session Type: The type of logon session, for example, console, RDP, or ICA.
« Session Locale: The regional settings of the user session/profile

« Logon Client Session Hostname: The hostname of the client the user is logging on from. This will either be the local
computer (for Console sessions) or the remote device name (for remote sessions).

« Logon Client Session IP Address: The IP address of the client the user is logging on from. This will either be the local
computer (for console sessions) or the remote device name (for remote sessions).

L]
1 For more information on user information reporting, please see the BeyondTrust Privilege Management Reporting guides,

at www.beyondtrust.com/docs/privilege-management/windows.htm.

Collect Host Information

This rule, when enabled, will raise an audit event on computer start-up or when the Privilege Management for Windows service is
started. The audit event will collect the following information, which is reported through the Reporting pack:

« Instance ID: A unique reference identifying a specific service start event.

« OS Version: The name and version of the operating system, including service pack.

« Chassis Type: The type of chassis of the client, for example, workstation, mobile, server, or VM.

« Language: The default system language.

« Location: The current region and time zone of the device.

« Client Version: The version of the Privilege Management for Windows.

« Client Settings: The type of installation and current settings of the Privilege Management for Windows.

« System Uptime: Time since the computer booted.

« Unexpected Service Start: Only added if the service has unexpectedly started (thatis, a previous start was not proceeded by

a service stop).

An additional event will be raised when the computer shuts down, or when the Privilege Management for Windows service is
stopped:

« Instance ID: A unique reference identifying the last service start event.

« Computer Shutdown: Value identifying whether the service stopped as part of a computer shutdown event.

This option is only available in policies set under the Computer Configuration Group policy.

L]
1 For more information on computer information reporting, please see the BeyondTrust Privilege Management Reporting

guides.
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Prohibit Privileged Account Management

This rule, when enabled, blocks users from modifying local privileged group memberships. This prevents real administrators, or
applications which have been granted administrative rights through Privilege Management for Windows from adding and/or removing
and/or modifying a privileged account.

The list of local privileged groups that are prohibited from modification when this rule is enabled is:

« Built-in administrators

« Powerusers

« Account operators

« Server operators

« Printer operators

« Backup operators

« RAS servers group

« Network configuration operators

This rule provides three options:

« Not Configured: This Workstyle will be ignored.
- Enabled: The user will not be able to add, remove, or modify user accounts in local privileged groups.

« Disabled: Default behavior based on the users rights or those of the application.

Enable Windows Remote Management Connections

This rule, when enabled, authorizes standard users who match the Workstyle to connect to a computer remotely using WinRM, which
would normally require local administrator rights. This general rule supports remote PowerShell command management, and must
be enabled in order to allow a standard user to execute PowerShell scripts and/or commands.

L]
. Formore information on configuring remote PowerShell, please see "Insert Remote PowerShell Commands" on page

107.

To allow remote network connections, you may be required to enable the Windows Group Policy setting access this computer from
the network.

-
. Formore information, please see https:/technet.microsoft.com/en-us/library/cc740196(v=WS.10).aspx.
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Filters

To view or edit the general properties of a Workstyle, select Windows —

> Workstyles > 'Workstyle Name' > Filters from the policy tree. The

Filters SeCtiOn iS Iast in the ||St on the rlght Filters can be used to control who the policy should apply to

There is 1 Account Filter
There is 1 Computer Filter
There is 1 Time Range Filter
There is 1 Expiry Filter

There is 1 WMI Filter

The Filters tab of a Workstyle can be used to further refine when a Workstyle will actually be applied.

By default, a Workstyle will apply to all users and computers who receive it. However, you can add one or more filters that will restrict
the application of the workstyle:

« Account Filter: This filter restricts the Workstyle to specific users or groups of users.

« Computer Filter: This filter will restrict the Workstyle to specific computers (names or IP addresses), or Remote Desktop
clients.

« Time Filter: This filter will restrict the Workstyle to being applied at particular days of the week and times of the day.
« Expiry Filter: This filter will expire a Workstyle at a set date and time.
« WNMI Filter: This filter will restrict the Workstyle based on the success or failure of a WMI query.

If you want the Workstyle to apply only if all filters match, select the option ALL filters must match from the drop-down menu. If you
want the Workstyle to apply when any filter matches, select the option ANY filter can match from the drop-down menu.

Filters can also be configured to apply if there are no matches. This is referred to as an exclude filter. To set an exclude filter, right-
click the filter and check the option Apply this filter if it does NOT match (This does not apply to Time and Expiry filters).

f Note: Time filters and Expiry filters can only be used once in a Workstyle.

Account Filters

Account filters specify the users and groups the Workstyle will be applied to.

Note: When a new Workstyle is created, a default account filter will be added to target either Standard users only, or
Everyone (including administrators), depending on your selection in the Workstyle Wizard.

Configure Account Filters

1. On the Filter tab, click Add a filter.
2. Click Add an Account Filter > Add a new account.
3. The Select Users or Groups dialog box appears.
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4. Enter the relevant group or user accounts and click Check Names to validate the names, or alternatively click Advanced to
browse for groups and users.

5. Click OK to save your changes.

Domain and well known accounts will display a Security Identifier (SID). The SID will be used by Privilege Management for Windows,
which will avoid account lookup operations. For local accounts, the name will be used by Privilege Management for Windows, and
the SID will be looked up when the Workstyle is loaded by the client. Local Account will appear in the SID column of the accounts list
for local accounts.

By default, an account filter will apply if any of the user or group accounts in the list match the user. If you have specified multiple user
and group accounts within one account filter, and want to apply the Workstyle only if all entries in the account filter match, then check
the option All items below should match.

You can add more than one account filter if you want the user to be a member of more than one group of accounts for the Workstyle to
be applied.

If an account filter is added, but no user or group accounts are specified, a warning will be displayed advising No accounts added,
and the account filter will be ignored.

Note: If All items below should match is enabled, and you have more than one user account listed, the Workstyle will
never apply, as the user cannot match two different user accounts.

Computer Filters

A computer filter can be used to target specific computers and remote desktop clients. You can specify a computer using either its
host/DNS name, or by an IP address.

To restrict the Workstyle to specific computers by IP address:

Select the Filters tab, and click Add a new filter.

Click Add a Computer Filter > Add a new IP rule. The Add IP rule dialog box appears.
Enter the IP address manually, in the format123.123.123.123.

Click Add.

e Dd =

K Note: Ifthe computer filter is intended for matching the IP address of remote computers using remote desktop sessions,
check the option Match the remote desktop (instead of the local computer).

x Note: You can also use the asterisk wildcard (*) in any octet to include all addresses in that octet range, for example,
192.168.*.*. Alternatively, you can specify a particular range for any octet, for example, 192.168.0.0-254. Wildcards and
ranges can be used in the same IP Address, but not in the same octet.

To restrict the Workstyle to specific computers by hostname:

1. Select the Filters tab, and click Add a Filter.
Click Add a Computer Filter > Add a new hostname rule. The Add hostname rule dialog box appears.

Enter one or more hostnames, separated by semicolons, or alternatively browse for one or more computers. You can use the *
and ? wildcard characters in hostnames.

4. Click Add.
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5. Ifthe computer filter is intended for matching the hostname of remote computers using remote desktop sessions, check the
option Match the remote desktop (instead of the local computer).

Note: By default, a computer filter will apply if any of the computers or IP Addresses in the list match the computer or client.
If you specified multiple entries, and want to apply the Workstyle only if all entries in the computer filter match, then check
the option All items below should match.

If a computer filter is added, but no host names or IP addresses are specified, a warning is displayed advising No rules added, and
the computer filter will be ignored.

Time Range Filters

A time range filter can specify the hours of a day, and days of week that a Workstyle will be applied.

To restrict a Workstyle to a specific date/time period of activity:

Select the Filters tab, and click Add a new filter.
Click on Add a Time Filter > Edit time restrictions. The Time Restrictions dialog box appears.

Select Active and Inactive times in the time grid by either selecting individual elements or dragging over areas with the left
mouse button held down.

4. Click OK.

K Note: Only one time filter can be added to a Workstyle.

The time filter is applied based on the user’s timezone by default. Uncheck the Use timezone of user for time restrictions
(otherwise use UTC) box to use UTC for the timezone.

Expiry Filter

An expiry filter specifies an expiry date and time for a Workstyle.
To restrict a Workstyle to an expiry date and time:
1. Select the Filters tab, and click Add a new filter.

2. Click on Add an Expiry Filter.
3. Setthe date and time that you want the Workstyle to expire.

K Note: Only one expiry filter can be added to a Workstyle.

The expiry time is applied based on the user’s timezone by default. Uncheck the Use timezone of user for workstyle expiry
(otherwise use UTC) box to use UTC for the timezone.

WMI (Windows Management information) Filters

A WM filter specifies if a workstyle should be applied, based on the outcome of a WMI query.

The filter allows you to specify the following:
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« Description: Free text to describe the WMI query.
- Namespace: Set the namespace that the query will execute against. By default, this is root\CIMV2.
« Query: The WMI Query Language (WQL) statement to execute.

. Timeout: The time (in seconds) the client will wait for a response before terminating the query. By default, no timeout is
specified.

Note: Long running WMI queries will result in delayed application launches. Therefore, we recommend a timeout is
specified to ensure that queries are terminated in a timely manner.

When you execute a WMI query, the client will check if any rows of data are returned. If any data is returned, then the WMI query will
be successful. If no data is returned or an error is detected in the execution, the WMI query will be unsuccessful.

Itis possible for a WMI query to return many rows of data, in which case you can create more complex WQL statements using
WHERE clauses. The more clauses you add to your statement, the fewer rows are likely to return, and the more specific your WMI
query will be.

The WMl filter includes several default templates for common WMI queries. To add a new WMI query from a template, click Add a
WMI template and use the instant search box to quickly find a template.

WQL statements can include parameterized values, which allow you to execute queries including select user, computer, and
Privilege Management for Windows properties.

-
1 For more information on how to use parameters, please see "Windows Workstyle Parameters" on page 45.

f Note: WMI queries are always run as SYSTEM, and cannot be executed against remote computers or network resources.
WMl filters do not support impersonation levels, and can only be used with SELECT queries.

By default, a WMI filter will apply if any of the WMI queries in the list return true. If you specified multiple WMI queries, and want to
apply the Workstyle only if ALL queries return true, then check the option All items below should match.

If a WMl filter is added, but no WMI queries are specified, a warning is displayed advising No queries added and the WMl filter is

ignored.
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Application Groups

Application groups are used to define logical groupings of applications.

Application groups are assigned to Workstyles, so you must define application groups for all of the applications you want to assign to
a Workstyle.

Create Application Groups

To create an application group:

Navigate to Privilege Management Settings > Windows > Application Groups.

2. Right-click Application Groups and click New Application Group. This creates an Application Group with the default name
Application Group x, where x increments numerically.

3. Right-click on the new Application Group and click Rename. Enter the new name you want and press Return to save your
new Application Group.

View or Edit the Properties of an Application Group

Each application group has a name, an optional description, and can be hidden from the policy navigation tree. You can edit these in
the properties for the application group.

To view the properties of an application group:

1. Navigate to Privilege Management Settings > Windows > Application Groups.

2. Right-click the application group and select Properties to view its properties. Enter or change the description and click OK to
save the new properties.

You can also choose to hide your application group in this menu by checking the Hidden box.

L]
. Formore information, please see "Show Hidden Groups" on page 38.

Delete an Application Group

Application groups are usually mapped to one or more application rule in a Workstyle. If you attempt to delete an application rule that
is mapped to an application group, you are notified of this before you continue. If you continue to delete the application group, the
associated application rule in the Workstyle is also deleted.

To delete an application group:

Navigate to Privilege Management Settings > Windows > Application Groups.
Right-click on the application group you want to delete and click Delete.

If there aren't any application rules in the Workstyle using that application group, then itis deleted. If there are application
rules in the Workstyle that reference that application group, then you are prompted to check the reference before you
continue. If you click Resolve All, then both the application group and the application rule that references it are deleted from
your policy. If you don't want to do this, click Cancel.
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Duplicate an Application Group

You can duplicate an application group if you need a new application group that contains the same applications as an existing
application group. You can edit a duplicated application group independently of the application group it was duplicated from.

To duplicate an Application Group:

Navigate to Privilege Management Settings > Windows > Application Groups.
Right-click on the application group you want to duplicate and click Copy.

3. Selectthe Application Groups node, right-click, and select Paste. This will make a new copy of the application group and all
the application rules it contained.

A new duplicate application group with an incremental number in brackets appended to the name will be created that you can add
applications to.

Rule Precedence

If you add more than one application rule or content rule to a Workstyle, then entries that are higher in the list will have a higher
precedence. Once a target matches a rule, no further rules or Workstyles will be processed for that target. If a target could match more
than one Workstyle or rule, then itis important that you order both your Workstyles and rules correctly.

To change the precedence of a rule in a Workstyle:

1. Expand the relevant Workstyle, and then select the rule type tab: Application, On-Demand, or Content.

2. Right-click on the rule and use the following options to change the rule precedence: Move Top, Move Up, Move Down, and
Move Bottom.

Application Definitions

Privilege Management for Windows must match every enabled criteria in an application definition before it will trigger a match (the
rules are combined with a logical AND).

Application definitions that require a match can also be negated. To target applications that do not match the definition, select does
NOT match from the drop-down.

ActiveX Codebase matches

When inserting ActiveX controls, this is enabled by default and we recommend you use this option in most circumstances. You must
enter the URL to the codebase for the ActiveX control. You can choose to match based on the following options (wildcard characters
? and * may be used):

« Exact Match

o Starts With

« Ends With

« Contains

« Regular Expressions

Although you can enter a relative codebase name, we strongly recommend you enter the full URL to the codebase, as itis more

secure.
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ActiveX Version matches

If the ActiveX control you entered has a version property, then you can choose Check Min Version and/or Check Max Version and
edit the respective version number fields.

App ID matches

This option allows you to match the App ID of the COM class, which is a GUID used by Windows to set properties for a CLSID. Applds
can be used by 1 or more CLSIDs.

The available operators are identical to the File or Folder Name definition.

Application Requires Elevation (UAC)

This option can be used to check if an executable requires elevated rights to run and would cause UAC (User Account Control) to
trigger. This is a useful way to replace inappropriate UAC prompts with Privilege Management for Windows end user messages to
either block or prompt the user for elevation.

Application Requires Elevation (UAC)

This option can be used to check if an MSI requires elevated rights to run and would cause User Account Control (UAC) to trigger.

K Note: This is supported on install only.

Any Uninstaller

This option allows you to match on any uninstaller type (msi or exe).

BeyondTrust Zone Identifier exists

This options allows you to match on the BeyondTrust Zone Identifier tag, where present. If an Alternate Data Stream (ADS) tag is
applied by the browser, we also apply a BeyondTrust Zone Identifier tag to the file. The BeyondTrust Zone Identifier tag can be used
as matching criteria if required.

CLSID matches

This option allows you to match the class ID of the ActiveX control or COM class, which is a unique GUID stored in the registry.

COM Display Name matches

If the class you entered has a Display Name, then it will automatically be extracted and you can choose to match on this property. By
default, a substring match is attempted (Contains). Alternatively, you may choose to pattern match based on either a wildcard match
(? and *) or a regular expression. The available operators are identical to File or Folder Name definition.
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Command Line matches

If the filename is not specific enough, you can match the command line, by checking this option and entering the command line to
match. By default, a substring match is attempted (Contains). Alternatively, you may choose to pattern match based on either a
wildcard match (? and *) or a regular expression. The available operators are identical to File or Folder Name definition.

PowerShell removes double quotes from command strings prior to transmitting to the target. Therefore, we do not recommend that
Command Line definitions include double quotes, as they will fail to match the command.

Controlling Process matches

This option allows you to target content based on the process (application) that will be used to open the content file. The application
must be added to an application group. You can also define whether any parent of the application will match the definition.

Drive matches

This option can be used to check the type of disk drive where the file is located. Choose from one of the following options:

. Fixed disk: Any drive thatis identified as being an internal hard disk.
« Network: Any drive thatis identified as a network share.
« RAM disk: Any drive thatis identified as a RAM drive.

- Any Removable Drive or Media: If you want to target any removable drive or media, but are unsure of the specific drive type,
choose this option which will match any of the removable media types below. Alternatively, if you want to target a specific type,
choose from one of the following removable media types:

o Removable Media: Any drive that is identified as removable media.

o USB: Any drive thatis identified as a disk connected by USB.

o CD/DVD: Any drive thatis identified as a CD or DVD drive.

o eSATA Drive: Any drive thatis identified as a disk connected by eSATA.

File or Folder Name matches

Applications are validated by matching the file or folder name. You can choose to match based on the following options (wildcard
characters ? and * may be used):

- Exact Match

» Starts With

« Ends With

» Contains

« Regular Expressions

L]
1 For more information, please see "Regular Expressions Syntax" on page 148.

Although you can enter relative filenames, we strongly recommend you enter the full path to a file or the COM server. Environment
variables are also supported.
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We do not recommend you use the definition File or Folder Name does NOT Match in isolation for executable types, as it will resultin
matching every application, including hosted types, such as installer packages, scripts, batch files, registry files, management
consoles, and Control Panel applets.

When creating blocking rules for applications or content, and the File or Folder Name is used as matching criteria against paths
which exist on network shares, this should be done using the UNC network path and not by the mapped drive letter.

File Hash (SHA-1 Fingerprint) matches

If a reference file was entered, then a SHA-1 hash of the PowerShell script will be generated. This definition ensures the contents or
the script file (which can normally be edited by any user) remain unchanged, as changing a single character in the script will cause
the SHA-1 Hash to change.

File Version matches

If the file, service executable, or COM server you entered has a File Version property, then it will automatically be extracted and you
can choose Check Min Version and/or Check Max Version, and edit the respective version number fields.

Parent Process matches

This option can be used to check if an application’s parent process matches a specific application group. You must create an
application group for this purpose or specify an existing application group in the Parent Process group. Setting match all parents in
tree to True will traverse the complete parent/child hierarchy for the application, looking for any matching parent process, whereas
setting this option to False will only check the application’s direct parent process.

Product Code matches

If the file you entered has a Product Code, then it will automatically be extracted and you can choose to check this code.

Product Description matches

If the file you entered has a Product Description property, then it will automatically be extracted, and you can choose to match on this
property. By default, a substring match is attempted (Contains). Alternatively, you may choose to pattern match based on either a
wildcard match (? and *) or a Regular Expression. The available operators are identical to the File or Folder Name definition.

Product Name matches

If the file, COM server, or service executable you entered has a Product Name property, then it will automatically be extracted and
you can choose to match on this property. By default, a substring match is attempted (Contains). Alternatively, you may choose to
pattern match based on either a wildcard match (? and *) or a Regular Expression. The available operators are identical to the File or
Folder Name definition.

Product Version matches

If the file, COM server, or service executable you entered has a Product Version property, then it will automatically be extracted and
you can choose Check Min Version and/or Check Max Version and edit the respective version number fields.
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Publisher matches

This option can be used to check for the existence of a valid publisher. If you browsed for an application, then the certificate subject
name will automatically be retrieved, if the application is signed. For Windows system files, the Windows security catalog is searched,
and if a match is found, the certificate for the security catalog is retrieved. Publisher checks are supported on Executables, Control
Panel Applets, Installer Packages, Windows Scripts, and PowerShell Scripts. By default, a substring match is attempted (Contains).
Alternatively, you may choose to pattern match based on either a wildcard match (? and *) or a Regular Expression. The available
operators are identical to the File or Folder Name definition.

Service Actions match

This option allows you to define the actions which are allowed. Choose from:

« Service Stop: Grants permission to stop the service.
« Service Start: Grants permission to start the service.
« Service Pause / Resume: Grants permission to pause and resume the service.

« Service Configure: Grants permission to edit the properties of the service.

Service Display Name matches

This option allows you to match the name of the Windows service, for example, W32Time. You may choose to match based on the
following options (wildcard characters ? and * may be used):

« Exact Match

« Starts With

« Ends With

. Contains

« Regular Expressions

Service Name matches

This option allows you to match the name of the Windows service, for example, W32Time. You may choose to match based on the
following options (wildcard characters ? and * may be used):

« Exact Match

- Starts With

« Ends With

« Contains

« Regular Expressions

Source URL matches

If an application was downloaded using a web browser, this option can be used to check where the application or installer was
originally downloaded from. The application is tracked by Privilege Management for Windows at the pointitis downloaded, so that if
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a user decided to run the application or installer at a later date, the source URL can still be verified. By default, a substring match is
attempted (Contains). Alternatively, you may choose to pattern match based on either a wildcard match (? and *) or a Regular
Expression. The available operators are identical to the File or Folder Name definition.

Trusted Ownership matches

This option can be used to check if an application’s file is owned by a trusted owner (the trusted owner accounts are SYSTEM,
Administrators, or Trusted Installer).

Upgrade Code matches

If the file you entered has an Upgrade Code, then it will automatically be extracted and you can choose to check this code.

Windows Store Application Version

This option allows you to match the version of the Windows Store application, for example, 16.4.4204.712. You can choose Check
Min Version and/or Check Max Version and edit the respective version number fields.

Windows Store Package Name

This option allows you to match the name of the Windows Store Application, for example, microsoft.microsoftskydrive. You can
choose to match based on the following options (wildcard characters ? and * may be used):

« Exact Match

« Starts With

« Ends With

. Contains

« Regular Expressions

Windows Store Publisher

This option allows you to match the publisher name of the Windows Store Application, for example, Microsoft Corporation. By
default, a substring match is attempted (Contains). Alternatively, you may choose to pattern match based on either a wildcard match
(? and *) or a Regular Expression. The other available operators are:

« Exact Match

« Starts With

« Ends With

« Contains

« Regular Expressions

The Browse File and Browse Apps options can only be used if configuring Privilege Management for Windows settings from a
Windows 8 client.
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Advanced Options

Allow child processes will match this application definition

If this box is checked, then any child processes that are launched from this application (or its children) will also match this rule. The
rules are still processed in order, so it's still possible for a child process to match a higher precedence rule (or Workstyle) first.
Therefore, this option will prevent a child process from matching a lower precedence rule. It should also be noted thatifan
application is launched by an on-demand rule and this option is selected, then its children will be processed against the on-demand
rules, and not the application rules. If this option is not selected, then the children will be processed against the application rules in
the normal way. You can further refine this option by restricting the child processes to a specific application group. The defaultis to
match <Any Application>, which will match any child process.

K Note: If you want to exclude specific processes from matching this rule, then click ...match... to toggle the rule to ...does
not match....

K Note: Child processes are evaluated in the context that the parent executed. For example, if the parent executed through
on-demand shell elevation, then Privilege Management for Windows will first attempt to match on-demand application
rules for any children of the executed application.

Force standard user rights on File Open/Save common dialogs

If the application allows a user to open or save files using the common Windows open or save dialog box, then selecting this option
ensures the user does not have admin privileges within these dialog boxes. These dialog boxes have Explorer-like features, and
allow a user to rename, delete, or overwrite files. If an application is running with elevated rights and this option is disabled, the
open/save dialog boxes will allow a user to replace protected system files.

Where present, this option is selected by default to ensure Privilege Management for Windows forces these dialog boxes to run with
the user’s standard rights, to prevent the user from tampering with protected system files.

When enabled, this option also prevents processes launched from within these dialog boxes from inheriting the rights of an elevated
application.

Environment Variables

Privilege Management for Windows supports the use of the following environment variables in file path and command line
application definitions:

System Variables

« %ALLUSERSPROFILE%

« %COMMONPROGRAMFILES(x86)%
« %COMMONPROGRAMFILES%

« %PROGRAMDATA%

« %PROGRAMFILES(x86)%

« %PROGRAMFILES%
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e %SYSTEMROOT%
o %SYSTEMDRIVE%

User Variables

« %APPDATA%

o %USERPROFILE%

o %HOMEPATH%

o %HOMESHARE%

o %LOCALAPPDATA%
o %LOGONSERVER%

To use any of the environment variables above, enter the variable, including the % characters, into a file path or command line.
Privilege Management for Windows will expand the environment variable prior to attempting a file path or command line match.

Insert ActiveX Controls

Unlike other application types, Privilege Management for Windows only manages the privileges for the installation of ActiveX
controls. ActiveX controls usually require administrative rights to install, but once installed, they will run with the standard privileges of
the web browser.

Select the application group you want to add the ActiveX control to.

Right-click and select Insert Application > ActiveX Control .

Enter the Codebase (URL) if required. This is a full or partial URL that specifies the location of the ActiveX control.

Enter a description if required. By default, this is the name of the application you're inserting.

o kLN

You need to configure the matching criteria for the executable and then click Next . You can configure:
« ActiveX Codebase matches
o CLSID matches
« ActiveX Version matches

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition

« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK . The Active X Control is added to the application group.

Insert Batch Files

Select the application group you want to add the application to.
2. Right-click and select Insert Application > Batch File .

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.
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L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the executable. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
o Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists

L]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
o "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

« "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open and Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The Active X Control is added to the application group.

Insert COM Classes

COM elevations are a form of elevation which are typically initiated from Explorer, when an integrated task requires administrator
rights. Explorer uses COM to launch the task with admin rights, without having to elevate Explorer. Every COM class has a unique
identifier, called a CLSID, that is used to launch the task.
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COM tasks usually trigger a Windows UAC prompt because they need administrative privileges to proceed. Privilege Management
for Windows allows you to target specific COM CLSIDs and assign privileges to the task without granting full administration rights to
the user. COM based UAC prompts can also be targeted and replaced with custom messaging, where COM classes can be
whitelisted and/or audited.

1. Selectthe application group you want to add the COM Class to.
2. Right-click and select Insert Application > COM Class .

3. Entera Class ID (CLSID) if required. Privilege Management for Windows will extract information from this for the criteria if
required, or click Browse Class, or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112 .

4. Enter a description if required. By default, this is the name of the application you're inserting.

5. You need to configure the matching criteria for the executable. COM classes are hosted by a COM server DLL or EXE, so
COM classes can be validated from properties of the hosting COM server. You can configure:

« File or Folder Name matches
o Drive matches

« File Hash (SHA-1 Fingerprint) matches
o Product Name matches

o Publisher matches

« CLSID matches

« App ID matches

« COM Display Name matches
« Product Description matches
o Product Version matches

« File Version matches

« Trusted Ownership matches

« Application Requires Elevation (UAC): Match if Application Requires Elevation (User Account Control) is always
enabled, as COM classes require UAC to elevate

« Source URL matches

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Product Name matches" on page 89

« "Publisher matches" on page 90

o "CLSID matches" on page 87

« "App ID matches" on page 87

« "COM Display Name matches" on page 87

« "Product Description matches" on page 89
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1 « "Product Version matches" on page 89
« "File Version matches" on page 89
o "Trusted Ownership matches" on page 91
« "Application Requires Elevation (UAC)" on page 87
« "Source URL matches" on page 90

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1. Formore information, please see "Advanced Options" on page 92.

7. Click OK . The application is added to the application group.

Insert Control Panel Applets

1. Select the application group you want to add the application to.
2. Right-click and select Insert Application > Control Panel Applet.

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File, Browse Folder, or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the control panel applet. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
« Product Name matches

« Publisher matches

« Product Description matches

o Product Version matches

« File Version matches

o Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists
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L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Product Name matches" on page 89

« "Publisher matches" on page 90

« "Product Description matches" on page 89

« "Product Version matches" on page 89

« "File Version matches" on page 89

o "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

» "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The Application is added to the application group.

Insert Executables

1. Selectthe application group you want to add the application to.
2. Right-click and select Insert Application > Executable .

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the executable. You can configure:

« File or Folder Name matches

« Command Line matches

o Drive matches

« File Hash (SHA-1 Fingerprint) matches
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« Product Name matches

« Publisher matches

« Product Description matches

« Product Version matches

« File Version matches

« Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Product Name matches" on page 89

« "Publisher matches" on page 90

« "Product Description matches" on page 89

« "Product Version matches" on page 89

« "File Version matches" on page 89

o "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

» "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK . The application is added to the application group.

Insert Installer Packages

Privilege Management for Windows allows standard users to install and uninstall Windows Installer packages that normally require
local admin rights. Privilege Management for Windows supports the following package types:
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« Microsoft Software Installers (MSI)
« Microsoft Software Updates (MSU)
« Microsoft Software Patches (MSP)
When a Windows Installer package is added to an application group, and assigned to an application rule or on-demand application

rule, the action will be applied to both the installation of the file, and also uninstallation when using Add/Remove Programs or
Programs and Features .

x Note: The publisher property of an MSx file may sometimes differ to the publisher property once installed in Programs
and Features. We therefore recommend applications targeted using the Match Publisher validation rule are tested for
both installation and uninstallation, prior to deployment, using the Privilege Management for Windows Activity Viewer.

Installer packages typically create child processes as part of the overall installation process. Therefore, we recommend when
elevating MSI, MSU, or MSP packages, that the advanced option Allow child processes will match this application definition is
enabled.

Note: If you want to apply more granular control over installer packages and their child processes, use the Child Process
validation rule to whitelist or blacklist those processes that will or will not inherit privileges from the parent software
installation.

1. Select the application group you want to add the installer package to.

N

Right-click and select Insert Application > Installer Package .

w

You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112 .

&

Enter a description, if required. By default, this is the name of the application you're inserting.

o

You need to configure the matching criteria for the installer package. You can configure:

« File or Folder Name matches

« Command Line matches

o Drive matches

« File Hash (SHA-1 Fingerprint) matches
« Product Name matches

« Publisher matches

« Product Version matches

o Product Code matches

« Upgrade Code matches

o Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

- BeyondTrust Zone Identifier exists

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 99

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/2019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrUSt GROUP POLICY ADMINISTRATION GUIDE 5.5.X

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Product Name matches" on page 89

« "Publisher matches" on page 90

« "Product Version matches" on page 89

« "Product Code matches" on page 89

« "Upgrade Code matches" on page 91

o "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

» "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.

Insert Privilege Management Policy Editor Snap-ins

1. Selectthe application group you want to add the application to.
2. Right-click and select Insert Application > Executable .

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the management console snap-ins. You can configure:

« File or Folder Name matches

« Command Line matches

o Drive matches

« File Hash (SHA-1 Fingerprint) matches
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o Publisher matches

« Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Publisher matches" on page 90

o "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

» "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.

Insert PowerShell Scripts

Privilege Management for Windows allows you to target specific PowerShell scripts and assign privileges to the script without
granting local administration rights to the user. Scripts can also be blocked if they are not authorized or whitelisted.

Select the application group you want to add the PowerShell script to.

Right-click and select Insert Application > PowerShell Script .

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112.
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4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the PowerShell script. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
o Publisher matches

« Trusted Ownership matches

« Parent Process matches

« Source URL matches

- BeyondTrust Zone Identifier exists

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

» "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Publisher matches" on page 90

« "Trusted Ownership matches" on page 91

« "Parent Process matches" on page 89

» "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.

ﬂ Note: PowerShell scripts that contain only a single line are interpreted and matched as a PowerShell command, and will
not match a PowerShell script definition. We recommend PowerShell scripts contain at least two lines of commands to
ensure they are correctly matched as a PowerShell script. This cannot be achieved by adding a comment to the script.
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Example PowerShell Configurations

Create New Configuration, Save to Local File

# Import both Defendpoint cmdlet module

Import-Module 'C:\Program Files\Avecto\Privilege Guard
Client\PowerShell\Avecto.Defendpoint.Cmdlets\Avecto.Defendpoint.Cmdlets.dll"
# Create a new variable containing a new Defendpoint Configuration Object
$PGConfig = New-Object Avecto.Defendpoint.Settings.Configuration

## Add License ##

# Create a new license object

$PGLicence = New-Object Avecto.Defendpoint.Settings.License
# Define license value

$PGLicence.Code = "5461EODO-DE30-F282-7D67-A7C6-B011-2200"
# Add the License object to the local PG Config file
$PGConfig.Licenses.Add ($PGLicence)

## Add Application Group ##

# Create an Application Group object

$SAppGroup = new-object Avecto.Defendpoint.Settings.ApplicationGroup
# Define the value of the Application Group name

SAppGroup.name = "New App Group"

# Add the Application Group object to the local PG Config file
$PGConfig.ApplicationGroups.Add (SAppGroup)

## Add Application ##

# Create an application object

$SPGApplication = new-object Avecto.Defendpoint.Settings.Application $PGConfig

# Use the Get-DefendpointFileInformation to target Windows Calculator
$PGApplication = Get-DefendpointFileInformation -Path C:\windows\system32\calc.exe
# Add the application to the Application group
$PGConfig.ApplicationGroups[0].Applications.AddRange ($PGApplication)

## Add Message ##

# Create a new message object

$PGMessage = New-Object Avecto.Defendpoint.Settings.message $PGConfig

#Define the message Name, Description and OK action and the type of message
$PGMessage.Name = "Elevation Prompt"

SPGMessage.Description = "An elevation message"

$PGMessage.OKAction = [Avecto.Defendpoint.Settings.Message+ActionType]::Proceed
$PGMessage.Notification = 0

# Define whether the message is displayed on a secure desktop
$SPGMessage.ShowOnIsolatedDesktop = 1

# Define How the message contains

$PGMessage.HeaderType = [Avecto.Defendpoint.Settings.messaget+MsgHeaderType]::Default
$PGMessage.HideHeaderMessage = 0

$SPGMessage.ShowLineOne = 1

$PGMessage.ShowLineTwo = 1

$PGMessage.ShowLineThree =
$PGMessage.ShowReferLink = 0
$PGMessage.ShowCancel = 1
$PGMessage.ShowCRInfoTip = 0

|
-
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# Define whether a reason settings

$PGMessage.

Reason =

[Avecto.Defendpoint.Settings.message+ReasonType] : :None

$PGMessage.CacheUserReasons = 0
# Define authorization settings

$PGMessage.PasswordCheck =

Avecto.Defendpoint.Settings.message+tAuthenticationPolicy] : :None

$PGMessage.AuthenticationType =
$PGMessage.

RunAsAuthUser

# Define Message strings

$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage
$PGMessage

.MessageStrings.
.MessageStrings.
.MessageStrings
.MessageStrings
.MessageStrings
.MessageStrings.
.MessageStrings.
.MessageStrings.
.MessageStrings.
.MessageStrings.
.MessageStrings
.MessageStrings
.MessageStrings
.MessageStrings.
.MessageStrings.
.MessageStrings.
.MessageStrings
.MessageStrings.

[Avecto.Defendpoint.Settings.message+MsgAuthenticationType] : :Any
0

Caption = "This is an elevation message"
Header = "This is an elevation message header"

.Body = "This is an elevation message body"
.ReferURL = "http:\\www.bbc.co.uk"
.ReferText =

"This is an elevation message refer"

ProgramName = "This is a test Program Name"

ProgramPublisher = "This is a test Program Publisher"

PublisherUnknown = "This is a test Publisher Unknown"

ProgramPath = "This is a test Path"

ProgramPublisherNotVerifiedAppend = "This is a test verification failure"

.RequestReason = "This is a test Request Reason"
.ReasonError =
.Username =

"This is a test Reason Error"
"This is a test Username"
Password = "This is a test Password"

Domain = "This is a test Domain"

InvalidCredentials = "This is a test Invalid Creds"

.OKButton = "OK"

CancelButton = "Cancel"

# Add the PG Message to the PG Configuration
$PGConfig.Messages.Add ($PGMessage)

## Add custom Token ##

# Create
SPGToken =
# Define
$SPGToken
SPGToken.
SPGToken.
$PGToken.
$SPGToken
SPGToken.

a new custom Token object

New-Object Avecto.Defendpoint.Settings.Token

the Custom Token settings
.Name = "Custom Token 1"
Description = "Custom Token 1"
ClearInheritedPrivileges = 0
SetAdminOwner =
.EnableAntiTamper

IntegrityLevel

=0

Avecto.Defendpoint.Settings.Token+IntegritylLevelType] ::High

# Add the custom token to the PG Configuration
$PGConfig.Tokens.Add ($PGToken)

## Add Policy ##

# Create new policy object

$PGPolicy

$PGPolicy.Description =

new-object Avecto.Defendpoint.Settings.Policy $PGConfig
# Define policy details
$PGPolicy.Disabled = 0
$PGPolicy.Name = "Policy 1"

"Policy 1"

# Add the policy to the PG Configurations
$PGConfig.Policies.Add ($PGPolicy)

## Add Policy Rule ##
# Create a new policy rule
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$PGPolicyRule = New-Object Avecto.Defendpoint.Settings.ApplicationAssignment PGConfig

# Define the Application rule settings

SPGPolicyRule.ApplicationGroup = $PGConfig.ApplicationGroups[0]
$PGPolicyRule.BlockExecution = 0

$PGPolicyRule.ShowMessage = 1

$PGPolicyRule.Message = $PGConfig.Messages[0]

$PGPolicyRule.TokenType = [Avecto.Defendpoint.Settings.Assignment+TokenTypeType] ::AddAdmin
$SPGPolicyRule.Audit = [Avecto.Defendpoint.Settings.Assignment+AuditType]::0n
$PGPolicyRule.PrivilegeMonitoring = [Avecto.Defendpoint.Settings.Assignment+AuditType]::0ff
$PGPolicyRule.ForwardEPO = 0

$PGConfig.Policies[0] .ApplicationAssignments.Add ($PGPolicyRule)

## Set the Defendpoint configuration to a local file and prompt for user confirmation ##
Set-DefendpointSettings -SettingsObject $PGConfig -Localfile —-Confirm

Open Local User Policy, Modify then Save

# Import the Defendpoint cmdlet module

Import-Module 'C:\Program Files\Avecto\Privilege Guard
Client\PowerShell\Avecto.Defendpoint.Cmdlets\Avecto.Defendpoint.Cmdlets.dll’
# Get the local file policy Defendpoint Settings

$PGConfig = Get-DefendpointSettings -LocalFile

# Disable a policy

$PGPolicy = $PGConfig.Policies[0]

$PGPolicy.Disabled = 1

$PGConfig.Policies[0] = $PGPolicy

# Remove the PG License

$TargetLicense = $PGConfig.Licenses[0]

$PGConfig.Licenses.Remove ($TargetLicense)

# Update an existing application definition to match on Filehash

$SUpdateApp = $PGConfig.ApplicationGroups[0].Applications[0]
SUpdateApp.CheckFileHash = 1

$PGConfig.ApplicationGroups[0] .Applications[0] = $UpdateApp

# Set the Defendpoint configuration to the local file policy and prompt for user confirmation
Set-DefendpointSettings —-SettingsObject $PGConfig -LocalFile -Confirm

Open Local Configuration and Save to Domain GPO

# Import the Defendpoint cmdlet module

Import-Module 'C:\Program Files\Avecto\Privilege Guard
Client\PowerShell\Avecto.Defendpoint.Cmdlets\Avecto.Defendpoint.Cmdlets.dll"

# get the local Defendpoint configuration and set this to the domain computer policy, ensuring the
user is prompted to confirm the change

Get-DefendpointSettings -LocalFile | Set-DefendpointSettings -Domain -LDAP "LDAP://My.Domain/CN=
{GUID},CN=Policies,CN=System, DC=My, DC=domain" —-Confirm
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Insert Registry Settings

1. Select the application group you want to add the application to.
2. Right-click and select Insert Application > Registry Settings .

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.

L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.

5. You need to configure the matching criteria for the application. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
o Trusted Ownership matches

- Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists

L]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

« "Source URL matches" on page 90

« "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.
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Insert Remote PowerShell Commands

Privilege Management for Windows provides an additional level of granularity for management of remote PowerShell cmdlets to
ensure you can execute these commands without local administrator privileges on the target computer.

Get-service -Name *time* | restart-Service —-PassThru

Privilege Management for Windows allows you to target specific command strings and assign privileges to the command without
granting local admin rights to the user. Commands can also be blocked if they are not authorized or whitelisted. All remote
PowerShell commands are fully audited for visibility.

To allow standard users to connect to a remote computer with Windows Remote Management, or WinRM (a privilege normally
reserved for local administrator accounts), itis necessary to enable the General rule Enable Windows Remote Management
Connections. This rule grants standard users, who match the Privilege Management for Windows Workstyle, the ability to connect
using WinRM, and can be targeted to specific users, groups of users, or computers using Workstyle filters.

Select the application group you want to add the application to.
Right-click and select Insert Application > Remote PowerShell Command.

You can leave the Select reference script file blank to match on all applications of this files, type in a specific name or path
manually, or click Browse Cmdlets.This lists the PowerShell cmdlets for the version of PowerShell that you installed. If the
cmdlet you want to use is not listed because the target version of PowerShell is different, you can manually enter it.

Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the PowerShell command. You can configure:
« Command Line matches: PowerShell removes double quotes from the Command Line before itis sent to the target.

Command Line definitions thatinclude double quotes are not matched by Privilege Management for Windows for
remote PowerShell commands.

L]
. Formore information, please see "Command Line matches" on page 88.

6. Click OK. The application is added to the application group.

L]
1 If you want to manage remote PowerShell scripts instead of a single cmdlet, please see "Insert Remote PowerShell
Scripts" on page 107 for more information.

Messaging

Privilege Management for Windows end user messaging includes limited support for remote PowerShell sessions; block messages
can be assigned to Workstyle rules, which block remote PowerShell scripts and commands. If a block message is assigned to a
Workstyle, which blocks a script or command, then the body message text of an assigned message will be displayed in the remote
console session as an error.

Insert Remote PowerShell Scripts

From within a remote PowerShell session, a script (.PS1) can be executed from a remote computer against a target computer.
Normally this requires local administrator privileges on the target computer, with little control over the scripts that are executed, or the
actions that the script performs. For example:
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Invoke-Command -ComputerName RemoteServer -FilePath c:\script.psl -Credential xxx

Privilege Management for Windows allows you to target specific PowerShell scripts remotely and assign privileges to the script
without granting local administration rights to the user. Scripts can also be blocked if they are not authorized or whitelisted. All remote
PowerShell scripts executed are fully audited for visibility.

Note: You must use the Invoke-Command cmdlet to run remote PowerShell scripts. Privilege Management for Windows
cannot target PowerShell scripts that are executed from a remote PowerShell session. Remote PowerShell scripts must be
matched by either a SHA-1 File Hash or a Publisher (if the script has been digitally signed).

Privilege Management for Windows allows you to elevate individual PowerShell scripts and commands which are executed from a
remote machine. This eliminates the need for users to be logged on with an account which has local admin rights on the target
computer. Instead, elevated privileges are assigned to specific commands and scripts which are defined in application groups, and
applied by a Workstyle.

PowerShell scripts and commands can be whitelisted to block the use of unauthorized scripts, commands, and cmdlets. Granular
auditing of all remote PowerShell activity provides an accurate audit trail of remote activity.

PowerShell definitions for scripts and commands are treated as separate application types, which allows you to differentiate between
pre-defined scripts authorized by IT, and session-based ad hoc commands.

To allow standard users to connect to a remote computer with Windows Remote Management, or WinRM (a privilege normally
reserved for local administrator accounts), itis necessary to enable the General rule Enable Windows Remote Management
Connections. This rule grants standard users who match the Privilege Management for Windows Workstyle the ability to connect
using WinRM, and can be targeted to specific users, groups of users, or computers using Workstyle filters.

N

Select the application group you want to add the Remote PowerShell script to.

N

Right-click and select Insert Application > Remote PowerShell Script.

3. You can leave the Select reference script file blank to match on all applications of this files, type in a specific name or path
manually, or click Browse File.

.‘>

Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the PowerShell script. You can configure:

« File Hash (SHA-1 Fingerprint) matches

« Publisher matches

L]
1 For more information, please see the following:

« "File Hash (SHA-1 Fingerprint) matches" on page 89

« "Publisher matches" on page 90

6. Click OK. The application is added to the application group.

K Note: Remote PowerShell scripts that contain only a single line will be interpreted and matched as a Remote PowerShell
Command, and will fail to match a PowerShell script definition. We therefore recommend PowerShell scripts contain at
least two lines of commands to ensure they are correctly matched as a script. This cannot be achieved by adding a
comment to the script.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 108

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/2019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrust GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Messaging

Privilege Management for Windows end user messaging includes limited support for remote PowerShell sessions; block messages
can be assigned to Workstyle rules which block remote PowerShell scripts and commands. If a block message is assigned to a
Workstyle which blocks a script or command, then the body message text of an assigned message will be displayed in the remote
console session as an error.

Insert Uninstaller (MSI or EXE)

Privilege Management for Windows allows standard users to uninstall Microsoft Software Installers (MSlIs) and executables (EXEs)
that would normally require local admin rights.

When the Any Uninstaller application type is added to an application group and assigned to an application rule in the Privilege
Management for Windows policy, the end user can uninstall applications using Programs and Features or, in Windows 10, Apps
and Features .

The Uninstaller Application Type allows you to uninstall any EXE or MSI when itis associated with an Application Rule. As the
process of uninstalling a file requires admin rights, you need to ensure when you target the Application Group in the Application
Rules you set the Access Token to Add Admin Rights.

K Note: The Uninstaller type must be associated with an Application Rule. It does not apply to On-Demand Application
Rules.

You cannot use the Uninstaller Application Type to uninstall the BeyondTrust Privilege Management for Windows or the BeyondTrust
PMC Adapter using Privilege Management for Windows, irrespective of your user rights. The anti-tamper mechanism built into
Privilege Management for Windows prevents users from uninstalling Privilege Management for Windows, and the uninstall will fail
with an error message.

K Note: If a user attempts to use Privilege Management for Windows to modify the installation of Privilege Management for
Windows, for example, uninstall it, and they do not have an anti-tamper token applied, the default behavior for the user is
used. For example, if Windows UAC is configured, the associated Windows prompt will be displayed.

If you want to allow users to uninstall either BeyondTrust's Privilege Management for Windows or the BeyondTrust PMC Adapter, you
can do this by either:

« Loggingin as a full administrator

« Elevating the Programs and Features control panel (or other controlling application) using a Custom Access Token that has
anti-tamper disabled.

L]
1 For more information, please see "Edit Custom Tokens" on page 132.

Select the application group you want to add the uninstaller to.
Right-click and select Insert Application > Uninstaller .
Enter a description, if required. By default, this is the name of the application you're inserting.

e Dnhd =

The Any Uninstaller matching criteria is selected by default. This cannot be changed.

L]
1 For more information, please see "Any Uninstaller" on page 87.
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5. The advanced options are selected by default for the Uninstaller application type. This cannot be changed.
6. Click OK. The application is added to the application group.

Insert Windows Services

The Windows service type allows individual service operations to be whitelisted, so that standard users are able to start, stop, and
configure services without the need to elevate tools such as the Service Control Manager.
Select the application group you want to add the application to.
2. Right-click and select Insert Application > Window Service .

3. You can leave the Service Name blank to match on all applications of this type, type in a specific name or path manually, or
click Browse Services to browse the services on the local computer.

Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the windows services. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
« Product Name matches

o Publisher matches

« Product Description matches

o Product Version matches

« File Version matches

« Service Name matches

« Service Display Name matches
« Service Actions match

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Product Name matches" on page 89

« "Publisher matches" on page 90

« "Product Description matches" on page 89

« "Product Version matches" on page 89

« "File Version matches" on page 89

« "Service Name matches" on page 90

« "Service Display Name matches" on page 90
« "Service Actions match" on page 90
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6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

-
1 Formore information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.

Insert Windows Store Applications

The Windows Store application type allows the installation and execution of Windows Store applications on Windows 8 and later to
be whitelisted, so that users are prevented from installing or using unknown or unauthorized applications within the Windows Store.

Note: Privilege Management for Windows can only be used to block Windows Store Applications. When you use Privilege
Management for Windows to block a Windows Store Application and assign a Privilege Management for Windows block
message to the Application Rule, the native Windows block message overrides the Privilege Management for Windows
block message, meaning it is not displayed. Event number 116 is still triggered if you have events set up in your
Application Rule.

1. Select the application group you want to add the application to.
2. Right-click and select Insert Application > Windows Store Application.

3. You can leave the File or Folder Name blank to match on all applications of this type, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.

-
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

-
. Formore information, please see "Advanced Options" on page 92.

6. Click OK. The application is added to the application group.

Insert Windows Scripts

Select the application group you want to add the application to.
2. Right-click and select Insert Application > Windows Script .

3. You can leave the File or Folder Name blank to match on all applications of this files, type in a specific name or path
manually, or click Browse File , Browse Folder, or Template.
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L]
1 For more information, please see "Insert Applications from Templates" on page 112.

4. Enter a description, if required. By default, this is the name of the application you're inserting.
5. You need to configure the matching criteria for the executable. You can configure:

« File or Folder Name matches

« Command Line matches

« Drive matches

« File Hash (SHA-1 Fingerprint) matches
« Publisher matches

o Trusted Ownership matches

« Application Requires Elevation (UAC)
« Parent Process matches

« Source URL matches

« BeyondTrust Zone Identifier exists

L ]
1 For more information, please see the following:

« "File or Folder Name matches" on page 88

« "Command Line matches" on page 88

« "Drive matches" on page 88

« "File Hash (SHA-1 Fingerprint) matches" on page 89
« "Publisher matches" on page 90

« "Trusted Ownership matches" on page 91

« "Application Requires Elevation (UAC)" on page 87
« "Parent Process matches" on page 89

« "Source URL matches" on page 90

- "BeyondTrust Zone Identifier exists" on page 87

6. You need to configure the Advanced Options for the application. You can configure:

« Allow child processes will match this application definition
« Force standard user rights on File Open/Save common dialogs

L]
1 For more information, please see "Advanced Options" on page 92.

7. Click OK. The application is added to the application group.

Insert Applications from Templates

Application templates provide a simple way to pick from a list of known applications. A standard set of templates is provided that
covers basic administrative tasks for all supported operating systems, common ActiveX controls, and software updaters.
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There are two ways you can insert applications into Application Groups. If you want to insert multiple applications from the
BeyondTrust templates, you need to add the applications from the template menu.

L]
1 For more information, please see "Use the Add Apps to Template Menu" on page 113.

If you use the Template functionality, once you select your application type, the list from BeyondTrust is filtered to just those
applications and you can only add one ata time.

-
. Formore information, please see "Use the Template Option in Matching Criteria" on page 113.

Use the Add Apps to Template Menu

Select the application group you want to add the application to.

2. Right-click and select Insert Applications > Application Templates. Choose one or more applications to add to the
application group. You can select multiple rows using standard Windows functionality.

3. Click Save to add the applications or click Finish to exit without adding any applications.

Use the Template Option in Matching Criteria

Select the application group you want to add the application to.
Right-click and select Insert Applications > Application Templates.

Click Template next to the Description and choose the application you selected to add to the application group.

o Db~

Select the applications you want to add to the application group. Each application is highlighted once selected. Use the filter
options Filter Text or Type, at the top of the page to refine the number of applications displayed.

5. Select Save.

You can click on an application description to modify the settings of the application definitions and/or the Advanced Options.

Windows Application Templates

Privilege Management for Windows ships with some standard application templates to simplify the definition of applications that are
part of the operating system, common ActiveX controls, and software updaters. The standard application templates are splitinto
categories:

« Browsers

« COM Classes for 3rd Party Software

« Com Classes for file, folder and drive operations

« COM Classes for general Windows operations

« COM Classes for security features and configurations

. COM Classes for software installation, uninstallation, and updates

« COM Classes for network device settings, sharing options, and configurations

o Common ActiveX controls

« ContentHandler Untrusted

« ContentHandlers
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« Installers for common printer driver manufacturers

« Software updaters

« Tools and utilities for administrators and developers

« Windows 10 Default Apps

« Windows 7/8 and Windows Server 2008 R2/2012 /2012 R2
o Windows 8.0 Default Apps

« Windows 8.1 Default Apps

« Windows Server 2008 R2

Each category then has a list of applications for that category. Picking an application will cause the application or ActiveX control
dialog boxes to be pre-populated with the appropriate information.

Insert Applications from Running Processes

Select the relevant application group.

Right-click the applications listin the details pane to access the context menu.

Select Insert Application and then select the Running Process from the sub-menu.

The Running Process dialog box appears.

Select Show processes from all users if you want to select a process from another user’s session.

R

Select the relevant process from the list. Click OK.

Insert Applications from Events

The Event Import Wizard allows you to search from in any Privilege Management for Windows event source, and create application
definitions based on the properties collected by an audit event. The wizard provides a simple and convenient way to find specific
applications based on any or all of the following search criteria:

« Event Source: Where the eventis collected (Local or remote Eventlog, Forwarded Eventlog, or Enterprise reporting Pack
database).

« Event Type: The type of event you are interested in. Choose Any application or choose from one of the following:
o Applications that performed privileged operations
= Eventnumber 100
o Applications that triggered UAC
m [fthe UACTriggered flag on the event was setto 1
o Applications that were blocked
s Eventnumber 116
o Applications that were launched by the Shell Menu
= Eventnumbers 101, 104,107,110, 114 and 119

- Timeframe: The period of time to search for applications. Choose from one of the following:
o From: Pick a range starting from a predefined time period. From here you can also choose Anytime, to include all
events.
o Specific period: Pick an optional From and To date to include events collected during that period of time.
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Once the search criteria is entered, the wizard returns a list of unique applications that were audited, matching the criteria you
specified. From here you can browse the list (which is grouped by Publisher), or to find a particular application you can type into the
Search publisher\Description field to instantly filter the list based on the text you enter.

Applications that are already members of the application group will be highlighted and displayed with a check mark v".

After you find an application or applications, select (or multi-select by holding down the Control or Shift key while selecting) and then
click OK to create new application definitions from your selection.

Once the definitions are created, you can edit the definition and modify the matching criteria. All matching criteria will be pre-
populated with values collected from the application.

ﬂ' Note: A unique application is based on the product description of the application. So if two or more audited applications
share the same product description, they will be displayed as a single application.
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Content Groups

Content control allows you to control the accessibility of privileged content. Content groups provide a means of targeting specific
types of content, based on file or folder, drive, or controlling process. Rules determining the behavior for that content are applied to
each content group in a Workstyle.

There are two main use cases for applying content control:

1. To allow standard users to modify privileged content, without having to assign admin rights to either the user, or the
application used to modify the content.

« Content groups can be added to content rules where the content can be assigned admin rights. When this is done, any
user who receives the Workstyle can modify matching content without requiring an administrator account.

2. To block access to content or directories.
« Content groups can be added to content rules where the ability to open the content can be controlled with a Block

action. When this is done, any user who can normally open and read the contentis blocked from opening the content.

The following sections explain how to create content groups including content definitions, and how to assign groups to content rules
to apply the specific content control rules that meet your requirements.

Create Content Groups

To create a content group:

Navigate to Privilege Management Settings > Windows > Content Groups.

2. Right-click and click New Content Group. This creates a Content Group with the default name Content Group x, where x
increments numerically.

3. Right-click on the new Content Group and click Rename. Enter the new name you want and press Return to save your new
Content Group.

Duplicate Content Groups

You can duplicate a content group if you need a new content group that contains the same content as an existing content group. You
can edit a duplicated content group independently of the content group it was duplicated from.

To duplicate a Content Group:

Navigate to Privilege Management Settings > Windows > Content Groups.

Right-click on the Content Group you want to duplicate and click Copy.

Select the Content Groups node, right-click, and select Paste. This will make a new copy of the Content Group and all the
Contentrules it contains.

A new duplicate Content Group with an incremental number in brackets appended to the name will be created that you can add
content to.

Target Content Definitions

The Content dialog box provides various Content Definitions. Privilege Management for Windows must match every definition you
configure before it will trigger a match (the rules are combined with a logical AND). The following definitions are available:
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File or Folder Name

Applications are validated by matching the file or folder name. You can choose to match based on the following options (wildcard
characters ? and * may be used):

« Exact Match
o Starts With
« Ends With

» Contains
« Regular Expressions

L]
1 For more information, please see "Regular Expressions Syntax" on page 148.

Although you can enter relative filenames, we strongly recommend you enter the full path to a file or the COM server. Environment
variables are also supported.

We do not recommend the definition File or Folder Name does NOT Match is used in isolation for executable types, as it will resultin
matching every application, including hosted types such as Installer packages, scripts, batch files, registry files, management
consoles, and Control Panel applets.

When creating blocking rules for applications or content, and the File or Folder Name is used as matching criteria against paths
which exist on network shares, this should be done using the UNC network path and not by the mapped drive letter.

Drive

This option can be used to check the type of disk drive where the file is located. Choose from one of the following options:

« Fixed disk: Any drive thatis identified as being an internal hard disk.
« Network: Any drive thatis identified as a network share.
« RAM disk: Any drive thatis identified as a RAM drive.

- Any Removable Drive or Media: If you want to target any removable drive or media, but are unsure of the specific drive type,
this option will match any of the removable media types below. Alternatively, if you want to target a specific type, choose from
one of the following removable media types:

o Removable Media: Any drive that is identified as removable media.

o USB: Any drive thatis identified as a disk connected by USB.

o CD/DVD: Any drive thatis identified as a CD or DVD drive.

o eSATA Drive: Any drive thatis identified as a disk connected by eSATA.

Controlling Process

This option allows you to target content based on the process (application) that will be used to open the content file. The application
must be added to an application group. You can also define whether any parent of the application will match the definition.

Insert Content

To insert a content rule:
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1.
2.
3.
4.

Select the content group you want to add the content control to.

Right-click and select Insert Content.

Enter a description, if required.

You need to configure the matching criteria for the executable and then click Next. You can configure:
« File or Folder Name
o Drive

« Controlling Process

5. Click Finish. The contentis added to the content group.
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Messages

You can define any number of end user messages and notifications. Messages and notifications are displayed when a user’s action
triggers a rule (application/on-demand or content rule). Rules can be triggered by an application launch or block, or when contentis
modified.

Messages provide an effective way of alerting the user before an action is performed. For example, before elevating an application or
allowing content to be modified, or advising that an application launch or content modification is blocked.

Messages give the user information about the application or content, the action taken, and can be used to request information from
the user. Messages also allow authorization and authentication controls to be enforced before access to an application is granted.

Messages are customizable with visual styles, corporate branding, and display text, so you are offered a familiar and contextual
experience. Messages are assigned to application rules. A message will display different properties, depending on which of these
targets itis assigned to. To view the differences, a Preview option allows you to toggle between the Application Preview and the
Content Preview. This is available from the Preview drop-down menu, located in the top-right corner of the details pane.

Once defined, a message may be assigned to an individual rule in the Workstyles Rules tab by editing the rule. Depending on the
type of Workstyle you’ve created, Privilege Management for Windows may auto-generate certain messages for you to use.

Types of Messages

You can choose from Messages or Notifications. Messages take focus when they're displayed to the user. Message notifications
appear on the user's task bar.

Message notification text is fully customizable, so that users are given concise and relevant information about the action performed.
You can edit the strings in the Message Text tab.

-
1 For more information, please see "Message Text" on page 128.

Message notifications are displayed either as a systray bubble (Windows 7), or as a foast notification (Windows 8 and higher).

f Note: Message notifications are not supported for SYSTEM processes.

Create Messages

You can create two types of messages:

« Message or Notification
« ActiveX Message

Message or Notification
To create a message or notification:

1. Navigate to Privilege Management Settings > Windows > Messages.
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2. Right-click and click New Message.

Mew Message x
Create a new message
Select a message template
Select 3 message template

The template defines the outcome, elevation templates wil allow the program to
run (with elevation) and blodk templates will prevent the program from running.

(®)jiise a Message Box template;
5 Allow Message (Blevate) w
() se a Notification (balloon) template:

Application Mofification (Audit Only)

<o o

3. Selecta message template from either the Use a Message Box template or Use a Notification (balloon) drop-down menus
and click Next.

Note: Messages can be interactive (the user may be asked to input information before an action occurs). Notifications are
descriptive (displaying information about an action that has occurred).

4. Customize the message (more advanced message configuration can be performed after the message is created).
5. Click Finish.

A new message will be created. You can further refine the message by selecting it and editing the Design and the Text options
available beneath each message.

ActiveX Message

When Privilege Management for Windows is configured to elevate the installation of an ActiveX control, a built-in progress dialog box
of the installation process appears. You can create and configure this message in the Messages node.
1. Navigate to Privilege Management Settings > Windows > Messages.
2. Right-click and click Manage ActiveX Message text.
« Title: The title text of the progress dialog box.
. Download Message: The text displayed during the download phase.
« Install Message: The text displayed during the installation phase.

The display text can be configured for multiple languages. Privilege Management for Windows will detect the regional language of
the end user, and if ActiveX strings in that language are configured, the correct translation will be displayed.

Note: If language settings for the region of the end user are not configured, then the default language text will be
displayed. To change the default language, select the desired language and click Set Default.
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Set ActiveX Message Text

When Privilege Management for Windows is configured to elevate the installation of an ActiveX control, a built-in progress dialog box
of the installation process appears. You can create and configure this message in the Messages node.

1. Right-click on the Messages node and select Manage ActiveX Message text.

« Title: The title text of the progress dialog box.

- Download Message: The text displayed during the download phase.

« Install Message: The text displayed during the installation phase.

« Cancel Button: The text displayed for the button that cancels the ActiveX installation.

The display text can be configured for multiple languages. Privilege Management for Windows will detect the regional language of
the end user, and if ActiveX strings in that language are configured, the correct translation is displayed.

Note: If language settings for the region of the end user are not configured, then the default language text will be
displayed. To change the default language, select the desired language and click Set Default.

Message Name and Description

You may edit a message name or description by clicking on either element:

1. Select the Message (in either the left or right pane).
2. Selecteither the Message Design tab or the Message Text tab to make further changes to your message.

L]
1. Formore information, please see the following:

« "Message Design" on page 121
« "Message Text" on page 128

Message Design

Messages have a wide array of configuration options, which are detailed below.

As you change the various message options, the preview message will automatically be updated. To test the message box, use the
preview facility (program and content information will contain appropriate placeholders).

Once you configure the message options, you should configure the Message Text for the message, which includes full multi-lingual
support.

« Miscellaneous Settings

« Message Header Settings

- Message Body Settings

« User Reason Settings

« User Authorization

« Challenge/Response Authorization
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« Authorization Settings
« Email Settings

L]
1 For more information, please see the following:

« "Miscellaneous Settings" on page 122

« "Message Header Settings" on page 122

« "Message Body Settings" on page 123

« "User Reason Settings" on page 123

« "User Authorization" on page 123

« "Challenge/Response Authorization" on page 124
« "Authorization Settings" on page 125

« "Email Settings" on page 125

Miscellaneous Settings

« Show message on secure desktop: Select this option to show the message on the secure desktop. We recommend this if the
message is being used to confirm the elevation of a process, for enhanced security.

Message Header Settings

« Header Style: Select the type of header, which can be No header, Privilege Management, Warning, Question, or Error.
« Show Title Text: Determines whether to show the title text.
« Text Color: Select the color for the title text (the automatic color is based on the Header Style).

« Background Type: Set the background of the header, which can be Solid background, Gradient background, or Custom
image (the default Background Type is Custom Image, making the Color 1 and Color 2 options initially unavailable).

« Color 1: Select the color for a Solid background or the first color for a Gradient background (the automatic color is based on
the Header Style).

« Color 2: Select the second color for a Gradient background (the automatic color is based on the selected Header Style).

« Custom Image: Select the image for a Custom image background. This option is only enabled if you have selected Custom
Image for the Background Type. Click the ellipsis (...) button to import, export, modify, or delete images using the Image
Manager.

Image Manager

The Image Manager associated with message creation allows you to Add, Modify, Export, and Delete images that are referenced in
message headers. All images are stored inside the Workstyles as compressed and encoded images.

We recommend you delete any unused images to minimize the size of the policies, as Privilege Management for Windows does not
automatically delete unreferenced images.

The Image Manager is accessible from the Message Design tab. Click the Manage Images button next to the Custom Image drop-
down menu.

To upload an image:

1. Click Upload Image. The Import Image status dialog box appears. Click Choose file and browse to the location of the file.
2. Selectthe image and enter an Image Description. Click OK.
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3. The image will be uploaded into Image Manager.

f Note: Images must be *.png format. The recommended size is 450x50.

To edit an image:

In the Custom Image field, select Manage Images.
Select the image in the list and click Edit.
The Image Properties dialog box appears.

B oe Db =

Alter the description and click OK.
To delete an image:

1. Select the image in the list and click Delete.
2. When prompted, click Yes to delete the image.

x Note: If an image is referenced by any messages, you will not be allowed to delete it.

Message Body Settings

The Message Body Settings display specific information about the program or content. These can be configured on the Message
Text tab; they can display Automatic default values or Custom values. The Automatic default values are:

« Show Line One: The Program Name or the Content Name.

« Show Line Two: The Program Publisher or the Content Owner.

« Show Line Three: The Program Path or the Content Program.

Custom values are configured on the Message Text tab.

« Show reference Hyperlink: This option determines whether to show a hyperlink in the message below the body settings (the
hyperlink is configured on the Message Text tab).

User Reason Settings

This option determines whether to prompt the end user to enter a reason before an application launches (Allow Execution message
type) or to request a blocked application (Block Execution message type).

« Show User Reason Prompt: Select between Text box and Drop-down menu. The Text Box allows users to write a reason or
request. The Drop-down allows users to select a pre-defined reason or request from a drop-down menu. The pre-defined
drop-down entries can be configured on the Message Text tab.

« Remember User Reasons (per-application): Reasons are stored per-user in the registry.

User Authorization

« Authorization Type: Set this option to User must authorize to force the user to re-authenticate before proceeding. If you want
to use this option for over the shoulder administration, then set this option to Designated user must authorize.
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« Authentication Method: Set this option to Any to allow authentication using any method available to the user. If you want to
enforce a specific authentication method, then set to either Password only or Smart card only.

x Note: If you select a method that is not available to the user, then the user will be unable to authorize the message.

. Designated Users: If the Authorization Typeis set to Designated user must authorize, then click the ellipsis (...) button to
add one more user accounts or groups of users that will be allowed to authorize the message.

« Run application as Authorizing User: If the Authorization Type is set to Designated user must authorize, then this option
determines whether the application runs in the context of the logged on user or in the context of the authorizing user. The
defaultis to run in the context of the logged on user as opposed to the authorizing user.

K Note: When Run application as Authorizing User is set to Yes, Privilege Management for Windows will attempt to match
a Workstyle of the same type (application rule or on-demand rule) for the authorizing user. If no Workstyle is matched,
Privilege Management for Windows will fall back to the original user Workstyle.

Designated User Must Authorize

When this option is enabled, a designated user, such as a system administrator, can authorize the elevation in place of (or in addition
to) a Challenge Response code.

Input Outcome

Valid Challenge/Response code only is Application runs as logged on user
provided

Valid Challenge/Response code is provided Application runs as logged on user
and valid (but not required) credentials are

provided

Invalid Challenge/Response code is provided Application runs as authorizing user
but valid credentials are provided

No Challenge/Response code is provided but Application runs as authorizing user
valid credentials are provided

Challenge/Response Authorization

« Enabled: Set this option to Yes to present the user with a challenge code. For the user to proceed, they must enter a matching
response code. You can click Edit Key to change the shared key for this message.

x Note: When this option is enabled for the first time, you will be requested to enter a shared key.

L]
1. Formore information, please see "Challenge/Response Authorization" on page 126.

« Authorization Period (per-application): Set this option to determine the length of time a successfully returned challenge code
is active for. Choose from:
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o One use Only: A new challenge code is presented to the user on every attempt to run the application.

o Entire Session: A new challenge code is presented to the user on the first attempt to run the application. After a valid
response code is entered, the user will not be presented with a new challenge code for subsequent uses of that
application until they nextlog on.

o Forever: A new challenge code is presented to the user on the first attempt to run the application. After a valid
response code is entered, the user will not be presented with a new challenge code again.

o As defined by helpdesk: A new challenge code is presented to the user on the first attempt to run the application. If
this option is selected, the responsibility of selecting the authorization period will be delegated to the helpdesk user at
the time of generating the response code. The helpdesk user can select one of the three above authorization periods.
After a valid response code is entered, the user will not receive a new challenge code for the duration of time specified
by the helpdesks.

« Suppress messages once authorized: If the Authorization Period is not set to One Use Only the Suppress messages
once authorized option is enabled and configurable.

« Show Information tip: This option determines whether to show an information tip in the challenge box.

. Forinformation on how to configure the text of the information tip, please see "Message Text" on page 128.

« Maximum Attempts: This option determines how many attempts the user has to enter a successful response code for each
new challenge. Set this option to Three Attempts to restrict the user to three attempts, otherwise set this option to Unlimited.

Note: After the third failure to enter a valid response code, the message will be canceled and the challenge code will be
rejected. The next time the user attempts to run the application, they will be presented with a new challenge code. Failed
attempts are accumulated even if the user clicks Cancel between attempts.

Authorization Settings

If Authorization Type has been set to Designated user must authorize, this field becomes active. It allows you to choose between
either:

« Yes - Both required: Both the challenge/response and the designated user credentials are required.
« No - Either one sufficient: Either the challenge/response or the designated user credentials are required.

Email Settings
The email settings are only enabled for blocking messages.

« Allow user to email an application request: Select this option to allow the user to email a request to run an application (only
available for the Block Execution message type).
« Mail To: Email address to send the request to (separate multiple email addresses with semicolons).

« Subject: Subjectline for the email request.

The Mail To and Subject fields can include parameterized values, which can be used with email based automated helpdesk systems.

-
1 For information on using parameters, please see "Windows Workstyle Parameters" on page 45.
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Challenge/Response Authorization

Challenge/Response authorization provides an additional level of control for access to applications and privileges, by presenting
users with a challenge code in an end user message. For the user to progress, they must enter a corresponding response code into
the message.

Any policy that has a message in with challenge/response needs a shared key. This key is defined when you set up the first
challenge/response message in your policy, although you can change it later if required. If you create a Workstyle containing a
challenge/response message or you create a new challenge/response message and you are not prompted to create a shared key,
then there is already a shared key for the policy. You cannot view this shared key, however you can change itifrequired in the
Design page of a Message.

L]
1 For more information, please see "Shared Key" on page 126.

Challenge/Response authorization is configured as part of an end user message, and can be used in combination with any other
authorization and authentication features of Privilege Management for Windows messaging.

Authorization is applied per user, per token, per application, meaning that each user is presented with challenge codes that when
authorized, only apply to them, the token used to request access, and the specific application.

If there is still a valid Privilege Management for Windows response code available to the endpoint when the user runs the application
with a Power Rule assigned fo it, the application will open using the existing Privilege Management for Windows response code and
the Rule Scriptis notrun.

Challenge and response codes are presented as 8 digit numbers, to minimize the possibility of incorrect entry. When a user is
presented with a challenge code, the message may be canceled without invalidating the code. If the user runs the same application,
they will be presented with the same challenge code. This allows users to request a response code from IT helpdesks who may not
be immediately available to provide a response.

L]
1 For more information on configuring challenge/response authorization enabled end user messages, please see "Message

Design" on page 121.

Shared Key

The first time you create a Privilege Management for Windows end user message with a challenge, you are asked to create a shared
key. The shared key is used by Privilege Management for Windows to generate challenge codes at the endpoint.

Once you enter a shared key, it will be applied to all end user messages that have challenge/response authorization enabled in the
same Privilege Management for Windows settings.

To change the shared key:
1. Right-click the Messages node of a Workstyle and select Set Challenge/Response Shared Key.
2. In the Challenge/Response Shared Key dialog box, edit the Enter Key and Confirm Key with the new Shared Key.

3. Click OK to complete. If the key entered is not exact, you will be presented with a warning message.

Note: We recommend your shared key is at least 15 characters and includes a combination of alphanumeric, symbolic,
upper, and lowercase characters. As a best practice, the shared key should be changed periodically.
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Generate a Response Code

There are two ways to generate a response code. You can either use the PGChallengeResponseUl.exe utility thatis installed as part
of the Privilege Management Policy Editor, or you can generate them in the MMC.

x Note: To generate a response code, you must have set a Challenge/Response Shared key. You are prompted to do this
when you create any policy that has a Challenge/Response message assigned fo it. Alternatively, you can set the
Challenge/Response Shared Key from the home page of the Privilege Management Settings node by clicking Set
Challenge/Response Shared Key.

You can generate a response code from the Privilege Management Policy Editor. This launches a tool called
PGChallengeResponseUl.exe. This tool is part of your installation and can be used independently of the Privilege Management
Policy Editor. The tool is installed to the <Installation Dir>\Avecto\Privilege Guard Management Consoles\ path:

To generate a response code in the Privilege Management Policy Editor:
Click the Privilege Management Settings node and then Tools on the right side.

Click Response Code Generator.

Enter the shared key you defined, and the challenge code from the end-user.

Ao bd =

The response code is generated once both the Shared Key and the 8 character challenge code are entered.

The response value can then be sent to the end user to enter into their challenge dialog box.

Generate a Response Code from the Command Line

Response codes can also be generated from the command line using the PGChallengeResponse.exe command line utility, which is
installed as part of the Privilege Management Policy Editor installation, and is located in the <Installation Dir>\Avecto\Privilege
Guard Management Consoles\ directory:

To generate a response code from the command line:

1. Open the Command Prompt by clicking the Start Menu and typing cmd.exe.

2. In the Command Prompt, type the following command, then press Enter:

cd "\program files\avecto\privilege guard management consoles"

1. Once you open the privilege guard management consoles directory, type the following command (where <challenge> is the
challenge code presented to a user):

pgchallengeresponse.exe <challenge>

2. Atthe Shared Key prompt, enter the correct shared key, then press Enter.

Note: PGChallengeResponseUl.exe is a standalone utility and can be distributed separately from the Privilege
Management Policy Editor.
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Automating Response Code Generation

The PGChallengeResponse.exe utility supports full command line use, allowing it to be easily integrated into any third party
workflow that supports the execution of command line executables. The command line is as follows:

PGChallengeResponse.exe <challenge code> <shared key> <duration>

ﬂ Note: The duration parameter is optional.

In the command line argument above, <challenge code> is the code presented to the user and <shared key> is the key that was
configured within the Privilege Management for Windows settings which presented the end user message.

The utility will return the response code as an exit code, so it can be captured from within a custom script or wrapper application. The
options for the optional <duration> parameter are once | session | forever.

Below is an example VBScript:

Dim WshShell, oExec

Dim strChallenge, strKey, strExecutable, strType

strExecutable = "C:\Program Files\Avecto\Privilege Guard Privilege Management Policy
Editors\PGChallengeResponse.exe"

strChallenge = InputBox ("Enter Challenge Code from user","Challenge")

strType = InputBox ("Would you like a Once, Session, or Forever key?","Type")

strKey = InputBox ("Enter Authorization Key from policy", "Key")

Set WshShell = WScript.CreateObject ("WScript.Shell")

Set oExec = WshShell.Exec (strExecutable & " " & strChallenge & " " & strType & " " & strKey )
Do While oExec.Status = 0

WScript.Sleep 100

Loop

msgbox "Response Code: " & oExec.ExitCode

Set WshShell = Nothing

Set oExec = Nothing

Message Text

All of the text in the message can be configured in the Message Text section. You can add an additional language here and localize
the text that you enter for the message text.

[ ]
1 For more information, please see "Languages" on page 129.

We recommend you change the default text strings, as they are all English placeholders. After you change the message text, click
Update to see your changes applied to the preview message.

The textin any text string can include parameterized values which provide more personalized messages for users.

L]
1 For information on how to use parameters, please see "Windows Workstyle Parameters" on page 45.
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Languages

You can configure the textin the messages to display a language of your choice. To add a new language, click Add Languages and
select the language you want to use from the drop-down list. You can set this language to be the default language by clicking Set As
Default.

Privilege Management for Windows checks the locale of the user's language and tries to match it to a language in Privilege
Management for Windows that you've set up. Ifitfinds a match, the strings for that language are displayed for the message text. If it
doesn't find a match, the language you have assigned to be the defaultlanguage is used.

Note: Privilege Management for Windows doesn't localize the text into the language you selected. You need to edit the
message textin your chosen language.

If you have more than one language, you can set the default language. This is the language that will be used if an end user is using a
language thatis not defined. The default language is set to English, but you may change the default language:

1. Select the language you want to set as the defaultlanguage.
2. Click Set As Default.

Note: If you delete a language that has been set to the default language, the language at the top of the language list is set
to the default language. You must always have at least one language defined.

General

« Caption controls the text at the top of the dialog box.

- Header Message controls the text to the right of the icon in the header ifit's shown.

- Body Message controls the text at the top of the main message.

« Refer URL controls the hyperlink for the Reference URL if you selected to show itin the Message Design.

« Refer Text controls the text of the hyperlink for Reference URL if you selected to show itin the Message Design.

Information

« Message Mode determines where the message can be assigned. Messages can be assigned to application rules, on-
demand application rules, and content rules. Select Automatic to allow the rule type to determine the information thatis
displayed (Application or Content). Select Manual to enter your own information in the Custom fields. This information is
displayed irrespective of the type of rule.

« Application Line One Label controls the firstline. For Automatic mode, this is the Application Program Name.

« Application Line Two Label controls the second line. For Automatic mode, this is the Application Program Publisher.
« Application Line Three Label controls the third line. For Automatic mode, this is the Application Program Path.

« Content Line One Label controls the first line. For Automatic mode, this is the Control Content Name.

« Content Line Two Label controls the second line. For Automatic mode, this is the Content Owner.

« Content Line Three Label controls the third line. For Automatic mode, this is the Control Program.

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 129

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/2019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.



PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrust GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Publisher

« Program Publisher (Unknown) controls the text thatis displayed for the variable [PG_PROG_PUBLISHER] if it's not known.

« Verification Failure controls the text that is displayed next to Publisher if the publisher verification fails.
Privilege Management for Windows verifies the publisher by checking that there is a publisher and also checking that the certificate
associated with that publisher is signed. Privilege Management for Windows does not check to see if the certificate has been revoked
due to the length of the lookup process that would rely on network connectivity. Instead, Privilege Management for Windows relies on

the Certificate Store to be kept up to date with revoked certificates, which would be a standard operation as the full chain should be in
the local certificate store.

User Reason

« Reason controls the text above the field where the end user can enter their reason.
- Reason Error Message controls the text that is displayed if the end user clicks Yes and doesn't enter a reason.
« Drop-down list prompt controls the text above the user reason prompt.

« User Reason List allows you to select from the user reasons. You can modify the User Reason List using the Add, Edit, and
Delete buttons.

User Authentication

« User name controls the text adjacent to the field where the user enters their user name.
« Password controls the text adjacent to the field where the user enters their password.
« Domain controls the text below the password field that introduces the domain.

« Unauthorized credentials controls the text that is displayed if the end user enters credentials that aren't valid for the
requested operation.

Challenge / Response Authorization

« Header text controls the text that introduces the challenge/response authorization.

- Hint text controls the text thatis in the response code field for challenge/response messages.

« Information Tip Text controls the text above the challenge and response code fields.

« Error Message Text controls the text that is displayed to the end user if they enter an incorrect response code and click Yes.

« Maximum Attempts Exceeded Message Text controls the text that is displayed to the end user if they exceed the allowed
number of challenge/response attempts.

Smart Card Authorization

« Card Prompt controls the text that introduces the card prompt.

« Card Reading controls the text thatis displayed when the card is being read.

« Card Pin controls the text that is displayed when the card pin is provided.

« Card Error controls the text thatis displayed if there is an error reading the card.

« No Certificate Error controls the text that is displayed when there is no certificate.

« Incorrect Certificate Error controls the text thatis displayed when there is an incorrect certificate.

Buttons

Depending on the message options the message box will have either one or two buttons:
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« For a prompt, the message box will have OK and Cancel buttons.

« Fora blocking message with Allow user to email an application request enabled, the message box will have OK and
Cancel buttons. We recommend you change the OK button text to Email, unless you make it clear in the message text that the
OK button will send an email request.

« Forablocking message with Allow user to email an application request disabled, the message box will only have an OK
button.

You can change the OK Button and Cancel Button text. For instance, you can change itto Yes and No if you are asking the end user

a question.
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Custom Tokens

Access tokens (and custom tokens) are assigned to an application, or when contentis being edited, to modify the privileges of that
activity. Within an access token is a collection of settings that specify the group memberships, associated privileges, integrity level,
and process access rights.

Privilege Management for Windows includes a set of built-in access tokens that can be used to add administrator rights, remove
administrator rights, or enforce the users default privileges. A passive access token is also available that does not change the
privileges of the activity, but still applies anti-tamper protection.

Access tokens are assigned to applications or content through rules within a Workstyle. For more advanced configurations, custom
tokens can be created where group memberships, privileges, permissions, and integrity can be manually specified. You can
optionally define any number of custom tokens.

Create Custom Tokens

To create a new custom token:
1. Navigate to Privilege Management Settings > Windows > Custom Tokens.
2. Right-click and click New Custom Token. Select from the following options:

« Create a token which adds Administrator rights
« Create a token which removes Administration rights

« Create a blank token

3. For the first two options, the Windows privileges that are assigned to that token are pre-selected for you, although you can
change them if required. You can enter text in the Filter box to filter the listin real time.

4. Click Finish when you have assigned the required privileges to the token.

The new custom token is displayed beneath the Custom Tokens node. Click the new token to display the Token Summary.

You may now define the Groups, Privileges, Integrity Level, and Process Access Rights for the custom token.

Edit Custom Tokens

Groups
The Groups section of the custom token specifies the groups that will be added or removed from the token.
To insert a group:

Select Groups from the top tab. The Token groups appear in the right pane.
Right-click and select Add a new account.
Enter the object names and click Check Names to validate it.

o Db~

By default, when you insert a group, the Add Account box is checked, and the group will be added to the custom token. If you
want to remove the group from the custom token, check the Remove box instead.

Domain and well known groups will display a Security Identifier (SID). The SID will be used by the Privilege Management for
Windows, which will avoid account lookup operations. For local groups, the name will be used by the Privilege Management for
Windows, and the SID will be looked up when the custom token is created by the client. Local Account will appear in the SID column
of the groups list for local groups.
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Setting the Token Owner

By default, the owner of a custom token that includes the administrators group will have the owner set to the administrators group. If
the administrators group is not presentin the custom token then the user is set as the owner.

If you want the user to be the owner, regardless of the presence of the administrators group, check the Ensure the User is always
the Token Owner box.

Anti-Tamper Protection

By default, Privilege Management for Windows prevents elevated processes from tampering with the files, registry, and service that
make up the clientinstallation. It also prevents any elevated process from reading or writing to the local Privilege Management for
Windows policy cache.

If you want to disable anti-tamper protection, uncheck the Enable anti-tamper protection box.

Note: Under normal circumstances, this option should remain enabled, except in scenarios where elevated tasks require
access to protected areas. For instance, if you are using an elevated logon script to update the local Privilege
Management for Windows policy.

Privileges
The Privileges section of the custom token specifies the privileges that will be added to or removed from the custom token.

If you want to add a privilege to the custom token, then check the Add box for the relevant privilege. If you want to remove a privilege
from the custom token, check the Remove box for the relevant privilege.

You can also select multiple privileges and use the following options on the right-click menu:
« Reset Privilege
« Add Privilege
« Remove Privilege
« Add Admin Privileges
« Remove Admin Privileges

To clear all of the privileges in the custom token before applying privileges, check the Remove all existing privileges in access
token before applying privileges box. If this box is left unchecked, the privileges are added or removed from the user’s default
custom token.

Integrity Level
The Integrity Level section of the custom token specifies the integrity level for the custom token.

To set the integrity level:

1. Selectthe Integrity Level node in the left pane. The integrity levels appear in the right pane as radio buttons.

2. Setthe appropriate integrity level.

The integrity level should be set as follows:
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Integrity Level Description

System Included for completion and should not be required

High Set the integrity level associated with an administrator

Medium Set the integrity level associated with a standard user

Low Set the integrity level associated with protected mode (an application may fail to run or

function in protected mode)

Untrusted Included for completion and should not be required

Process Access Rights

The Process Access Rights section of a custom token allows you to specify which rights other processes will have over a process
launched with that custom token.

Tokens that include the administrators group have a secure set of access rights applied by default, which will prevent code injection
attacks on elevated processes initiated by processes running with standard user rights in the same session.

Check or uncheck the Access Right Name box to enable or disable a specific access right.
You can also select multiple privileges and use the following options on the right-click menu:
+ Reset all to default

« Add Right
« Remove Right

The access rights should be set as follows:

Access Rights Description

GENERIC_HEAD Read access.
PROCESS CREATE_PROCESS Required to create a process.
PROCESS_CREATE_THREAD Required to create a thread.
PROCESS_DUP_HANDLE Required to duplicate a handle using DuplicateHandle.
PROCESS_QUERY_INFORMATION Required to retrieve certain information about a process, such as its token, exit code,
and priority class
PROCESS_QUERY_LIMITED_ Required to retrieve certain information about a process
INFORMATION
PROCESS_SET_INFORMATION Required to set certain information about a process, such as its priority class
PROCESS_SET_QUOTA Required to set memory limits using SetProcessWorkingSetSize
PROCESS_SUSPEND_RESUME Required to suspend or resume a process
PROCESS_TERMINATE Required to terminate a process using TerminateProcess
PROCESS_VM_OPERATION Required to perform an operation on the address space of a process
PROCESS_VM_READ Required to read memory in a process using ReadProcessMemory
PROCESS_VM_WRITE Required to write to memory in a process using WriteProcessMemory
READ_CONTROL Required to read information in the security descriptor for the object, not including the
information in the SACL
SYNCHRONIZE Required to wait for the process to terminate using the wait functions
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Deploy Privilege Management for Windows Policy

There are several ways to deploy a Privilege Management for Windows policy to your endpoints. This section discusses the various
ways that this can be achieved.

Group Policy Management

Create Privilege Management for Windows Settings

Privilege Management for Windows is implemented as an extension to Group Policy, enabling policy settings to be managed through
the standard Group Policy management tools. Privilege Management for Windows also supports Advanced Group Policy
Management (AGPM ) from versions 2.5 to 4.0.

Group Policy Objects (GPOs) are usually managed through the Group Policy Management Console (GPMC). GPMC is a scriptable
Microsoft Management Console (MMC) snap-in, providing a single administrative tool for managing Group Policy across the
enterprise. GPMC is the standard tool for managing Group Policy.

Privilege Management for Windows also supports Local Computer Policy, which can be edited in the Group Policy Editor, but this is
only recommended for small environments or for test purposes.

You may add Privilege Management for Windows settings to existing GPOs or create new GPOs for this purpose.
To edita GPO from the GPMC:

Launch the GPMC (gpmc.msc).

2. In the GPMC tree, double-click Group Policy Objects in the forest
and domain containing the GPO you want to edit.

3. Right-click the GPO and click Edit.

Group Policy Objects in test local
Canerts | Delogaton|

Name = GPO Status [ WM Fter Modfied Onrer
"/ Defouk Domain Cortiolers Folcy Enobled  None 18/09/2003 162602 Domain Admins (TEST\Domain Admi
2] Defauit Domain Polcy Enabled None 18/09/2009 112248 Domain Admins (TEST\Domain Admi
et Enbled  None 18/09/2009 163316 Domain Adnins (TEST\Domain Adni

The Group Policy Management Editor appears. Privilege Management
Settings are available in both the Computer Configuration and the
User Configuration nodes, which allow you to set either computer or
user settings, respectively. Computer settings are updated when a
computer starts up, whereas user settings are updated when a user logs
on. In addition, a background refresh occurs every 90 minutes by default,
which will update settings while the user is logged on. 2L il :

Once a client updates its Privilege Management for Windows settings
through Group Policy, the settings are applied dynamically. Any logged on users do not need to log off for the changes to take effect.

Note: Privilege Management Settings will either appear directly under the Computer Configuration and User
Configuration nodes, or under the Policies sub-node, if it exists.

To create Privilege Management for Windows settings for a GPO:

1. In the Group Policy Management Editor, select the Privilege Management Settings node for either the Computer
Configuration or the User Configuration section, as appropriate.

On the Group Policy Management Editor Action menu, click Create Privilege Management Settings.

Right-click the Workstyles node and select Create Workstyle. Choose a controlling or a blank Workstyle. Click Finish to
create a Workstyle based on your selection.
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L]
1 For information about Workstyles, please see "Workstyles" on page 57.

Privilege Management Settings Scope

When deploying Privilege Management for Windows settings with Active Directory Group Policy, there are two factors to consider: the
management scope of the GPO you selected and the user or group accounts listed on the account filter section of a Privilege
Management for Windows Workstyle.

When you create a new Privilege Management for Windows Workstyle, you are given the option of applying a filter that will either
target Standard users only or Everyone, including administrators.

Subsequently, you can further refine a subset of users that the Workstyle will target by adding account filters. These are defined on
the Filters tab of a Workstyle where you add groups and users (either domain or local) to the filter. Do not leave the account filters
empty or the Workstyle will still apply to everyone.

Multiple account filters can be added to a Workstyle, if you need add AND logic to your filtering. For example, if you want to target a
user who is a member of GroupA AND GroupB, then add two account filters to an account filter, and select the box All items below
must match.

You can also use computer filters to apply the workstyle to specific computers and connecting client devices. These can be used in
combination with account filters to provide more specific targeting of user and computer combinations, if required.

L]
1 For more information, please see "Filters" on page 81.

GPO Precedence and Inheritance Rules

Privilege Management for Windows settings are associated with an Active Directory GPO and are distributed to all the computers and
users under the management scope of the GPO. As a result, Privilege Management for Windows settings are subject to the same
Group Policy processing and precedence rules as standard Active Directory GPOs.

Order of Processing

Group Policy settings are processed in the following order:

1. Local Group Policy Object: Each computer has exactly one GPO that is stored locally. This applies to both computer and user
Group Policy processing.

2. Site: Any GPOs that are linked to the site that the computer belongs to are processed next. Processing is in the order thatis
specified by the administrator, on the Linked Group Policy Objects tab for the site in GPMC. The GPO with the lowest link
order is processed last, and therefore has the highest precedence.

3. Domain: Processing of multiple domain-linked GPOs is in the order specified by the administrator, on the Linked Group
Policy Objects tab for the domain in GPMC. The GPO with the lowest link order is processed last, and therefore has the
highest precedence.

4. Organizational Units: GPOs that are linked to the organizational unit that is highest in the Active Directory hierarchy are
processed first, then GPOs that are linked to its child organizational unit, and so on. Finally, the GPOs that are linked to the
organizational unit that contains the user or computer are processed.

At the level of each organizational unitin the Active Directory hierarchy, one, many, or no GPOs can be linked. If several GPOs are
linked to an organizational unit, their processing is in the order that is specified by the administrator, on the Linked Group Policy
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Objects tab for the organizational unitin GPMC. The GPO with the lowest link order is processed last, and therefore has the highest
precedence.

This order means the local GPO is processed first, and GPOs that are linked to the organizational unit of which the computer or user
is a direct member are processed last, which overwrites settings in the earlier GPOs if there are conflicts.

Privilege Management for Windows merges settings so settings with a higher precedence will be processed first. Once an application
matches a Privilege Management for Windows Workstyle, no further Workstyles will be processed for that application, so itis
important to keep this in mind when multiple GPOs are applied.

Exceptions to Default Order of Processing

The default order for processing settings is subject to the following exceptions:

« A GPO link may be enforced, or disabled, or both. By default, a GPO link is neither enforced nor disabled.

« A GPO may have its user settings disabled, its computer settings disabled, or all settings disabled. By default, neither user
settings nor computer settings are disabled on a GPO.

« An organizational unit or a domain may have a Block Inheritance set. By default, Block Inheritance is not set.

L]
1 Forinformation about the above modifications to default behavior, please see Managing inheritance of Group Policy at
https://msdn.microsoft.com/en-us/windows/desktop/cc757050.

A computer thatis a member of a Workgroup processes only the local GPO.

Privilege Management Settings Storage and Backup

Privilege Management for Windows stores its settings within Active Directory’s SYSVOL folder, within the storage area for the relevant
GPOs, which are identified by their GUIDs. The settings are stored in an XML file and Active Directory is then used as the distribution
mechanism.

Privilege Management for Windows settings can be backed up by one of the following methods:
1. Privilege Management for Windows settings files will be backed up as part of a standard System State backup, which
organizations should be performing as part of their standard backup routines.

2. Perform a manual backup of a GPO from the GPMC, which will back up the GPO settings and Privilege Management for
Windows’ XML files.

3. In addition, Privilege Management for Windows settings may be manually exported and saved to a location of your choice.

-
L Formore information on how to perform an export or import of policies, please see "Export" on page 38.

Disconnected Users

Disconnected users are fully supported by Privilege Management for Windows. When receiving its settings from a GPO, Privilege
Management for Windows automatically caches all the information required to work offline, so the settings will still be applied if the
clientis not connected to the corporate network. Of course, any changes made to the policy will not propagate to the disconnected
computer until it reconnects to the domain and receives a Group Policy refresh. This behavior is identical to most of the standard
Microsoft Group Policy settings.
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Privilege Management for Windows also supports a completely standalone configuration mode, where the settings are configured by
a Local Group Policy for that machine, or deployed in a standalone XML configuration file. These settings contain all of the
information required to apply these policies offline.

Standalone Management

Although the Privilege Management Policy Editor is implemented as a Group Policy extension, it also supports a standalone mode,
which is independent of Group Policy.

Standalone mode allows you to deploy the Privilege Management for Windows settings with an XML file. You will need to employ a
suitable deployment mechanism to distribute the XML file to your client computers.

To run the Privilege Management Policy Editor in standalone mode:

Launch mmc.exe.

Select Add/Remove Snap-in from the File menu.

Select Privilege Management Settings from the available snap-ins and click Add.
Click OK.

e nh =

The Privilege Management Policy Editor is now running in standalone mode and is not connected to a Group Policy Object (GPO).
On Windows 7 onwards, the Privilege Management for Windows settings will be saved to the following local XML file:
%ALLUSERSPROFILE%\Avecto\Privilege Guard\PrivilegeGuardConfig.xml

If you installed Privilege Management for Windows when you installed the Privilege Management Policy Editor, then the client will
automatically apply the policies in this XML file. For this reason we strongly recommend you do not install the client if you will use the
policy editor in standalone mode, unless you want the settings to be applied to your management computer. This may be case if you
are evaluating Privilege Management for Windows.

The Privilege Management for Windows settings are edited in the same way as when editing GPO based policies. To distribute the
XML file to multiple clients, you will need to export the policies to an XML file and then deploy it to the location specified above.
Privilege Management for Windows monitors this directory and will automatically load the XML file.

You must name the settings file PrivilegeGuardConfig.xml once itis deployed, otherwise Privilege Management for Windows will not
load the settings. If you make changes to the Privilege Management for Windows settings, redeploy the modified XML file and
Privilege Management for Windows will automatically reload the settings.

PowerShell Management

The BeyondTrust Privilege Management for Windows PowerShell APl enables administrators to configure Privilege Management for
Windows using PowerShell scripts. This enables integrations with external systems, and provides an alternative to using the
BeyondTrust management consoles.

Through the PowerShell API, you can create and modify any Privilege Management for Windows configuration within Domain Group
Policy, Local Group Policy, or any local configuration. The PowerShell APl is available on any computer where the Privilege
Management Policy Editor or Privilege Management for Windows is installed.

L]
1 For information on scripting Privilege Management for Windows configurations, please see the BeyondTrust Privilege

Management for Windows PowerShell APl document and the accompanying help file PowerShell APl.chm. Both of these
documents are installed with the Privilege Management Policy Editor, under C:\Program Files\Avecto\Privilege Guard
Privilege Management Policy Editors\PowerShell\.
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Windows PowerShell Execution Policy

The default PowerShell execution policy is Restricted, which stops any scripts running. To set the execution policy:

1. Open PowerShell as an elevated application.
2. Navigate to the Deployment folder in the PMC package.
3. Run Set-ExecutionPolicy unrestricted -scope CurrentUser -f

L]
1 For information on how to configure the setting using Group Policy, please see the Microsoft document Set-
ExecutionPolicy at https://technet.microsoft.com/en-us/library/hh849812.aspx.

Execute PowerShell Configurations

PowerShell scripts and commands which use the Get-DefendpointSettings, Set-DefendpointSettings, and Get-
DefendpointFileInformation cmdlets must be executed with admin rights on the target computer. If you are elevating scripts and
commands with the Privilege Management for Windows Remote PowerShell Management feature, you must ensure an Add
Administrator Rights Custom Token has been assigned, and includes the following Groups settings:

« Enable anti-tamper protection box is unchecked.
« Make sure the users is always the token owner box is checked.

When using PowerShell Management to apply changes to Privilege Management for Windows configurations stored in Active
Directory Group Policy, you require domain level write access to the Group Policy Object.

x Note: Configurations created and edited with PowerShell are not backwards compatible with older Privilege Management
for Windows versions, so we recommend only configurations targeting version 4.0 Clients are managed through
PowerShell scripting.

Webserver Management

Deploy Workstyles using Web Services

For instances where Active Directory Group Policy is not suitable, such as for clients outside of the corporate network, Privilege
Management for Windows configurations may be hosted on a webserver using HTTP or HTTPS. Privilege Management for Windows
can be configured to download configurations on a schedule.

K Note: Webserver configurations should be implemented as a complement to other configuration deployment methods.
Workstyle precedence can be customized so that webserver configurations are evaluated with the correct priority. For
more information, please see "Workstyle Precedence”on page 60.

L Forinformation on how to create an XML configuration for deployment from a webserver, please see the following:
« "Export" on page 38
« "Import" on page 38

SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 139

©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/2019
or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.


http://technet.microsoft.com/en-us/library/hh849812.aspx
http://technet.microsoft.com/en-us/library/hh849812.aspx
https://technet.microsoft.com/en-us/library/hh849812.aspx

PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTFUSt GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Privilege Management for Windows may be configured to pull an XML configuration from a webserver during the installation of the
Client MSI or EXE, or for existing installations, can be configured using the Windows Registry.

Webserver Enabled Client Installation

To install Privilege Management for Windows with webserver configurations enabled, there are several command line arguments
which can be used to configure the following settings:

Argument ‘ Description
WEBSERVERMODE= Enables webserver functionality (Required, 1 = Enabled)
WSP_URL= Specifies the full URL (including XML filename) to the webserver configuration
(required)
WSP_INTERVAL= Refresh interval for new configuration check in minutes (optional, default 90 minutes)
WSP_LOGON= Check for new configuration at user logon (optional, default 1 = Enabled)
WSP_CERT= The Common Name for a webserver certificate. When added, restricts webserver

downloads only if the common name matches the webserver certificate, and the
certificate is valid.

DOWNLOADAUDITMODE= Specifies the level of auditing for attempts to download webserver configurations; 0 =
No auditing, 1 = Failures only, 2 = Successes only, 3 = audit both (default)

POLICYENABLED= Specifies the policy deployment methods which are enabled. Add this value to allow a
webserver policy to be used by the Privilege Management for Windows:
WEBSERVER.

L]
1 For more information, please see "Deployment Methods" on page 142.

Example:

Msiexec.exe /i DefendpointClient x86.msi /gn /norestart WEBSERVERMODE=1 WSP
URL="http://MyWebServer.Internal/WebConfig.xml” WSP_INTERVAL=90
POLICYPRECEDENCE="WEBSERVER, GPO, LOCAL"”

DefendpointClient x86.exe /s /v” WEBSERVERMODE=1 WSP
URL=\"http://MyWebServer.Internal/WebConfig.xml\” WSP_INTERVAL=90
POLICYPRECEDENCE=\"”WEBSERVER, GPO, LOCAL\"”"”

Enable Webserver Policy Download Using the Registry
At any time after Privilege Management for Windows is installed, webserver configuration may be set using the Windows registry. The
following registry entries are valid:

HKEY_LOCAL_MACHINE\Software\Avecto\Privilege Guard Client\
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Value Data Data
WebServerPolicyUrl REG_SZ | Specifies the full URL (including xml filename) to the webserver
configuration (Required)
WebServerPolicyRefreshintervalMins DWORD  Refresh interval for new configuration check in minutes (Optional, default
90 minutes)

WebServerPolicyRefreshAtUserLogon DWORD | Check for new configuration at user logon (Optional, default 1 = Enabled)

WebServerCertificateDisplayName REG_SZ The Common Name for a webserver certificate. When added, restricts
webserver downloads only if the common name matches the webserver
certificate, and the certificate is valid.

DownloadAuditMode DWORD | Specifies the level of auditing for attempts to download webserver
configurations (0 = No auditing, 1 = Failures only, 2 = Successes only, 3 =
audit both (default))

PolicyEnabled REG_SZ  Specifies the policy deployment methods which are enabled. Add this
value allow a webserver policy to be used by the Privilege Management
for Windows: WEBSERVER.

[ ]
. Formore information, please see "Deployment Methods" on

page 142.

Configuration Precedence

Privilege Management for Windows supports a variety of deployment methods, and can accept multiple simultaneous configurations
from any combination of the following:

« Group Policy: Configurations that are stored in Group Policy Objects, configured with GPMC (Active Directory Group Policy)
and GPEdit (Local Group Policy). Group Policy based configurations are evaluated according to GPO precedence rules.

« Local Policy: A standalone configuration, which is stored locally, configured with MMC.

- Webserver Policy: A configuration located on a web server, accessible using HTTP, HTTPS, or FTP.

« McAfee ePO Policy: A configuration that is stored within McAfee ePO, configured with the ePO policy catalog.

« Beyondinsight: A web-based console where you configure and launch vulnerability assessment scans. As a scan completes,
a report is automatically generated. Results can be navigated interactively in the console.

Privilege Management for Windows uses a logical precedence to evaluate each configuration for matching rules. By default, the
client will apply the following precedence: ePO Policy > Beyondinsight > Webserver Policy > Group Policy > Local Policy.

Configuration precedence settings can be configured either as part of the clientinstallation or with the Windows Registry, once the
clientis installed.

To modify configuration precedence at clientinstallation, use one of the following command lines to install Privilege Management for
Windows with a specific configuration precedence:

msiexec /i DefendpointClient x(XX).msi POLICYPRECEDENCE="EPO, WEBSERVER,GPO, LOCAL"

DefendpointClient x(XX).exe /s /v“ POLICYPRECEDENCE=\"EPO, WEBSERVER, GPO, LOCAL\""
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Note: In the command line arguments above, (XX) represents 86 or 64 in relation to the 32-bit or 64-bit installation
respectively.

To modify configuration using the Registry, run regedit.exe with elevated privileges (ensuring you are using a Privilege Management
for Windows token with anti-tamper disabled) and navigate to the following key:

HKEY_LOCAL_MACHINE\Software\Avecto\Privilege Guard Client
REG_SZ PolicyPrecedence = "EPO,WEBSERVER,GPO,LOCAL"

Deployment Methods

Certain types of deployment methods may be enabled or disabled. By default, all deployment types are enabled. To include or
exclude a method of deployment from evaluation, edit the entries in the registry value below. If this key does not already exist, the
default behavior is to include all methods:

HKEY_LOCAL_MACHINE\Software\Avecto\Privilege Guard Client
REG_SZ PolicyEnabled = "EPO,Beyondinsight WEBSERVER,GPO,LOCAL"
In the entry above, EPO,Beyondinsight, WEBSERVER,GPO,LOCAL are the available deployment methods.

K Note: Registry settings may be deployed using the Advanced Agent Settings feature. For more information, see
"Advanced Agent Seftings"on page 56. In order to apply a configuration deployment method using Advanced Agent
Settings, the setting must be applied to a type of configuration that is already part of the configuration precedence order.
For more information, please see "Configuration Precedence"”on page 141.

Automate the Update of Multiple GPOs

The PGUpdateGPO.exe command line utility allows you to automate the update of Privilege Management for Windows settings in
multiple computer or user GPOs (Group Policy Objects).

The PGUPdateGPO.exe utility is used as follows:

PGUpdateGPO.exe COMPUTER GPODSPath [SourceXMLFile]

PGUpdateGPO.exe USER GPODSPath [SourceXMLFile]

Where:

« GPODSPath is the LDAP path to the GPO
« SourceXMLFile is the location of the Privilege Management for Windows settings XML file on disk

The command line below demonstrates using this utility to copy an XML file from the current directory into the computer section of a
GPO stored in BeyondTrust.test:

PGUpdateGPO.exe COMPUTER "LDAP://BeyondTrust.test/cn={97B1DB2E-D68B-45EA-98FF—
D71F9971F44C},cn=policies, cn=system, DC=BeyondTrust,DC=test" PrivilegeGuardConfig.xml

Where:
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« {97B1DB2E-D68B-45EA-98FF-D71F9971F44C} is the GUID of the GPO.
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Audit and Reports

The Privilege Management McAfee ePO Integration Pack includes a set of rich preconfigured dashboards, builtin ePO Queries and
Reports, which summarize Privilege Management for Windows event data collected from McAfee ePO managed computers.

BeyondTrust also provides an enterprise level, scalable reporting solution in Privilege Management Reporting. Privilege
Management Reporting includes a rich set of dashboards and reports designed to simplify the centralized management and auditing
of Privilege Management for Windows activity throughout the desktop and server estate. Each dashboard provides detailed and
summarized information regarding Application, User, Host, and Workstyle usage.

L]
1 For more information on how to configure Reporting in ePO, please see the ePO Installation Guide at

hitps://www.beyondtrust.com/docs/privilege-management/windows.htm.

Events

Privilege Management for Windows sends events to ePO using the McAfee Agent, and also to the local application event log,
depending on the audit and privilege monitoring settings within the Privilege Management for Windows policy.

The following events are logged by Privilege Management for Windows:

Event ID ‘ Description

0 Service Control Success

1 Service Error

2 Service Warning

100 Process has started with admin rights added to token.

101 Process has been started from the shell context menu with admin rights added to token.

103 Process has started with admin rights dropped from token.

104 Process has been started from the shell context menu with admin rights dropped from token.

106 Process has started with no change to the access token (passive mode).

107 Process has been started from the shell context menu with no change to the access token (passive mode).

109 Process has started with user’s default rights enforced.

110 Process has started from the shell context menu with user’s default rights enforced.

112 Process requires elevated rights to run.

113 Process has started with custom token applied.

114 Process has started from the shell context menu with user’s custom token applied.

116 Process execution was blocked.

118 Process started in the context of the authorizing user

119 Process started from the shell menu in the context of the authorizing user

120 Process execution was canceled by the user

150 Privilege Management for Windows handled service control start action.

151 Privilege Management for Windows handled service control stop action.
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Event ID Description

152
153
154
155
156
157
158
159
160
161
162
198
199
Configuration Events
10
200
201
202
210
211

Privilege Management for Windows handled service control pause/resume action.
Privilege Management for Windows handled service control configuration action.
Privilege Management for Windows blocked a service control start action.

Privilege Management for Windows blocked a service control stop action.

Privilege Management for Windows blocked a service control pause/resume action.
Privilege Management for Windows blocked a service control configuration action.
Privilege Management for Windows service control action run in the context of the authorizing user.
Privilege Management for Windows service control start action canceled.

Privilege Management for Windows service control stop action canceled.

Privilege Management for Windows service control pause/resume action canceled.
Privilege Management for Windows service control configuration action canceled.
Privileged group modification blocked.

Process execution was blocked, the maximum number of challenge / response failures was exceeded.

License Error

Config Config Load Success
Config Config Load Warning
Config Config Load Error

Config Config Download Success

Config Config Download Error

User / Computer Events

300 User User Logon

400 Service Privilege Management for Windows Service Start

401 Service Privilege Management for Windows Service Stop

Content Events

600 Process Content Has Been Opened (Updated Add Admin)

601 Process Content Has Been Updated (Updated Custom)

602 Process Content Access Drop Admin (Updated Drop Admin)

603 Process Content Access Was Cancelled By The User (Updated Passive)

604 Process Content Access Was Enforced With Default Rights (Updated Default)

605 Process Content Access Was Blocked

606 Process Content Access Was Cancelled

607 Process Content Access Was Sandboxed

650 Process URL Browse

706 Process Passive Audit DLL

716 Process Block DLL

720 Process Cancel DLL Audit
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Each process event contains the following information:

« Command line for the process

« Process ID for the process (if applicable)

« Parentprocess ID of the process

« Workstyle that applied

« Application group that contained the process
« End userreason (if applicable)

« Custom access token (if applicable)

« File hash

« Certificate (if applicable)

Note: Each process event also contains Product properties, where applicable, but these can only be viewed in the
Privilege Management Reporting Console.

Audit with Custom Scripts

When an application is allowed, elevated, or blocked, Privilege Management for Windows will log an event to the application event
log to record details of the action. If you want to record the action in a bespoke or third-party tracking system that supports
PowerShell, VBScript, or JScript based submissions, you can use the Run a Script setting within an application rule.

To add a new auditing script:

Create a new or edit an existing Application Rule within a Workstyle.
2. In Run a Script, click on the Off value and in the drop-down menu, select Manage Scripts to open the Script Manager.

3. In the Script Manager, click New in the left-hand tree view. A new script will be added to the tree. Click the name New Script
once to rename the script.

4. In the right-hand script editor, enter your script code either manually, by copy and paste, or you can import a script from file by
clicking Import.

5. In the Script Language drop-down menu, select either PowerShell, VM Script, or Javascript, depending on the code format
you entered.

x Note: PowerShell audit scripts can only be run in the System context.

6. Selecta Timeout for how long the script will be allowed to execute, before it is terminated. By default, this will be set to Infinite.

7. Select whether the script should be executed in the System context or the current User context from the Script Context drop-
down menu.

8. Click OK to finish.

The new script will automatically be selected in the Run a Script setting.

x Note: If you have any existing scripts, these can be selected in the drop-down menu.

The auditing script supports the use of parameters within the script. Parameters are expanded using the COM interface PGScript. For

example:
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strUserName = PGScript.GetParameter (“[PG USER NAME]”)
strCommandLine = PGScript.GetParameter (“[PG PROG CMD LINE]”)
strAgentVersion = PGScript.GetParameter (“[PG _AGENT VERSION]”)

L]
1 For a list of available parameters, please see "Windows Workstyle Parameters" on page 45.

Note: Scripts created in the script editor can be reused in multiple application rules and on-demand application rules. Any
modification to an existing script will affect all Workstyle rules that have been configured to execute that script.

BeyondTrust End User Utilities

Privilege Management for Windows includes four end user utilities to enable users to manage advanced network adapter settings,
printer settings, and software installations, as many of these capabilities would usually be hosted in the explorer shell, making it
difficult to give these tasks elevated rights. These applications can also be managed using COM class elevation in your Privilege
Management for Windows policy.

Name of Utility Name of Executable

BeyondTrust Network Adapter Utility PGNetworkAdapterUtil.exe
BeyondTrust Printer Management Utility PGPrinterUtil.exe
BeyondTrust Programs and Features Manager PGProgramsUtil.exe

BeyondTrust Task Manager PGTaskManager.exe

IMPORTANT!

The utilities in red will be deprecated in the 5.5 release. If you require any help building a policy to replace these utilities with
their native Windows counterparts, please contact your BeyondTrust account manager.

Add These Applications to Your Policy

To use these applications, you must add them to a policy so they can be elevated as required.

Create an Application Group for these applications with a name such as BeyondTrust Utilities so you know what it contains.

2. Right-click the application group and Insert Application > Application Template. The BeyondTrust utilities are listed at the
top of the listin alphabetical order.

3. Selectone or more of the BeyondTrust utilities you want to include and click Insert.

4. You can now choose an existing Workstyle or create a new Workstyle in your policy and add an Application Rule to target the
Application Group you created. This Application Rule needs to elevate the applications in the Application Group.

Users who receive this policy can now use these BeyondTrust utilities as required.
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BeyondTrust Network Adapter Manager

From this utility, a user can modify the properties of a network adapter, rename an adapter, or disable an adapter. To do this, you
must use the PGNetworkAdapterUtil.exe application, which can be found in the Privilege Management for Windows installation
directory (usually C:\Program Files\Avecto\Privilege Guard Client).

BeyondTrust Printer Manager

From this utility, a user can add and delete printers, set their default printer, access printer properties and preferences, view the
printer queue, access print server properties, and print a test page. To do this, you must use the PGPrinterUtil.exe application, which
can be found in the Privilege Management for Windows installation directory (usually C:\Program Files\Avecto\Privilege Guard
Client).

BeyondTrust Programs and Features Manager

From this utility, a user can uninstall, change, and repair software installed on their computer. To do this, you must use the
PGProgramsUtil.exe application, which can be found in the Privilege Management for Windows installation directory (usually
C:\Program Files\Avecto\Privilege Guard Client).

By default, PGProgramsUtil will not display Windows Updates. To enable the option to show updates (using a toggle button), use the
following command line switch:

PGProgramsUtil.exe /showupdates

BeyondTrust Task Manager

From this utility, a user can view and manage tasks currently running on the endpoint. To do this, you must use the
PGTaskManager.exe application which can be found in the Privilege Management for Windows installation directory (usually
C:\Program Files\Avecto\Privilege Guard Client).

Regular Expressions Syntax

Privilege Management for Windows can control applications at a granular level by using regular expression syntax. Privilege
Management for Windows uses the ATL regular expression library CAtIRegExp. Below is a summary of the regular expression
syntax used by this library.

Metacharacter‘ Meaning ‘ Example

Any character All characters except the listed special characters match a single instance of | abc matches abc
except \"$.|?*+() | themselves. To match one of these listed characters use a backslash escape
character (see below).

\ (backslash) Escape character: interpret the next character literally. a\+b matches a+b

. (dot) Matches any single character. a.b matches aab, abb or
ach, etc.

[1 Indicates a character class. Matches any character inside the brackets (for [abc] matches a, b, orc

example, [abc] matches a, b, and c).
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) BeyondTrust

Metacharacter

Meaning

Example

A (caret) If this metacharacter occurs at the start of a character class, it negates the [*abc] matches all
character class. A negated character class matches any character except characters excepta, b,
those inside the brackets (for example, [*abc] matches all characters except | andc
a,b,and c).

If # is at the beginning of the regular expression, it matches the beginning of
the input (for example, *[abc] will only match input that begins with a, b, or ¢).

- (minus In a character class, indicates a range of characters (for example, [0-9] [0-9] matches any of the

character) matches any of the digits 0 through 9). digits 0 through 9

? Indicates that the preceding expression is optional: it matches once or notat | ab?c matches ac or abe
all (for example, [0-9][0-9]? matches 2 and 12).

+ Indicates that the preceding expression matches one or more times (for ab+c matches abc and

* (asterisk)

| (vertical pipe)

example, [0-9]+ matches 1, 13,999, and so on).

Indicates that the preceding expression matches zero or more times

Alternation operator: separates two expressions, exactly one of which
matches.

abbc, abbbc, etc.

ab*c matches ac and
abc, abbc, etc.

alb matches a orb

??,+?,%? Non-greedy versions of ?, +, and *. These match as little as possible, unlike Given the input
the greedy versions which match as much as possible. Example: given the <abc><def>, <.*?>
input <abc><def>, <.*?> matches <abc> while <.*> matches <abc><def>. matches <abc> while

<.*> matches
<abc><def>.

() Grouping operator. Example: (\d+,)*\d+ matches a list of numbers separated  (One)|(Two) matches
by commas, such as 1 or 1,23,456. One or Two

{} Indicates a match group. The actual text in the input that matches the
expression inside the braces can be retrieved through the
CAtIREMatchContext object.

\ Escape character: interpret the next character literally. For example, [0-9]+ <{.*?}>.*?</\0> matches
matches one or more digits, but [0-9]\+ matches a digit followed by a plus <head>Contents</head>
character. Also used for abbreviations, such as \a for any alphanumeric
character; see table below.

If\is followed by a number n, it matches the nth match group (starting from 0).
Example: <{.*?}>.*?<N\0> matches "<head>Contents</head>".
Note thatin C++ string literals, two backslashes must be used: "\+", "\a", "<
{F?2}>2<N\0>".
$ Atthe end of a regular expression, this character matches the end of the [0-9]% matches a digit at
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Alternation operator: separates two expressions, exactly one of which
matches. For example, T|the matches The or the.

Negation operator: the expression following ! does not match the input.
Example: alb matches a not followed by b.
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Database Sizing and Resource Consumption

Data Retention Considerations
The Audit Event and Microsoft SQL Server Reporting Services databases used to support BeyondTrust Privilege Management
Reporting may be hosted and scaled independently.

It's important to identify the length of time that Privilege Management for Windows audit event data must be retained in the Privilege
Management for Windows database as it drives resource utilization projections, and initial allocation.

Privilege Management Reporting is designed to report on activity in recent time, not as a long term archival data storage solution.

« Privilege Management for Windows provides a database purge utility that may be used to purge data manually, or
automatically on a configured period to ensure database growth is capped.

« Unlimited database growth inevitably reduces query execution performance, and increases resource utilization for queries.

Note: Prior to purging large sets of data, please ensure your SQL Transaction logs are able to grow to accommodate. It
may be necessary to delete data in stages when setting this up for the first time.

In order to facilitate your decision making regarding retention time in the Privilege Management for Windows database, please refer
to the following sections in our standard documentation:

« Description of the views of data exposed in Privilege Management Reporting.

L]
1 For more information, please see the Reporting Dashboard Guide at https://www.beyondtrust.com/docs/privilege-

management/windows.htm.

« Description of the events audited by Privilege Management for Windows.

L]
1 For more information, please see "Events" on page 144.

« Description of the Workstyle parameters. You may consider these as the fields that are collected in the audit events,
eventually stored in the Privilege Management for Windows Audit Events database.

[ ]
1 For more information, please see "Windows Workstyle Parameters" on page 45.

Database Sizing

The Audit Event database has to be sized to accommodate substantial data volume, matching the number of clients generating audit
data and the desired retention period.

Database storage requirements may be estimated roughly using the following calculation:

Number of hosts

X Number of events per host per day
X 5Kb per event

X Number of retention days
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Number of hosts X Number of events per host per day
X 5Kb per event
X Number of retention days

For example, an organization of 10,000 hosts, with each host generating an average of 15 events per day, requiring a 30 day
retention would require a database capacity of:

10,000 X 15 X 5 X 30 = 22,500,000Kb, or 21.5Gb

A typical event volume would be 10-20 events per host per day and varies based on Privilege Management for Windows auditing
configuration, user job function (role/workstyle) and user activity patterns.

Note: Please see the Privilege Management for Windows Database sizing calculator to further explore database sizing
and growth expectations.

Database resource utilization (CPU, Memory) is highly variable depending on the hardware platform.

Example Use Case Volumes

Based on an organization of 10,000 hosts requiring a 42 day (six weeks) retention.
Discovery: Between 40 — 60 events per machine per day
(4.6K per event (based on real world data))

Average total: 67.06 GB

Production: Between 2 — 10 events per machine per day
(4.6K per event (based on real world data))

Average total: 5.66 GB

K Note: Ifthe number of events "per machine per day" is raised to 15, then the Average total increases to 16.99 GB.

Key considerations

Volume of inbound audit event records

As seen above, the number of events per hour may be estimated following simple calculations.

Queries triggered from MSFT SQL Reporting Services Reports

As the database grows in size, the resource impact of the reporting platform queries becomes important.

The volume of data maintained in the audit event database will affect the duration and resource cost of these queries.

To maintain good performance, we recommend the ER Purge Utility is used to limit the timespan of audit event data retained in the
database.

Finer-grained audit data management and clean-up is possible using the Privilege Management for Windows Database
Administration Dashboard. The Database Administration Dashboard allows the purging of audits related to specific applications and
suppression of incoming audit items related to those applications.
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L]
1 For more information, please see the Database Administration description in the Reporting Dashboard Guide at

www.beyondtrust.com/docs/privilege-management/windows.htm.

Prior to purging large sets of data, please ensure your SQL Transaction logs are able to grow to accommodate. It may be necessary
to delete data in stages when setting this up for the first time.

Windows Privileges

Standard User Privileges

Privilege . Windows 7
Windows Server 2008 R2
SeChangeNotifyPrivilege Yes
SelncreaseWorkingSetPrivilege Yes
SeShutdownPrivilege Desktop Only
SeTimeZonePrivilege Yes
SeUndockPrivilege Desktop Only

Administrator Privileges

Privilege | . Windows 7
Windows Server 2008 R2
SeBackupPrivilege Yes
SeCreateGlobalPrivilege Yes
SeCreatePagefilePrivilege Yes

SeCreateSymbolicLinkPrivilege  Yes

Windows Server 2008 R2

SeDebugPrivilege Yes
SeEnableDelegationPrivilege Server Only
SelmpersonatePrivilege Yes
- Windows 7
Privilege

SelncreaseBasePriorityPrivilege | Yes

SelncreaseQuotaPrivilege Yes
SelLoadDriverPrivilege Yes
SeMachineAccountPrivilege Yes
SeManageVolumePrivilege Yes

SeProfileSingleProcessPrivilege Yes

SeRemoteShutdownPrivilege Yes

SeRestorePrivilege Yes
SALES: www.beyondtrust.com/contact SUPPORT: www.beyondtrust.com/support DOCUMENTATION: www.beyondtrust.com/docs 152
©2003-2019 BeyondTrust Corporation. All Rights Reserved. Other trademarks identified on this page are owned by their respective owners. BeyondTrust Corporation is not a chartered bank or trust company, TC: 11/4/2019

or depository institution. It is not authorized to accept deposits or trust accounts and is not licensed or regulated by any state or federal banking authority.


https://www.beyondtrust.com/docs/privilege-management/windows.htm
https://www.beyondtrust.com/docs/privilege-management/windows.htm

PRIVILEGE MANAGEMENT FOR WINDOWS

I BeyondTrust GROUP POLICY ADMINISTRATION GUIDE 5.5.X

Windows 7
Windows Server 2008 R2

Privilege

SeSecurityPrivilege Yes
SeShutdownPrivilege Yes
SeSystemEnvironmentPrivilege | Yes
SeSystemProfilePrivilege Yes
SeSystemTimePrivilege Yes
SeTakeOwnershipPrivilege Yes

System Privileges

- Windows 7
Privilege

Windows Server 2008 R2

SeAssignPrivilegeTokenPrivilege | Yes

SeAuditPrivilege Yes
SeCreatePermanentPrivilege Yes
SeCreateTokenPrivilege Yes
SelLockMemoryPrivilege Yes
SeRelabelPrivilege Server 2008 R2 Only
SeSyncAgentPrivilege Yes
SeTcbPrivilege Yes
SeTrustedCredManAccessPrivilege | Server 2008 R2 Only
SeUnsolicitedInputPrivilege Server 2008 R2 Only

Configure Remote Computer Browser

The Privilege Management for Windows Workstyle Editor allows you to browse computers on the network for executables, Windows
services and running processes, which can be added to application groups. This provides a convenient alternative to manual entry.

Remote computer browsing leverages Windows Remote Management (WinRM) and PowerShell, which must be configured on each
target endpoint in advance of using the computer browser feature to access the remote computer.

K Note: WinRM and Powershell are components of the Windows Management Framework, and are part of Windows 7 and
Windows Server 2008 R2. For older versions of Windows, the Windows Management Framework can be downloaded and
installed as an optional update at www.microsoft.com/en-gb/download/details.aspx?id=40855.

Configure the ePO Server
Configure WinRM trusted hosts:

1. Open PowerShell (elevated).
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2. Type winrm s winrm/config/client ‘@{TrustedHosts="<endpoint>"}".

<endpoint> should be replaced with the hostname or IP Address of the network computer to be trusted. A wildcard (*) can
also be used.

3. Press Enter.

Configure a network computer
Verify PS-Remoting is enabled:

1. Open PowerShell (elevated).
2. Type Enable-PSRemoting, and then type A to accept all defaults (this can also be enabled with AD Group Policy).

Configure WinRM to allow remote connections

1. In the same PowerShell window, type winrm ¢c and press Enter.

2. Type winrm set winrm/config/service @{AllowUnencrypted="true"} and press Enter.

Test for a successful connection
From the ePO server, run this command: winrm identify -r:http://<endpoint>:5985 -u:<username> -p:<password>.

<endpoint> should be replaced with the hostname or IP Address of the network computer. Replace <username> and <password>
with administrator credentials on the network computer.

If the connection is unsuccessful, edit the local security policy to enable classic mode authentication for network logons.
Open Local Security Policy from Control Panel > Administrative Tools.

Navigate to Local Policies > Security Options.
Double click Network Access: Sharing and Security Model for local accounts.

e nh =

Set to classic.
Mixed environments:
1. Open PowerShell (elevated).
2. Type the following and press Enter:

new-itemproperty -name LocalAccountTokenFilterPolicy -path
HKLM: \SOFTWARE\Microsoft\Windows\CurrentVersion\Policies\System -propertyType DWord -value 1

Troubleshoot

Resultant Set of Policy

Privilege Management for Windows provides full support for Resultant Set of Policy (RSoP). RSoP is usually accessed through the
Group Policy Management Console (GPMC).

The GPMC supports two modes of operation for RSoP:
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« Group Policy Modeling (RSoP planning mode)
« Group Policy Results (RSoP logging mode)

RSoP can be used to establish which policy applies to a particular user or computer to aid troubleshooting. Detailed HTML reports
are generated, which may also be exported to aid policy documentation.

Group Policy Modeling

To run a Group Policy Modeling query (RSoP planning), perform the following steps from the GPMC:

Double-click the forest in which you want to create a Group Policy Modeling query.
Right-click Group Policy Modeling and click Group Policy Modeling wizard.

In the Group Policy Modeling wizard, click Next and enter the appropriate information.
After completing the wizard, click Finish.

o kDN

Right-click the node for the completed query in the console tree, and click Advanced View to launch the Resultant Set of
Policy window.

6. Selectthe Privilege Management Settings node under the Computer Configuration node or the User Configuration node to
view the RSoP HTML report for Privilege Management for Windows.

Privilege Management also appears in the Summary tab of the Group Policy Modeling node. Expand the Component Status
section of the HTML report to find out whether RSoP data has been collected for Priviliege Management for Windows.

Privilege Management does not appear in the Settings tab of the Group Policy Modeling node, as third-party Group Policy
extensions are not detailed in this HTML report. You must use the Advanced View, as outlined above, to view Privilege Management
for Windows Workstyles for an RSoP query.

Group Policy Results

To run a Group Policy Results query (RSoP logging), perform the following steps from the GPMC:

Double-click the forest in which you want to create a Group Policy Results query.
Right-click Group Policy Results and click Group Policy Results wizard.
In the Group Policy Results wizard click Next and enter the appropriate information.

After completing the wizard, click Finish.

A

Right-click the node for the completed query in the console tree, and click Advanced View to launch the Resultant Set of
Policy window.

6. Selectthe Privilege Management Settings node under the Computer Configuration node or the User Configuration node
to view the RSoP HTML report for Privilege Management for Windows.

Privilege Management also appears in the Summary tab of the Group Policy Results node. Expand the Component Status section
of the HTML report to find out whether RSoP data has been collected for Privilege Management for Windows.

Privilege Management does not appear in the Settings tab of the Group Policy Results node, as third-party Group Policy
extensions are not detailed in this HTML report. You must use the Advanced View, as outlined above, to view Privilege Management
for Windows Workstyles for an RSoP query.

Check Privilege Management for Windows is Installed and Functioning

If you are having problems, the first step is to check that you installed the client and the client is functioning.
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« Privilege Management: The Ul of Privilege Management for Windows on the toolbar for messages and end user interaction

« defendpointd: The Privilege Management for Windows daemon that manages interaction with Privilege Management for
Windows

. dppolicyserverd: Manages policy and communicates with defendpointd
« Custodian: Manages authentication as required by Privilege Management for Windows
The easiest way to determine the clientis installed and functioning is to check for the existence of the BeyondTrust Privilege

Management Service in the Services Privilege Management Policy Editor. Ensure this service is both present and started. The
Privilege Management for Windows service is installed by Privilege Management for Windows and should start automatically.

K Note: The Privilege Management for Windows service requires MSXMLG6 in order to load the Privilege Management for
Windows settings, but the service will still run even if MSXMLG is not present.

Windows 7 and Windows Server 2008 R2 already include MSXMLG6.

Check Settings are Deployed

Assuming Privilege Management for Windows is installed and functioning, the next step is to check that you deployed settings to the
computer or user.

You can use RSoP logging mode to determine whether the computer has received settings. Assuming the RSoP query shows that
Privilege Management for Windows settings are applied, you should check the contents of the settings (including licensing and
Workstyle precedence).

Check Privilege Management for Windows is Licensed

One of the most common reasons for Privilege Management for Windows not functioning is the omission of a valid license from the
Privilege Management for Windows settings. If you are creating multiple GPOs, then you must ensure the computer or user receives
atleast one GPO that contains a valid license. To avoid problems, itis simpler to add a valid license to every set of Privilege
Management for Windows settings that you create.

Check Workstyle Precedence

Assuming Privilege Management for Windows is functioning and licensed, most other problems are caused by configuration
problems or Workstyle precedence problems.

Once an application matches an application group entry in the application rules or the on-demand application rules, processing will
not continue for that application. Therefore, itis vital you order your entries correctly:

« If you create multiple Workstyles, Workstyles higher in the list have a higher precedence.

« Ifyou have multiple rules in the application rules and the on-demand application rules sections of a Workstyle, entries higher
in the list have a higher precedence.

Application rules are applied to applications that are launched either directly by the user or by a running process. On-demand
application rules are only applied to applications that are launched from the Privilege Management for Windows shell menu (if
enabled).

If you have multiple GPOs applying to a user and/or computer, you should ensure GPO precedence rules are not causing the
problem. If multiple GPOs are applied to a computer or user, Privilege Management for Windows will merge the computer GPOs and
user GPOs by following Group Policy precedence rules. Once merged, the user Workstyles will take precedence over the computer
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Workstyles. In other words, the computer Workstyles will only be processed if an application does not match an entry in the user
Workstyles.

For this reason, we strongly recommended you do not create over-complex rules that rely on the merging of many GPOs, as this can
become difficult to troubleshoot. If, however, it makes sense to split rules over multiple GPOs, you should make use of RSoP to
ensure Workstyles are combined correctly. You must also remember that computer and user Workstyles are processed separately,
with user Workstyles always processed ahead of computer Workstyles, if both exist.
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